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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this section and 
licensed to you. You acknowledge that the programs may contain third party software (VAR 
applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation 
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail 
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of 
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory 
Management. 

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, 
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags. 

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of 
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization 
application. 

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR 
Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding 
any other term or condition of the agreement and this ordering document, you shall not cause or 
permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all 
alterations, translations, upgrades, enhancements, customizations or modifications of all or any 
portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the VAR 
Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach 
of the agreement to utilize the relationship, and/or confidential information of the VAR 
Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and Customer shall 
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or 
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to 
replace, with functional equivalent software, any of the VAR Applications in future releases of the 
applicable program. 
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Send Us Your Comments 
Oracle Retail Macro Space Management, Fixture Studio User Guide, Release 13.3 

 

Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 
 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 

http://www.oracle.com/
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Preface 
Documentation Accessibility 

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc. 

Access to Oracle Support 
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are 
hearing impaired. 

 Related Documents 
For more information, see the following documents in the Oracle Retail Macro Space 
Management Release 13.3 documentation set: 

     Oracle Retail Macro Space Management Administration Module User Guide 
     Oracle Retail Macro Space Management Administration Module Online Help 
     Oracle Retail Macro Space Management Configuration Module User Guide 
     Oracle Retail Macro Space Management Configuration Module Online Help 
     Oracle Retail Macro Space Management Data Importer User Guide 
     Oracle Retail Macro Space Management Data Importer Online Help 
     Oracle Retail Macro Space Management Store Planning User Guide 
     Oracle Retail Macro Space Management Store Planning Online Help 
     Oracle Retail Macro Space Management Product Studio User Guide 
     Oracle Retail Macro Space Management Product Studio Online Help 
     Oracle Retail Macro Space Management Report Designer User Guide 
     Oracle Retail Macro Space Management Report Designer Online Help 
     Oracle Retail Macro Space Management Release Notes 
     Oracle Retail Macro Space Planning Installation Guide 
     Oracle Retail Macro Space Planning License Information 
     Oracle Retail Macro Space Planning Data Model 

For more information on In-Store Space Collaboration see the following documents 
in the Oracle Retail In-Store Space Collaboration Release 13.3 documentation set: 
     Oracle Retail In-Store Space Collaboration Release Notes 
     Oracle Retail In-Store Space Collaboration User Guide 
     Oracle Retail In-Store Space Collaboration Online Help 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 

When contacting Customer Support, please provide the following: 

http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs
https://support.oracle.com/
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 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 
 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 13.3) or a later patch release (for example, 13.3.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 

 Oracle Retail Documentation on the Oracle Technology Network 
Documentation is packaged with each Oracle Retail product release. Oracle Retail 
product documentation is also available on the following Web site: 
http://www.oracle.com/technology/documentation/oracle_retail.html 

(Data Model documents are not available through Oracle Technology Network. These 
documents are packaged with released code, or you can obtain them through My Oracle 
Support.) 

Documentation should be available on this Web site within a month after a product 
release.  

Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.” 
This is a code sample 
 It is used to display examples of code 
 

 

http://www.oracle.com/technology/documentation/oracle_retail.html
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1 
Overview of Fixture Studio 

Overview of Fixture Studio Module 
The Fixture Studio Window has a number of parts, as seen in the following figure. 

 

The Menu Bar gives access to a number of pull-down menus. 

The Toolbar allows the selection of a number of options relative to fixture and gondola 
creation.  

The Block Browser has a hierarchical tree of fixtures or gondolas depending on which tab 
is selected. 
The Preview Window in the Object Browser gives a simplified image of the selected 
object. 

The Status Bar at the bottom of the screen gives information on the number objects 
selected and the status of current action. 

The Gondola Definitions Window contains a list of all gondolas held in the central 
database. 
The Block Definitions Window contains a list of all blocks (fixtures, fittings) held in the 
central database. 

Whether blocks are automatically loaded into Fixture Studio depends upon the setting in 
the Options dialog box (View menu). If blocks are not set to automatically load, they 
must be imported using the Read Blocks option on the File menu. 
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Menu Options 
The Menu Bar contains five options, as shown in the following figure. 

 

The File menu allows blocks to be read and saved. It also allows blocks to be loaded to 
and saved from the drawing. Finally, it allows the blocks themselves to be subjected to 
operations such as normalizing or producing 3DS files. 

The Edit menu allows block definitions to added, edited and deleted. 

The View menu allows the way block definitions display in Fixture Studio to be defined.  

The Window menu allows the user to specify the way the various windows and dialog 
boxes display in Fixture Studio. 

The Help menu calls this Help Module and also allows the user to see system 
information for the computer the software is running on. 

File Menu 
The File Menu has varying options concerned with reading and saving blocks, AutoCAD 
operations, and connection to AutoCAD. 

 

The Load Blocks into Drawing, Load Blocks from Disc, Laying out Blocks, Normalize 
Blocks, Create 3DS Files and Redefine blocks from disk menu options are grayed out 
unless the Connect to AutoCAD option has been checked. 

Read Blocks reads the details of all blocks from the central Macro Space Planning 
database or the drawing into Fixture Studio.  

Save Blocks saves the details of all blocks back to the central Macro Space Management 
Planning from Fixture Studio.  

Save Gondolas saves the details of any newly created gondolas back to the central Macro 
Space Planning database from Fixture Studio.  

Block Factory is a wizard intended to assist in block creation. Clicking on Block Factory 
brings up the Block Factory dialog box. 
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Configure brings up the Configuration Module. This can be used to change fundamental 
settings in Macro Space Management. 

 

Connect to AutoCAD opens the AutoCAD environment and enables a number of block 
editing commands that cannot otherwise be used.  

Reading Blocks 
Information on blocks is held within the central Macro Space Planning database. When 
Fixture Studio is started, the information is loaded into local memory. This can be done 
in one of two ways:  

 Automatically by setting the Load Blocks Automatically on Start option from the 
Options dialog box accessed from the View Menu. 

 Manually by means of the Read Blocks option on the File menu. 
Once the information is loaded into local memory, all changes and edits are 
saved into that local memory. The updated information is only written back to 
the database when the Save Blocks option is selected from the File menu. 
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Gondola information is read into Fixture Studio on start-up. It is held in local memory 
and is only written back to the central Macro Space Planning database when the Save 
Gondolas option is invoked from the File menu. 

Reading Blocks 
Blocks are read from the database, from the drawing, or both. The options are invoked 
from the File menu. To have the option of reading in blocks from the drawing (or 
merging results) the Connect to AutoCAD option must also be selected. 

 

Read Blocks Option 
On selecting this option, the user has two check boxes: Clear existing Block definitions 
and Overwrite Existing Block definitions. 

 

 Clear existing Block definitions. If checked, this option deletes all information 
currently held in local memory and refreshes it with that held in the central 
Macro Space Planning database. 

 Overwrite existing Block definitions. This check box is only available if the 'clear 
existing Block definition' check box is not selected. When Overwrite existing 
Block definitions is selected, the Apply Data filters check box also becomes 
available. If checked, the button to the right can be used to bring up the Copy 
Options dialog box. Options checked within this dialog box result in data from 
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the central Macro Space Planning database overwriting what is held in local 
memory when the OK button is clicked in the Read Block Definitions dialog box. 

If neither check box is checked, data held in local memory will be overwritten without 
any filtering. 

Drawing Option 
The usual purpose of reading in from the drawing is to bring in blocks from an earlier 
version of the application. It is normally used by expert users. 

This option is only available if the Connect to AutoCAD option has been selected from 
the File menu. On selecting the Drawing option the user has two check boxes: Clear 
existing Block definitions and Overwrite Existing Block definitions. 

 

 Clear existing Block definitions. If checked, this option deletes all information 
currently held in local memory and refreshes it with a list of the blocks in the 
drawing. 

 Overwrite existing Block definitions. This check box is only available if the Clear 
existing Block definition check box is not selected. If Overwrite existing Block 
definitions is selected, the Apply Data filters check box also becomes available. If 
checked, the button to the right can be used to bring up the Copy Options dialog 
box. Options checked within this dialog box result in information read from the 
list of blocks in the drawing overwriting what is held in local memory when the 
OK button is clicked in the Read Block Definitions dialog box. 

Merge Option 
The merge option is a combination of reading from the database and reading from the 
drawing. It is only available if the Connect to AutoCAD option has been selected from 
the File menu. 
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If Merge is selected, the blocks in the currently selected drawing are compared to those 
held in local memory. Data from any blocks in the drawing but not in the database is 
read into local memory. If blocks in the drawing are also in local memory and they 
contain information different to local memory, some of this information (typically size 
data, block description, but not block name, and connection point information) are read 
into Fixture Studio and overwrite the information in local memory. 

Saving Blocks 
Information on blocks is held within the central Macro Space Planning database. When 
Fixture Studio is started, the information is loaded into local memory. When data has 
been added, changed, or deleted, that data needs to be written back to the central Macro 
Space Planning database to be made permanent. 

This is done by selecting the Save Blocks option on the File menu. 

Saving Blocks 
Block information can be saved to the database, to the drawing, or both. The options are 
invoked from the File menu. To have the option of saving block information to the 
currently active drawing and variation of the block held in the directory specified in the 
configuration module, the Connect to AutoCAD option must also be selected. 
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The process is illustrated in the following example in which Fixture Studio is connected 
to an active drawing in Planner. 

 

On clicking OK in the Save Block Definitions dialog box, the following actions take place. 

1. The information held in local memory is permanently written to the database. 

2. XData (MSM-specific data) is written to the instance of the block in the currently 
active drawing. (An instance of every block being saved must be in the currently 
active drawing). 

3. A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

Note: If Fixture Studio is not connected to Planner, the 
fixture in the active drawing will not have its XData 
updated, nor will a copy of the block be written to the 
directory specified in the Category tab of the block Details 
dialog box. 
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Save Blocks Not Connected to Planner Drawing 

 

If Fixture Studio is not connected to the Planner drawing, the options to write to the 
drawing and write block files will be grayed out and unavailable. It is then only possible 
to save the current version of the local data held in Fixture Studio to the database. The 
available options are: 

 Add New Definitions: This option writes back all new block definitions in the 
locally stored data that are not presently held that in the database. 

 Enforce Save: This option writes back information from any blocks that have 
been changed but not selected for saving if the 'Only Save Selected Blocks' option 
has been selected. 

 Only Save Selected Blocks: This option only saves blocks that have been 
highlighted. It allows a subset of data to be saved back, not the entire contents of 
Fixture Studio. 

 Update Database with Drawing. 

Save Blocks Connected to Planner Drawing 
 

If Fixture Studio is connected to the Planner drawing, the options to write to the drawing 
and write block files will be available. The additional options are: 

 Database: Data held locally in Fixture Studio is written back to the database. 
 Drawing: XData is written to the block in the drawing as a minimum. 

 Write Block Files: A copy of the block in the drawing (including XData) is written 
to the directory specified in the Category tab of the Block Details dialog box. 

The block written to the specified directory is the definition block. Instances of this block 
are then placed in floor plan. It is the template for all blocks being placed by store 
planners. 

Deleting Blocks 
Deleting blocks from Fixture Studio takes place in multiple stages. 
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Marking Blocks for Deletion from Within Fixture Studio 
Blocks are marked for deletion in Fixture Studio by highlighting the block then using the 
Delete option on the right click menu. 

 

The block name is then grayed out in the Fixture hierarchy, and the icon turns black in 
the Block details list. 

 

Marking Blocks for Deletion in the Database 
At present the block has a delete flag set against it in the information held locally within 
Fixture Studio. The next stage is to write that information back to the central Macro Space 
Planning database so the delete flag is set there as well. This is done by highlighting the 
entry in the Fixture Hierarchy and then using the Save Block definitions dialog box from 
the File menu. 

 

The Destination should be set to Database and the Enforce Save/Only Save Selected 
blocks options checked. On clicking OK, the delete flag is written to the database. 
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Permanently Deleting the Blocks in the Administration Module 
The blocks can be permanently deleted from the database by selecting the Purge option 
from the Tools menu in the Admin module.  

 

If there are problems, an error message displays. 

 

Typical reasons preventing blocks from being deleted include: 
 Fixtures present in floor plan (blocks cannot be deleted from the database if 

instances still exist in other tables in the database). 

 Fixture information may be present in other tables in the database, causing 
referential integrity problems.  

Block Factory 
The Block Factory option is available from the File menu.  
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On selecting Block Factory, the Block Factory dialog box opens. 

 

Block Factory creates a list of blocks within the Fixture hierarchy. If a Fixture Group has 
been highlighted before Block Factory has been opened, the blocks are created at that 
point in the hierarchy. If no fixture group has been highlighted, the blocks are created 
under the Fixture hierarchy root.  

When blocks are created in the hierarchy, they have the name, description and 
dimensions assigned. All other information have to be entered by editing the within the 
Block Details dialog box. 

There are two options: manually enter the information into Block Factory or use the 
Wizard to automatically create blocks. 

Manual Use of Block Factory  
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To enter information manually, enter the Name, Description, Length, Depth and Height 
in the top line. To store each line, press Return. On clicking OK, the entries are written to 
the fixture hierarchy. 

Block Factory Wizard 
The Block Factory Wizard is accessed by clicking the Wizard button in the Block Factory 
dialog box. 

 

A Name and Description can be entered followed by the dimensions. The dimensions to 
be included and the separators can be specified, but the resulting name combinations 
must be unique.  
On clicking OK, a list of block names followed by dimensions in the Block Factory dialog 
box is produced. 

 

On clicking OK, this information is written to the Fixture hierarchy. 

 

The blocks can then be edited using the Block Details dialog box with additional 
information added before the modified block is saved back to the database.  



Toolbar 

Overview of Fixture Studio Module 13 

Note: Using the Block Factory (or the Block Factory Wizard) 
does not create any graphics. The DWG and 3DS files have 
to be manually created. 

AutoCAD Operations from Fixture Studio 
Before the AutoCAD functionality can be used from within Fixture Studio, users must 
first connect to the Planner module. Until this is done, the AutoCAD options on the File 
menu remain grayed out and unavailable. 

 

The Connect to AutoCAD option on the File menu must be selected. If the AutoCAD 
environment is not open, AutoCAD will be activated. If it is open, Fixture Studio will link 
to AutoCAD. When Fixture Studio has connected to Planner, the AutoCAD based 
options change from being grayed out to available and the Connect to AutoCAD option 
will be checked. 

 

Loading Blocks into Drawing 
The Load Blocks into Drawing command is used to take copies of the DWG files from the 
Macro Space Planning directories currently specified in Fixture Studio and transfer them 
to the currently active drawing in AutoCAD  

The Connect to AutoCAD option must be selected on the File menu. 
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There are three stages to this.  

1. Select the required blocks in Fixture Studio. 

2. Select the Load Blocks into the Drawing option. 

3. Select the Insert option in AutoCAD. 

Selecting the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio: from the 
hierarchical tree or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections.  

 

Using the Load Blocks into Drawing Option 
Using the Load Blocks into Drawing loads the block definitions into the AutoCAD 
drawing. They are loaded to the AutoCAD database associated with drawing and are not 
visible until the Insert command is used to put instances into the visible part of the 
drawing. 
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Using the Insert Option 
The Insert option can be invoked by typing insert into the command line. 

 

This brings up the Insert dialog box. 

 

Block definitions can be selected using the Name drop-down list. After specifying the 
Insertion Point, Scale, and the Rotation Angle and whether or not the components of the 
block are to be exploded, clicking on OK places an instance of the block definition in the 
drawing. 

Loading Blocks from Disc 
Load Blocks from Disc enables the user to select blocks from a source outside of the 
Macro Space Management database and load them into the currently active AutoCAD 
drawing. (This is in contrast to the Load Blocks into Drawing option, which selects copies 
of the DWG files from the Macro Space Planning directories currently specified in Fixture 
Studio.) 

There are two stages to this:  

1. Select the Load Blocks from Disk option. 
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2. Select the Insert option in AutoCAD. 

Using the Load Blocks from Disc Option 
Using the Load Blocks from Disc option transfers the block definitions into the AutoCAD 
drawing. They will not become visible until instances have been placed in the drawing. 

 

This brings up Select blocks to Load dialog box. Navigate to the required directory and 
highlight the required blocks. Click on Open to transfer the block definitions to the active 
AutoCAD drawing. They will not become visible until the insert command is used to put 
instances into the visible part of the drawing. 

 

Using the Insert Option in AutoCAD 
When the block definitions have been transferred into the drawing, instances of that 
definition can be inserted into the drawing by typing Insert into the command line. 
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This brings up the Insert dialog box. 

 

Block definitions can be selected using the Name drop-down list. After specifying the 
Insertion Point, Scale, and Rotation Angle and whether or not the components of the 
block are to be exploded, clicking on OK places an instance of the block definition in the 
drawing. 

Laying Out Blocks 
The Laying out Blocks is similar to the Load Blocks into Drawing option, except that it 
bypasses the AutoCAD Insert command and lays out the selected blocks in a grid pattern 
in the currently active drawing in the AutoCAD environment. 

There are two stages to this:  
 Select the required blocks in Fixture Studio. 

 Select the Layout Blocks in Drawing option. 

Selecting the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio: from the 
hierarchical tree or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections.  
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Selecting the Laying Out Blocks Option 
Click on the Laying Out Blocks in Drawing option in the File menu.  

 

This brings up the Layout Options dialog box. 
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The spacing between blocks can be specified by the X, Y and Z spacing. Selecting the 
appropriate check boxes adds the block name and/or description to each block when it is 
drawn the active drawing. Selecting the Clear Drawing check box clears all previous 
blocks from the drawing. 

Normalize Blocks 
The Normalize Blocks command is used to modify the AutoCAD properties of blocks 
selected in Fixture Studio. It is the equivalent of the AutoCAD Object Properties dialog 
box, but can be used to perform bulk operations. This is particularly useful when 
working with blocks that have been created outside of Macro Space Planning, as they 
may require their properties changed to work within the application. 

 For KPIs to work within Planner, the blocks color must be set to By Block. 

 For the thicken form of highlighting to work within Planner, the line weight 
must be set to By Block. 

Normalize Blocks is accessed from the File menu.  

 

The Normalize Blocks dialog box enables any currently selected blocks to have their 
AutoCAD Layer, Color, Line Type, and Line Weight changed.  
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Layer 
If set to Ignore, layers will be unchanged. 

If set to Ignore 2D/3D layers they will not be affected by any changes to other layers 
If set to Reset to 0, all selected blocks will have their parent layer set to the default of 0.  

Color 
If set to Ignore, line weights will be unchanged. 

If set to By Layer, then the selected blocks will adopt the default color for the layer they 
are inserted on. 

If set to By Block, the selected blocks will adopt the default color for the layer they 
inserted are on except where the Planner functionality changes the color to a alternative 
one (for example for a KPI). 
If set to Custom, then the modified color for the selected blocks can be set by means of 
the spin control. These blocks will not adopt the parent color of the layer they are 
inserted on; nor can their color be changed to display KPIs.   

Note: Color should normally be set to By Block. This enables 
blocks to have their colors changed in Planner when KPIs 
are applied. 

Line Type 
If set to Ignore, line types will be unchanged. 

If set to By Layer, the selected blocks will adopt the default line type for the layer they 
inserted are on. 

If set to By Block, the selected blocks will adopt the default liner type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative one.  

If set to Custom, then the line type for the selected blocks can be set by means of the 
drop-down list. 

Line Weight 
If set to Ignore, line weights will be unchanged. 

If set By Layer, the selected blocks will adopt the default weight type for the layer they 
inserted are on.  

If set By Block, he selected blocks will adopt the default liner type for the layer they 
inserted are on except where the Planner functionality changes it to an alternative one.  
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If set to a Custom level, all the selected blocks will be set to the line weight selected from 
the drop-down list. These blocks will not adopt the parent line weight of the layer they 
are inserted on; nor can their line weight be changed by the Planner functionality.   

Note: Line weight should normally be set to By Block. This 
enables blocks to have the thicknesses of their lines changed 
for highlighting purposes in Planner.  

 

Creating 3DS Files 
DWG files are used in the Planner module. A different sort of file (3DS file) is used to 
represent products and merchandise in the Merchandiser module. The 3DS files are 
created using the DWG file as a template.  

There are two stages to this: 
 Select the required blocks in Fixture Studio. 

 Select the Crease 3DS Files option. 

Selecting the Required Blocks in Fixture Studio 
Selecting the requited blocks can be done in two ways in Fixture Studio: from the 
hierarchical tree or from the Block Definitions window. They can be selected from the 
hierarchical tree by left clicking on an individual block or by holding down <Ctrl> and 
left clicking to make multiple selections. They can be selected from the Block Definitions 
window by left clicking on an individual block or by holding down <Ctrl> or <Shift> and 
left clicking to make multiple selections.  
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Selecting the Create 3DS Option 
Click on the Create 3DS Files option in the File menu.  

 

The required 3DS files are created in the same directory as the original DWG files. A 
confirmatory dialog box displays. 
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Note: The 3DS files are also used in the Preview Tab of the 
Block details dialog box. If files are absent, an error message 
displays. 

Redefine Blocks from Disc 
Redefine Blocks from Disc allows the user to overwrite any blocks in the current selected 
floor plan in Planner with the latest versions specified in Fixture Studio. 

It is accessed from the File menu and is only active when Fixture Studio is connected to 
AutoCAD.  

 

On selecting the command, Fixture Studio identifies all blocks in the drawing referenced 
by the Connect to AutoCAD option and replaces them with the blocks currently 
referenced in Fixture Studio. A confirmatory dialog box displays. 
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This task can also be carried out using the Restructure Drawing option in the Planner 
module. 

Edit Menu 
The Edit Menu has varying options concerned with editing block descriptions. 

 
Add Block, Edit Block and Delete Block result in a block being added or the selected 
block being either edited or deleted.  

Copy Data and Paste Data allow information to be copied from one block to another or 
copied into a block being added.  

If data is going to be overwritten, a confirmatory warning displays.  

 

Copy brings up a dialog box allowing the data being copied to be filtered. 

 

Clear all Blocks removes all blocks from the list of blocks currently loaded into Fixture 
Studio. 

Filter Data brings up the Filter Listed blocks dialog box. 
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Edit Sizes brings up the Edit Sizes dialog box. This is used to configure the sizes for 
stretchable blocks.  

 

Edit Categories bring up the Edit Categories dialog box. This is used to configure a list of 
Categories that can be assigned to fixtures on the Categories tab of the Block Details 
dialog box. Categories are often used as filters for reporting purposes.  
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Edit Attribute Variables brings up the dialog box used to configure the Attributes that 
can be assigned to fixtures in the Planner and Merchandiser Modules and in In-Store 
Space Collaboration. 

 

Copying Data 
The Copy Data and Paste Data options on the View menu (and on the toolbar) allow 
users to copy and paste data from one block to another. This is typically used when 
creating large numbers of blocks. One block is fully configured, and then the required 
data is copied and pasted to other blocks. Examples of this include copying lists of 
associated parts or styles from one block to another. 

The first stage is to specify the data that is to be copied from one block to another. This is 
done by selecting Copy Options from the Edit menu. 

 

This brings up the Copy Options dialog box.  
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The data to be copied can be specified by the check boxes. 
The next stage is to highlight the block from which data is to be copied. On selecting 
Copy, the specified data is written to the clipboard. 

The next stage is to highlight the block to which data is to be copied (only one block can 
be selected at a time). On selecting paste, a confirmatory warning appears. If Yes is 
clicked, the data held locally in Fixture Studio will be overwritten.  

 

This process can be repeated by selecting further blocks and pasting the information to 
those.  

Finally, the information must be saved back to the central Macro Space Planning 
database. This is done by identifying all changed blocks (red icons) and using the Save 
Blocks option from the File menu. 

This functionality works best if the block from which data is to be copied has first been 
saved back to the central Macro Space Planning database. Problems with the copy and 
paste functionality may result if it has not. 

Categories and Variable Attributes 
Categories and Variable Attributes are both used for reporting purposes. 

Categories 
Selecting Edit Categories from the Edit menu brings up the Edit Categories dialog box. 
This is used to configure a list of Categories that can be assigned to fixtures on the 
Categories tab of the Block Details dialog box.  
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Once entered, these categories can be assigned to fixtures using the Categories drop-
down list on the Category Tab of the Block Details dialog box. 

 

When generating reports (for example in BI Publisher), categories can then be used as a 
filter. 

Variable Attributes  
Variable attributes are also used for reporting purposes, particularly for compliance 
purposes. Selecting Edit Attribute Definitions from the Edit menu brings up the Edit 
Categories dialog box. This is used to configure a list of variable attributes that can be 
assigned to fixtures on the UDA tab of the Block Details dialog box.  

Edit Attribute Variables brings up the dialog box used to configure the Attributes that 
can be assigned to fixtures in the Planner and Merchandiser Modules as well as in In-
Store Space Collaboration. 
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Once attributes are set up, they are assigned to individual blocks in the UBA tab of the 
Block Details dialog box. 

 

Once the Variable attributes have been assigned and saved, they can then be used to set 
instance data for fixtures placed in floor plans. This is done by selecting one or more 
fixtures in the Planner or Merchandiser modules or in In-Store Space Collaboration, then 
clicking the attributes icon on the toolbar. This brings up the Attributes dialog box.  
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Information can then be entered and saved on a fixture-by-fixture basis. This can then be 
used for reporting purposes. For example, a KPI could be created to show all fixtures 
with incorrect planograms. This would mean that an In-Store Space Collaboration user in 
an individual store could mark up planograms on site and a Macro Space Management 
user at headquarters could then see how the actual store differed from what was in the 
floor plan.  

Editing Sizes 
Sizes are used to collect together a set of size rules.  

When a block is associated with a size, it is associated with all the size rules. This allows 
multiple sizes to be assigned to a block.  

 

Note: If a Size is changed, all the blocks that reference that 
size will have their associated size rules changed. 

Setting up Size Groups 
Size Group Classes are used to organize Size Groups into sub-divisions that make it 
easier to find the required Size Groups. 

Size Group Classes thus have an administrative function, but do not directly affect the 
data stored in Size Groups. 
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Adding a Size Group is a function that allows a hierarchical tree to be built.  
To add a Size Group, highlight the node in the hierarchical tree to which the new Size 
Group is to be added and click on the Add a Size Group icon. The Size Group dialog box 
appears. 

 

Type in the name of the required Size Group and then click OK. The Size Group is added 
to the hierarchical tree. 

Editing a Size Group 
Size Group names can be edited. To do this, highlight the required Size Group and click 
on the edit a Size Group icon. The Size Group dialog box appears. 

 

Change the name of the Size Group and then click OK. The Size Group is amended in the 
hierarchical tree. 

Deleting a Size Group 
To delete a Size Group, highlight the group and click on the Delete a Size Group icon on 
the toolbar.  

Adding a Size 
To Add a Size, click the Add a Size icon in the section of the toolbar concerned with 
Adding, Editing and Deleting Sizes. 

 

When adding a Size, first select the Size Group it is to be added to by clicking on it. If this 
is not done, an error message displays. 
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If a Size Group has been selected, the Size dialog box appears. 

 

1. While in the Details tab, type in the Size name, an expanded Description and a Title. 

2. Select the correct units for the Size. 

3. In the Sizes tab, enter the details of the sizes.  

4. Click OK to confirm. The Size is added to the hierarchy. 

Size Types 
There are a number of options for setting size rules. These are selected from the Type 
drop-down list in the Types tab. 
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Options are: 
 Fixed 

 Variable 

 Choice 

 Match 

 Delta 

 Ratio 
 Locked 

Fixed Sizes 

 

When setting fixed sizes, only a single dimension can be input for length, depth and 
height. All other options are grayed out. 
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Variable Sizes  

 

Variable Size allows the user to set a number of discrete sizes that can be selected when 
the block is inserted into the AutoCAD or Virtual Reality environments. 
Prompt enables the user to type in a brief description of that dimension (for example 
length, depth or height). 

The Maximum and Minimum dimensions can be set. In the above example, the length 
has been defined as having a minimum of 500 mm and a maximum of 1000 mm. 

The Increment can be set to specify the change from one permissible dimension to 
another.  
In the above example, the length has a minimum value of 500 mm and a maximum value 
of 1000 mm. Because the increment has been set to 100 mm, the user is presented with 
options to set the length to 500, 600, 700, 800, 900 or 1000 mm when the block is inserted.  

Choice allows the user to set in a number of predefined size options.  
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When this option is selected from the Type drop-down menu, an additional Size Choices 
Tab appears.  

The names entered in the prompt fields in the Types tab appear in the Size Choices tab as 
the names of the dimensions. 

 

The actual dimensions can be added in the Size Choices Tab. 

Icon Option 

 
Add New Choice 

 
Delete Selected 
Choice 

 
Move Choice Up 

 
Move Choice 
Down 

 

The toolbar allows the user to add, delete, and re-order the list of dimensions. 

Match Sizes 
Match Sizes enables the user to link one dimension to another.  
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At least one dimension must be defined using another size option (for example, fixed).  
The other dimension(s) can be slaved to that specified dimension. For example, if the 
length has been fixed at 36 inches, then the depth can be specified as matching the length. 
This results in a block where the length and depth match. 

 

Delta 
Delta allows a user to select another dimension and specify the current dimension to 
match that plus or minus a specified increment. 
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Ratio 
Ratio allows a user to select another dimension and specify the current dimension to be 
multiplied by a specific ratio. 
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Locked 
Locked sizes enable the choices visible to the user to be restricted to only one or two 
dimensions when the dialog appears during insertion. 

 

For this option to work, lists of dimensions must first be input into the Size Choices tab. 
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Window Menu 
The Window Menu has two groups of options. 

 

The first set of options arranges the active windows within Fixture Studio. 

Cascade arranges them so they are stacked sequentially across the diagonal of the screen.  

 

Tile Horizontal arranges then so they all share the available space horizontally. 

 

Tile Vertical arranges then so they all share the available space vertically. 

 

The second set of options allows switching between those windows. Clicking on either 
Gondola Definitions or Block Definitions causes that window to become active within 
Fixture Studio. 

View Menu 
The View Menu has varying options concerned with filtering and viewing blocks. 
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Filter Listed Blocks brings up the Block Filter. This can be used to select specific classes of 
blocks. 

 

The Options selection brings up the Options dialog box. This can be used to set some 
options determining how Fixture Studio Functions. 

 

 Show Tooltips enables tool tips. 

 Show Warnings enables warnings. 

 Automatically read blocks on start loads the block information into Fixture 
Studio when the module is started. If this option is not checked, the blocks have 
to be manually read in using the Read Blocks option on the File menu. 

 Set OSnaps for picking turns on OSnaps in the Planner module if they are off and 
if the Pick button is used in the Size tab of the Block Details dialog box. 
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 Only pick 1 point for heights assumes the base of the block is at zero elevation, 
allowing only the top of the block to be selected if Pick button is used in the Size 
tab of the Block Details dialog box. 

Note: 'Set OSnaps for Picking' and 'Only pick 1 point for 
heights' are not currently functional. 

Block Browser toggles the Block Browser (Object Browser) on and off. 

Checking or un-checking Preview toggles the preview window in the object browser on 
and off.  

The remaining three options allow blocks or gondolas to be grouped. 

Show Group by, Expand All and Collapse All are discussed in more detail here. 

 

Grouping Operations 
The Group By option on the View Menu allows blocks with common criteria to be 
grouped together, then the list expanded or collapsed. 

 

Show Group By (<Ctrl> + G) brings up a box above the table of blocks descriptions titled 
‘Drag a column header here to group by that column’.  

 

When this is done the list of blocks is sorted into groups specified by the header dragged 
into the box.  
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Clicking on the dragged column header changes the direction in which the data is sorted. 

The grouped data can be expanded or collapsed using the options on the View menu.  

A collapsed view is shown below. 

 

Any individual section of grouped blocks can be expanded or collapsed by clicking the 
‘+’ or ‘-’ signs to the left of the section. 

Help Menu 
The Help Menu has two options. 

 

Clicking on Block Details Help (or pressing the F1 function key) calls this help module. 

Clicking on About Block Details brings up a dialog box with information on the version 
of Fixture Studio the user has. 

Toolbar 
The Toolbar gives access to a series of Fixture Studio options (some of which are also 
available from the menu bar). 
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Reading Block Definitions 

 

There are three possible ways of reading Block Definitions into Fixture Studio. Each of 
these ways has a number of options that can be set. 

 Reading from the database. 

 Reading from the drawing. (This option is only available if Fixture Studio is 
linked to AutoCAD.) 

 Merging data from the database and active drawing. (This option is only 
available if Fixture studio is linked to AutoCAD.) 

The setting in the Options dialog box (View menu) determines whether blocks are 
automatically read into Fixture Studio on start up, or whether they are manually read in. 

Reading from the Database 
Reading from the database allows the user to read in information on blocks stored in the 
database. This may be filtered in different ways, depending on selections made in the 
Options frame. 

This option is the only option available if Fixture Studio is not linked to AutoCAD 
(Planner). 
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Reading from the Drawing 
Reading from the drawing allows users to read in any AutoCAD blocks from the 
drawing into Fixture Studio. When reading from the drawing, only the AutoCAD based 
information is imported. 

This option is only available if the Connect to AutoCAD option has been selected from 
the File menu. 

 

Merge 
Merge compares the blocks in the database to those in the drawing. Any blocks in the 
drawing but not in the database are imported into Fixture Studio. Data read from the 
drawing is AutoCAD based and does not contain any Macro Space Management 
information. 

This option is only available if the Connect to AutoCAD option has been selected from 
the File menu. 

 

Options 
These options are available as a function of both the source of the data and which other 
options have been selected. 
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Clearing Existing Block Definitions  

 

If this option is selected, all existing Block Definitions held in Fixture Studio are deleted 
and new definitions read in from drawing or database. The changes become permanent 
in the database until they are saved back. 

Overwriting Existing Block Definitions 

 

If this option is selected, any block definitions imported from the drawing or database 
overwrites the corresponding data in Fixture Studio with similar names in Fixture 
Studio. 

Overwriting Existing Block Definitions with Data Filters  
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If the Apply Data Filters option is selected, the filtered data from any block definitions 
imported from the central database overwrite the corresponding data in the Block 
definitions with similar names in Fixture Studio. 

 

All data options from the central database can be filtered (unlike Block definitions 
imported from a drawing, where options are more limited). 

Loading Blocks into Drawing 

This option is not currently implemented. It has been replaced by the Load Blocks 
into the Drawing option on the File menu. 

Saving Block Definitions 
Clicking on the Save Changes Icon brings up the Save Block Definitions dialog box. 
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Destination Frame 
The Destination Frame enables the user to specify whether data is saved to the drawing 
or to the database. 

The drawing option is only active if the Connect to AutoCAD option has been selected on 
the File menu. 

 If Database is selected, information will be written to the database. 
 If Drawing is selected (and Write block files is also selected), XData will be written to 

the blocks in the drawing currently linked to in the Connect to AutoCAD option. 

Options Frame 
 Add New Definitions adds all new definitions to the specified destination. This 

command should be used with caution as any block (including badly defined 
ones) is saved to either the drawing or database. 

 Enforce Save saves all Block definitions currently loaded into Fixture Studio and 
which have had changes made to the central database. 

 Save Dumb Blocks saves blocks without full information (for example insertion 
points) to the specified destination. 

 Only Save Selected Blocks saves only the Block definitions currently selected in 
Fixture Studio to the specified destination. 

 Write Block Files is only available when the Connect to AutoCAD option has 
been selected. If this option is selected, then Fixture Studio: 

– Writes a copy of the block file from the currently active drawing in Planner 
to the directory specified in the Categories tab of the Block Definition dialog 
box. 

– Writes XData to the block in the directory specified in the Categories tab of 
the Block Definition dialog box if the Database option has been selected in 
the Destination Frame. 

– Writes XData to the block in the currently active drawing in Planner. 

 Update Database with Drawing is only available when the database is selected as 
the only destination. It identifies all blocks in the drawing identified by the 
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Connect to AutoCAD option and writes the latest version of information in 
Fixture Studio to the database. 

Adding, Editing and Deleting Groups 
Groups are used to arrange fixture definitions into logical subsets. The resulting 
hierarchy is used in Fixture Studio for maintaining information on the equipment used in 
Macro Space Planning. The hierarchy also appears in the Object Browser in the Planner 
and Merchandiser modules and in In-Store Space Collaboration.  
Groups can be added, edited, and deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu.) 

 

Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click the 
Add Group icon. The Group dialog box appears. 

 

Enter a description and select an icon from the drop-down list. Click OK to conform. 

The group to be added is a child of its selected parent group. 

Editing a Group 
To edit a group, highlight the group which is to be edited. Click the Edit Group icon. The 
Group dialog box appears. 

 

Edit the description if required. It is also possible to select an alternative icon from the 
drop-down list. Click OK to confirm. 

The Group details are updated. 

Deleting a Group 
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To delete a group, highlight the group to be deleted. Click the Delete Group icon. 

If the Group to be deleted has child groups or block definitions, a warning dialog 
appears. 

 

If there are no child objects, the group is deleted without any requirement for 
confirmation. 

Filtering Blocks  
The list of blocks contained in the Block Details dialog box may be filtered using the 
filtering option on the toolbar. 

 

Filtering by name uses implied wild cards, although ‘*’ and ‘?’ are also allowed. 

 

 

Search String Result 

Leg All examples of blocks containing Leg 

I_BR_T-Leg_1x48x72 Find that exact file name 
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Search String Result 

I_BR_T-Leg_1* Find all examples of blocks beginning I_BR_T-Leg_1 

 
To show all blocks again, clear the text box and press Return. 

Filtering by Block Status 
The Block Status can be seen to the left of the Block Definitions Window.  

 

By using the Block Status frame it is possible to select blocks meeting specific stages of 
being registered in Fixture Studio. 

Icon Description Comments 

 
Show Valid 
Blocks 

These are blocks that have just been updated 
by having the XData written to the blocks 
stored in the directory specified in the 
Categories tab of the Block Details dialog box. 

 
Show New 
Blocks 

These are blocks just imported into Fixture 
Studio. 

 
Show 
Changed 
Blocks 

These are blocks where the data has been 
changed in Fixture Studio but not yet written 
back to the database. 

 
Show 
Database 
Blocks 

These are blocks where the information in 
Fixture Studio matches that held in the 
database. 

 
Show Drawing 
Blocks 

These are blocks in the drawing containing 
XData, but the information has not yet been 
written back to the database. This is achieved 
by assigning data in the Block Details dialog 
box and then writing that data back to the 
drawing, but not the database. 

 
Show Dumb 
Blocks 

These are blocks where no Macro Space 
Planning information has been assigned. They 
are pure AutoCAD blocks. 

Filtering by Block Type 
By using the Block Type Frame, the blocks displayed in the Block Definitions window 
can be restricted to those of specific types. 



Toolbar 

Overview of Fixture Studio Module 51 

 

These types are set in the Retail Type drop-down list in the Category Tab of the block 
Details dialog box.  

 

  Find Block Definitions 
Clicking the Find Icon on the toolbar brings up the Find Block dialog box. 
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To use the Find Option, type in the required search string into the Find box and press 
Return. A list of block definitions matching the search string appears in the box below.  

To display a block definition in the hierarchical tree in the Object Browser, highlight it in 
the list of block definitions and click the OK button. The block definition in the Object 
Browser is highlighted and the Find Block dialog box closes. 

Note: The search string does not allow wild cards such as ‘?’ 
and ‘*’. The search string does match any block description 
with a comparable string in the ID, Name or Description 
fields. In the above example the search string rack has 
matched instances of the name Leg. 

Setting Columns 
The columns that display in the Block Definitions window can be configured by clicking 
the Set Columns in Grid Icon in the toolbar. 

The columns displayed in the Gondola Definitions window cannot be configured. 

 

This brings up the Columns dialog box. 

 

The Columns frame on the left contains a list of the columns that are currently displayed. 
The Available Frame on the right contains a list of columns that are not being currently 
displayed. The list of columns to be displayed can be modified by making use of the 
selection arrow in the middle of the dialog box. 

When the selection has been made, clicking OK results in the Block Definition table being 
rearranged accordingly. 
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2 
Relationships with Other Modules 

Overview 
The settings made within Fixture Studio are affected by and interact with settings made 
within other modules in Macro Space Management 

 

Admin Module 
The following can be configured within the Admin Module: 

 List of Manufacturers 

 List of Ranges 

 Available statuses 

 List of possible Styles 

 List of default units 
 User Defined Attributes 

Configuration Module 
The Directory for graphics (dwg and 3DS) files can be configured within the 
Configuration Module. 

Layers 
This module contains a list of the aliased layers that a block can be inserted on and that 
the connections are valid on. These can only be configured in Planner. 

Levels 
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This module contains a list of the available levels that a block can be inserted on. These 
are only configurable in the database. 

Product Studio 
This module contains a list of available materials that affects the appearance of the 
graphics. 

The Admin Module 
The List of Manufacturers is used in the General Frame of the Categories tab in Block 
Definitions. 

 

The List of Manufacturers can be configured using the Manufacturers option on the 
General menu in the Admin Module. 

 

This brings up the Manufacturers dialog box. 

 

This enables a list of manufacturers to be built up and edited.  
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The list is primarily used for reporting purposes. 

For more information, consult the Admin Module Help File.  

Configuring the List of Ranges 
The List of Ranges is used in the General Frame of the Categories tab in Block 
Definitions. 

 

The List of Ranges can be configured using the Ranges option on the Edit menu in the 
Admin Module. 

 

This brings up the Ranges and Range Groups dialog box. 

 

Configuring the Available Statuses 
The List of Statuses is used in the General Frame of the Categories tab in Block 
Definitions. 
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The List of Statuses can be configured using the Status option on the General menu in the 
Admin Module. 

 

This brings up the Status dialog box. 

 

The Statuses available for blocks can be added, edited, and deleted.  
Their order can also be configured. Changes can be defined as reversible or irreversible 
and files can be set to read-only status when that status is reached.  

Finally, statuses can be set to be selectable or not selectable. Selectable statuses can be 
selected manually. Non-selectable statuses change automatically when other actions are 
carried out.  
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Configuring the List of Styles 
The List of Styles is used in the Available Styles Frame of the Styles/Ranges tab in Block 
Definitions. 

 

The List of Styles can be configured using the Styles option on the Edit menu of the 
Admin Module. 

 

This brings up the Styles dialog box. 
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Styles can be added, edited and deleted in the Styles tab. 

The relationships between the varying types of styles can be defined in the Style 
Relationships Tab.  

The Test Tab allows users to conform the requisite Style Relationships have been defined. 
  Configuring the Default Units 

The List of Units is used in the General Frame of the Categories tab in Block Definitions. 

 

The List of Units can be configured using the Units option on the Edit menu in the 
Admin Module. 
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This brings up the Units Admin Tool dialog box. 

 

This allows units to be added, edited, or deleted. 
It also allows other settings to be specified (for example, whether use of that unit is 
mandatory). 

Configuring User Defined Attributes 
The List of User Defined Attributes is used in the UDA tab in Block Definitions. 
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The List of User Defined Attributes (UDAs) can be configured using the User Defined 
Attribute option on the Edit menu of the Admin Module. 

This brings up the User Defined Attributes dialog box. 

 

This allows user-defined attributes to be added, edited, and deleted. 

System Variables 
System Variables can be configured within the Admin Module. 

The Configuration Module 
The Directory used is in the General Frame of the Categories tab in Block Definitions. 
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This determines the directory where Macro Space Management looks for the graphics 
associated with the corresponding block definitions. 

The Configuration Module can be accessed from the Administration module. Directory 
paths can be set in the Directories Tab. 

 

Layers 
The List of Layers is used in the Layers frame of the Insertion tab in Block Definitions. 
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It is also used in the Layer Alias frame of the Connections tab in Block Definitions. 

 

The List of Layer Aliases can be configured using the Layers > Layers option on the 
Format menu of the CAD environment. 

 
This brings up the Layers and aliases dialog box. 
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This can be used to configure Layers and Layer Aliases. 

Levels 
The List of Levels is used in the Insertion tab in Block Definitions. 

 

The list of levels is configured directly in the central Macro Space Planning database.  

If additional levels are required, contact Oracle’s Technical Support Team for further 
assistance. 

Product Studio 
The List of Materials is used in the General Frame of the Category tab in Block 
Definitions. 
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The List of Materials can be configured using the Materials option on the View menu of 
Product Studio. 

 

This brings up the Materials dialog box. 

 

This can be used to add edit and delete options determining the surface appearance of 
graphics blocks inserted into the Merchandiser environment. 
It has no effect on how graphics display in the Planner environment. 
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About Fixture Studio Basics 
Once Fixture Studio is set up, it is difficult to make changes to its configuration.  

Time spent considering the optimum way to set up Fixture Studio will be repaid many 
times over when fixtures and gondolas are used in the Planner and Merchandiser 
environments.  

 There are a number of things to consider prior to setting up Fixture Studio. These 
include: 

Use of Directory Structure   
Depending on the size of the retail organization, there may be hundreds, thousands, or 
even tens of thousands of fixtures.  

The graphics for these fixtures are stored in directories. Consider carefully the number of 
directories you need. With only a limited number of fixtures, one directory may be 
sufficient. With tens of thousands of fixtures, it may be more logical to create a number of 
directories.  

Naming Conventions 
Naming conventions have two purposes.  

Firstly, it can make it easier to identify the required block from a long list of available 
blocks. Secondly, and more importantly, it affects the ease of defining gondolas.  

Without a good naming convention, you may need to define hundreds of gondolas.  
With a good naming convention you may only need to define ten or twenty gondolas.  

Setting up Logical Hierarchies 
Fixtures and Gondolas are stored in hierarchies. 
Setting up logical hierarchies makes it easier to maintain the Fixtures and Gondolas 
within Fixture Studio. It also makes it easier for users to select fixtures and gondolas in 
Planner and Merchandiser.  

Using Stretchable Fixtures 
Stretchable Fixtures are fixtures that can be placed in the drawing and then configured to 
a range of preset sizes.  

Using stretchable fixtures reduces the number of fixtures required.  

However, if stretchable fixtures are used, it will not be possible to produce accurate 
reports on what fixtures and fittings are present in stores.   

About Connections 
Connections determine which items of equipment can be connected to which other items 
of equipment.  
Having a simple and consistent scheme for connections makes it easier to define those 
connections.  
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About Styles 
Styles determine which items of equipment can be placed on each other and which styles 
of product can be placed on what items of equipment.  

A logical list of styles and style relationships aids placement.  

Summary of Fixture Studio Basics 
The general flow for deciding on how to set up Fixture Studio is as follows: 

 

Fixture Categories 
For a large retail organization, there may be many thousands of fixtures and fittings. 
These could be assembled into many hundreds of types of gondola.  

Prior to setting up fixtures and gondolas within Fixture Studio, some thought must be 
given to how all this information is organized.  

Unless it is arranged in a simple and logical manner, considerable time will be wasted 
later trying to find specific fixtures or gondolas, or trying to attach one pieces of 
equipment to another when the styles are incompatible.  
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It is recommended that a table such as the following be produced as a basis for deciding 
how Fixture Studio is to be configured. 

 

Equipment 
Category 

Equipment 
Sub-Division 

Connections to Style Relationships 
with 

Hussmann Primary 

• Legs (6) 

• Backpanels 
(20) 

• Slatwalls 
(12) 

 

 

• Other Primary 
Hussmann 
Equipment 

• Secondary 
Hussmann 
Equipment 

• Some items of 
Primary Generic 
Equipment 

 

• Other Primary 
Hussmann 
Equipment 

• Secondary 
Hussmann 
Equipment 

• Product Display 
Styles 

 

Secondary 

• Open 
Shelves (30) 

• Wire 
Shelves (16) 

• Hanging 
Bars (6) 

• Lateral Rods 
(4) 

 

 

• Primary 
Hussmann 
Equipment 

• Other Secondary 
Hussmann 
Equipment 

• Tertiary 
Hussmann 
Equipment 

 

• Primary Hussmann 
Equipment 

• Other Secondary 
Hussmann 
Equipment 

• Product Display 
Styles 

Tertiary 

• Dividers  (2) 

• Grilles (4) 

 

 

• Secondary 
Hussmann 
Equipment 

 
N/A 

Lozier Primary            N/A N/A 

Secondary        N/A N/A 

Tertiary             N/A N/A 

Generic Primary            N/A N/A 

 Secondary        N/A N/A 

 Tertiary             N/A N/A 

Directory Structures 
Depending on the size of the retail organization, there may be hundred, thousands or 
even tens of thousands of fixtures. The graphics for these fixtures are stored in 
directories.  
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Consider carefully the number of directories you need. With only a limited number of 
fixtures, one directory may be sufficient. With tens of thousands of fixtures, it may be 
more logical to create a number of directories. 

Directories will mainly be used by people within Fixture Studio to store graphics and to 
select the graphics for editing or deletion. Too few directories will result in each directory 
containing hundreds of graphics files. Too many directories will make it difficult to 
remember which directories the graphics are in. It is recommended users list out the total 
number of graphics that are expected to be used within Macro Space Management, 
together with suggested classes they fall into. The number of fixtures that fall into each 
suggested class can then be estimated.  This can be seen as the bracketed figures in the 
suggested table. 

When classes have been selected that contain a sensible number of fixtures, the directory 
structure can then be set up accordingly. 

In this example, some subdirectories have been set up in the folder where the Macro 
Space Management directories are stored.  

 
Client data serves as a parent directory. The parent directory contains three 
subdirectories called Miscellaneous, Racking, and Shelves. These serve to hold the 
graphics for those classes of fixtures.  

Note: Each fixture normally has two classes of graphics 
associated: .dwf files for display in the Planner environment 
and .3DS files for display in Merchandiser. 

The directories that the graphics have been assigned must have their paths specified in 
the Directories Tab in the Configuration Module. 

Setting up Directory Structures 
Directory Structures need to be set up before fixtures can be imported into them.  

This is done in two stages: 
 Create the required directories using Windows Explorer. 

 Set up the required links in the Configuration Module. 

Creating the Required Directories using Windows Explorer 
Using Windows Explorer, navigate to where the Macro Space Management data files are 
held. Create the required directories.  
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Setting Up the Required Links in the Configuration Module 
The Directories tab configuration module can only be accessed from the Administration 
Module. 

 

Use the Add button to add paths to the directories made using Windows Explorer. 

Naming Conventions 
Note: Naming conventions are important to the efficient 
operation of Macro Space Management. They must be 
decided upon before any blocks are imported into Fixture 
Studio. Lack of a naming convention will make it more 
difficult to locate the require fixture blocks.  

A naming convention is a planned and logical way of assigning block names.  

Names like Widget-187567 and Gizmo-ADRTYN do not make it clear what the blocks are 
for or what their dimensions are.  
Here is an example of an organized naming convention: 
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In the above example, there are three types of block: Back Panels, L shaped uprights, and 
T shaped uprights.  

The back panels have widths of 600 and 900 mm, and heights of 1400, 1600, 2500 and 
2900 mm.  
Both the L and T shaped uprights come in four heights; 1400, 1600, 2500 and 2900 mm. 

Widget-187567 might well be a back panel of width 600 mm and height 2500 mm; 
however, this is not clear from the block name. 

Naming Conventions 
Naming conventions are of the general form: 

Prefix-parameter-parameter-parameter-suffix 

These can be any combination of numbers and letters, together with several separating 
characters. 

The separating characters can be: 
 A minus sign (-) 

 An underscore ( _ ) 

 An x  

Each of the following naming conventions is equally valid: 

 Prefix-Parameter-Parameter-Parameter-Suffix 

 Prefix-ParameterxParameterxParameter-Suffix 
 Prefix_ParameterxParameterxParameterxSuffix 

Note that the use of naming conventions must be consistent. Naming blocks with a 
mixture of ‘–’, ‘_’ or ‘x’ will lead to errors.  

The following example shows incorrectly named back panels. Macro Space Management 
expects to find the same separating character for blocks within a naming convention.  

 Backpanel-600-1400 
 Backpanel-600x1600 

When the program draws a gondola, if it expects to see: 

Prefix-Width-Height 

And some of the blocks are named: 
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Prefix-WidthxHeight 

It will find blocks with name like Backpanel-600-1400 because these are in the expected 
form. It will fail to find blocks with names like Prefix-widthxheight because there is an ‘x’ 
present where Macro Space Management expected to find a ‘–’. 

Examples of Naming Conventions 
The examples below are all valid examples of naming conventions: 

Prefix-Size 
 Leg-1500 

 Leg-2000 

 Leg-2500 

Prefix-WidthxHeight 

 Backpanel-600x1500 

 Backpanel-900x1500 
 Backpanel-1200x1500 

Prefix-Width-Depth-Height  

 FreezerUnit-600-800-300 

 FreezerUnit-600-800-400 

 FreezerUnit-600-1000-500 

Prefix-Width-Depth-Height-Suffix 
 FreezerUnit-600-800-300-Lozier 

 FreezerUnit-600-800-400-Lozier 

 FreezerUnit-600-1000-500-Lozier 

 FreezerUnit-600-800-300-Hoffmann 

 FreezerUnit-600-800-500-Hoffmann 

 FreezerUnit-600-1000-500-Hoffman 
Prefix-Size 

 Podium-Small 

 Podium-Medium 

 Podium-Large 

In general, naming conventions should be specified such that the block name provides all 
the information required. For example: 
Prefix-Width-Depth-Height-Suffix 

Gondolas that are defined using block names with this form make it easy to choose: 

 Specific type – for example Freezer Units 

 Specific width – for example 600, 800 and 1000 mm 

 Specific depth – for example 800, 1000 and 1200 mm 

 Specific height – for example 400, 500 and 600 mm 
 Manufacturer – for example Lozier 

Gondolas and Naming Conventions 
If naming conventions are assigned to Fixture blocks, then these blocks can be 
automatically be selected by including the correct options during Gondola definition.  
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When the gondola is placed in Planner or Merchandiser, a list of dimensions (and 
sometimes options) will be available in the Add Gondola dialog box.   

 

In the above example, a gondola can be placed with any combination of two widths and 
four heights (eight combinations in all). Here, a width of 600 mm and a height of 2500 
mm have been selected. When the gondola is created in the drawing, it will be done by 
reconstructing the required block name, based on information in the gondola definition. 
The application uses a back panel with a name of Backpanel-600-2500.  

If naming conventions were not used when defining this gondola, eight separate 
gondolas would have to have been designed in Fixture Studio.  
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Using gondola definitions in this way only works if a consistent naming convention has 
been used for the blocks used to draw the gondolas. This means that blocks must be 
imported into Fixture Studio using a good naming convention from the start.  

Stretchable Fixtures 
Stretchable fixtures are a special feature of Macro Space Management used so that those 
fixtures can take up a range of permitted sizes.  

Placing stretchable fixtures reduces the number of fixtures required as the same fixture 
could be placed in (for example) 600 mm, 700 mm and 800 mm widths.  

Use stretchable fixtures if you do not want accurate reports on what equipment is present 
in stores. Do not use stretchable fixtures if you want accurate reports on equipment.  

It is possible to generate reports on what equipment is present in one or more stores.  

If a stretchable back panel has been used in 600, 700 and 800 mm widths, then the report 
will only show the present of the stretchable back panel.  

If 600 mm, 700 mm and 800 mm wide back panels have been individually placed, it is 
possible to generate an accurate report on how many of each width of back panel is 
present in a store.   

Connections 
Connections are used to determine what items of equipment can connect to what other 
items of equipment.  

 Connection set-ups should be kept as simple as possible with regard to connecting 
together equipment in the correct alignment and ensuring non compatible equipment 
cannot be connected. Connections should also be used in conjunction with styles.  

For one item of equipment to connect to another, the following must be true. 

 Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders. 

This requirement can be 
disabled in the 
Configuration Module. 

Shape The connection points must have the 
same shape. 

This requirement can be 
disabled in the 
Configuration Module. 

Size The connection points must have 
compatible sizes. 

This requirement can be 
disabled in the 
Configuration Module. 

If any of these criteria are not true, then a connection cannot be made. 
In addition, if the details of the connections are not correctly specified relative to each 
other, equipment may connect together in unintended alignments.  

It is suggested the use of connection parameters is planned beforehand. 

Connections can be made easier to use by means of well planned hierarchies. For 
example, all equipment in the Lozier group would be expected to have connections 
designed to be compatible. 
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Planning the Use of Connections 
The following guidelines are recommended for planning the systematic use of 
connections. 

Connection Names 
Connections should be assigned logical names such as Peg or Slatwall. This enables their 
purpose to be seen at a glance.   

Gender 

Permissible Values Comment 

Male, Female, Neutral. Male connects with female.  

Neutral connects with itself and both male and 
female. 

Specific conventions such as male and female connections always point in opposite 
directions when defined.  

This means that when two items of equipment are inserted in Merchandiser next to each 
other and facing the same way, the male and female connections always mate when 
selected for joining.   

Logical conventions such as pegs and hanging rods always have male connections, and 
the holes or slots they fit into have female connections.  

Shape 

Permissible Values Comment 

None, Rectangle, Circle, 
Oval, Triangle, Hexagonal. 

Specific shapes only connect with themselves and 
None. 

Assign the shapes to equipment by function. For example, assign connections of shape 
Rectangle to Legs, Slatwalls and Back Panels and connections of shape Circle to Pegs, 
Hanging Rods. 

Slatwalls and Back Panels can only connect to Legs and not (say) Pallets. Similarly, Pegs 
can only connect to the appropriate connections on the Back Panel.   

(Equipment that has to connect to multiple types of equipment can be assigned the shape 
of None.) 

Size 

Permissible Values Comment 

Minimum size 0, maximum 
size 1000. 

Two items of equipment must have overlapping 
connection sizes to connect.  

Connection sizes can be assigned according to purpose. For example: 

Size Purpose 

11 - 15 Floor mounted (primary) equipment 

6 - 10 Shelves and other secondary equipment 
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Size Purpose 

0 - 5 Dividers, grilles and other tertiary equipment 

Connection types intended to let floor mounted equipment only join to each other can be 
assigned one size range.  

Shelves can be assigned another size range of connection types that only let them connect 
to the equivalently sized connections on primary fixtures such as back panels and 
slatwalls.  

Dividers and grilles can be assigned another size range of connection types that only let 
them connect to the equivalently sized connections on secondary fixtures such as shelves.  

If the size ranges are correctly assigned then although the gender and shape of a 
connection might be compatible, equipment will be prevented from joining 
inappropriately. For example a divider will only place on a shelf. 
These connection requirements can always be overridden by turning off the filters in the 
Fixtures Tab of the Configuration Module.  

As well as Connections, Styles can be used to determine what item of equipment can be 
connected to what. If it is intended to join one item of equipment to another, both the 
Styles and the Connections must be compatible with that aim. 

Styles 
Styles are used to determine what is compatible with what.  

Styles and Style Relationships should be kept as simple as possible with regard to 
making sure equipment connects together in a compatible manner and Ensuring the 
correct display style goes onto shelves and pegs. Styles should also be used in 
conjunction with connections.  
For example, the assigned fixture and shelf styles determine whether a shelf object can be 
placed on a specific item of equipment or not.  

For example, styles allow pegs to be placed in pegboards, but not on open shelves. 

Similarly, the assigned product style determines whether the product can be placed on 
for example a shelf.  

Product of Pegged style can be constrained to only place on pegs, while products of 
Boxed Style can be constrained to only place on wire, open and heavy duty shelves. 

Styles can be made easier to use by means of well planned hierarchies. For example, all 
equipment in the Lozier group should have styles designed to be compatible. 

Planning the Use of Styles 
In planning the use of Fixture and Shelf Styles, keep the number of styles to the 
minimum possible. This is because for Style Relationships: 

 Each shelf object that goes onto a fixture has to have a compatible style 
relationship with that fixture. 

 Each product that goes onto a fixture has to have a compatible style relationship 
with that fixture. 

 Each product that goes onto a shelf object has to have a compatible style 
relationship with that shelf object. 

If there are large numbers of Fixture, Shelf and Product Styles, it will be difficult to set up 
and maintain the list of style relationships.  
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For example, it is best to avoid manufacturer specific shelf styles unless there are actual 
reasons for doing so.  

Thus it is better to have a General Shelf style rather than Hussman Shelf, Lozier Shelf and 
Franklin Shelf, as having three separate shelf styles means three times as many style 
relationships need to be set up.  

As well as Styles, Connections can be used to determine what item of equipment can be 
connected to what. If it is intended to join one item of equipment to another, both the 
Styles and the Connections must be compatible with that aim. 

Naming Conventions 
Gondola creation relies on a convention for block naming. Blocks should be named in a 
systematic manner.  

 

Naming conventions are often of the general form Block Type-dimension-dimension-
dimension. 

In the above example, the convention is Back panel-width-height.  

• Backpanel-600-1150 is a back panel 600 mm wide x 1150 mm high. 

• Backpanel-600-1500 is a back panel 600 mm wide x 1500 mm high. 

Components for gondolas are selected using these name conventions, so it is important 
that a consistent scheme is used when creating blocks. If this scheme is not consistent, it 
may not be possible to select the required blocks for creating gondolas. Block names can 
also include suffixes, for example -HD and -HD-Foot.  

 

Suffixes can be used to further restrict the list of available blocks for a specific gondola. 

Block Details Dialog Box 
The Block Details dialog box allows the user to give the Wblock (World Block) created in 
Planner the intelligent properties needed by Macro Space Management to carry out the 
full range of its fixturing, merchandising, and reporting functions. 

Data added to Block Details is stored in the central Macro Space Management database. 
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The Block Name at the top of the dialog box must correspond to that of the AutoCAD 
Wblock it is associated with.  

If they do not correspond, the Macro Space Management block cannot be placed in the 
CAD or Virtual Reality environments.  

The Block Description allows the user to enter a more comprehensive description of the 
block.  

The Tabs allow the user to switch between various categories of Macro Space 
Management Block information. There are eleven tabs in total: 

 Category 

 Insertion 

 Size 

 Connections 

 Parts 
 Fixture 

 UDAs (User Defined Attributes) 

 Styles/Ranges 

 Merchandisable Areas 

 Shelves 

 Preview 
Each tab is split into a series of frames. Each frame deals with one aspect of the 
information on that tab. 
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Composite Blocks 
Composite blocks are super-blocks made up of a number of individual AutoCAD blocks. 
In the example below the composite at the rear represents a combination of fixtures that 
might form a checkout installation. These include the checkout itself, a cupboard for 
storing bags, racking for holding products for last minute impulse buys and a chair for 
the checkout operator. These are shown in expanded form at the front of the diagram. 

 

Composites provide a simple way of repetitively placing combinations of objects. 
Examples of how composites could be used include: 

 Combinations of equipment such as checkout complexes. 

 Entire departments of equipment. 

 Custom arrangements of equipment such as storage racking 

Composites are made by first creating the individual blocks, placing then into the correct 
alignment, then making them into a composite block. Both the individual blocks and the 
composite block have to be registered in Fixture Studio. 

Composite Blocks and Merchandiser 
Composite blocks are not visible in the Fixture Hierarchy in Merchandiser. If unexploded 
composites are present in a floor plan, they will not be visible in the Merchandiser floor 
plan. 

Configuring Composite Blocks 
Composite blocks are super-blocks made up of a number of individual AutoCAD blocks. 
In the example below, a desk, chair and filing cabinet are going to be made into a 
composite for placing into offices in superstores. These are shown in composite form on 
the left and separated into their individual components on the right. 
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To make a composite block, the individual blocks must first have been created and 
registered in Fixture Studio. 

 

Next the individual blocks are inserted into a Planner drawing and put into the required 
alignment. 

 

There are then selected and the AutoCAD Block command used. 
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Once the composite block has been created, it can be registered in Fixture Studio using 
standard methods. The settings specific to a composite block in the Block Details dialog 
box are as follows: 

Category Tab 

 

1. Set Retail type to Composite. This acts as a flag for some of the Macro Space Planning 
functionality, meaning that the composite block is treated in a specific way. For 
example, the composite block is 

2. Set the Icon to Composite. This indicates to users in Planner that this particular block 
is a composite. 

Insertion Tab 
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The Explode Block on Insert option must be checked. This causes the composite to break 
up into its component parts when inserted into a floor plan. This is important because 
composite blocks are not visible in Merchandiser.  

Product Blocks 
 

Product blocks are used to represent the volume taken up by products.  

Planner  
In the Planner module, product blocks are used as placeholders. They show the volume 
that products occupy but give no information on product quantities. 

 

A different product block has to be created for each shape of fixture. In the above 
example, three different forms of product block are required to suit the three different 
shapes of fixtures.  

Merchandiser 
In the Merchandiser module, product blocks can be used to represent the shape of the 
product at the display style level. 

 

In the above example, the left hand set of products is displayed as a Textured Box, and 
the right hand set of products as a Graphical display using a product block to represent 
the shape of the products. 

Creating Product Blocks 
Product blocks are created in Planner and then designated as such in Fixture Studio. This 
is done by setting the Retail Type in the Equipment Type frame in Categories tab of the 
Block details dialog box to Product. 
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Assigning Product Blocks to Fixtures 
Product blocks are assigned to Fixtures in the Fixture tab of the Block Details dialog box 
in Fixture Studio.  

 

The assigned product block is then used to display product placeholders when a product 
is placed in the Planner module. 

Assigning Product Blocks to Display Styles 
Product blocks are assigned to display styles in the Shape drop-down list of the Size and 
Shape tab of the Display Style dialog box in Product Studio. 
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This product is used when the Draw Products as option (right click menu) is set to 
Graphical in Product Studio. 

Configuring Product Blocks 
Product blocks are created in two stages: 

 The product block is drawn in the Planner module. 

 The product block is registered in Fixture Studio.  

Product blocks can be used in the Planner module, the Merchandiser module, or both. 
 Depending on where they are used, they may require slightly different properties. 

 For the Planner module, the product block needs to be hatched so that it stands out 
in a wire frame drawing 

 For the Merchandiser module, the DWG file for the product block needs to be 
converted into 3DS format so it can be displayed. If the product block is to be display 
in Merchandiser only, it does not require hatching. 

Drawing the Product Block 
The product block should be drawn in the planner module. If the product block is being 
drawn for the Planner module, its faces should be hatched. As hatching can only be 
carried out on flat surfaces, this restricts the form of the product block. The example 
below shows a triangular product block and (on the right) a partially exploded form 
showing how it was constructed. 

 

Curved surfaces can be approximated by many sided polygons. In the example below, a 
circular product block has been created from a 32-sided polygon. (The right hand side 
shows a partially exploded product block.)  
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Alternatively, more complex product blocks can be drawn purely for Merchandiser. In 
the example below, a desk-shaped product block has been created in Planner (left side). 
When appropriately configured, this can be used to represent desks at Display Style level 
in the Merchandiser module. 

 

Once the product block has been drawn, it can be made into an AutoCAD block and 
imported into Fixture Studio. 

Reference Blocks 
Reference blocks are used for Bay and Aisle numbering. 

 

 

In the example above, the fixtures have been allocated bay numbers using a circular 
reference block, while the same reference block has been used to add the aisle number. 
Reference blocks are supplied with the application and there is not usually any need to 
change them. 
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Title Blocks 
Title blocks are used to put a frame round a drawing in preparation for printing it. Title 
blocks can also contain information on the drawing.  

 

The title block is an AutoCAD DWG file that overlays the store plan on model space. It 
contains information on the drawing and one or more view ports to display the drawing.  

The view port is a specified area within the title block where the drawing appears. View 
ports can be set to precise scales. 

The title block information is a specific part of the title block. It contains fields that 
populate with data about the drawing. In the above example the fields include the store 
name and store code. The data to populate these fields is read from two sources: 
 From information imbedded into the drawing by the software 

 From the database by using custom SQL   

Each title block is designed for a specific size of paper, so if drawings are to be printed off 
in a range of sizes, title blocks should be created for each size. A metric implementation 
of Macro Space Management may contain title blocks for A0, A1, A2, A3 and A4 size 
paper, while an imperial one may contain title blocks for ANSI A, ANSI B, ANSI C, ANSI 
D and ANSI E size paper.   

Creating the Title Block in Planner 
Creating the title block in the Planner Module requires a series of actions to be carried 
out. 
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Establishing Required Dimensions 
Title block size has to take into account the printable area on the selected paper size. For 
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of 
all that area and a border (called the non-printable area) that cannot contain any lines or 
text exists around the edges of the paper.  

 

The size of the title block needs to take into account the non-printable area. For example, 
if A3 paper is used, and the non-printable area is 6 mm wide, then the title block needs to 
be drawn at 285 x 408 mm to fit exactly into the printable area of the paper. The insertion 
point of the title block is normally set at 0,0, as 0,0 in the paper space layout is defined as 
the lower left corner of the printable area. 

Draw Frame and Text Boxes 
After the size has been established, a frame can be drawn in planner and text boxes 
added.  

 

 

The title block is usually drawn with the origin at 0,0.  
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Add Attribute Definitions 
Attribute definitions are used to set up the template attributes for the text boxes. They are 
invoked by typing the ATTDEF command into the AutoCAD command line in Planner. 

 

This brings up the Attribute Definition dialog box. 

 

The attribute definitions can then be put into the drawing. 

 

Attribute tags should always be continuous text. If necessary, join two words with an 
underscore: WORD1_WORD2. 

The attribute tags should either match the names of the data stamped into the drawing or 
the Column Aliases in the Custom SQL. 

Turn into Block 
The title block can then be turned into a block with the block command. This can either 
be initiated from the Draw toolbar or from the command line.  
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The individual components of the title block are then combined to make a single object. 
This block definition is stored in the current drawing and is not yet globally available.  

Write Block (Wblock) to Make Externally Available 
The Write Block (WBlock) command is used to write the block definition to an external 
directory where it can be used in any Macro Space Management drawing. The command 
is invoked by typing WBLOCK into the command line. 

 

 

The destination should be a directory specified in the Directories Tab of the 
Configuration Module.   

Registering the Title Block in Fixture Studio 
Registering the title block in Fixture Studio requires the following steps: 
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Selecting the Parent Fixture Group 
All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy 
contains a Fixture Group called Title Blocks. This is the usual location for title blocks.  

 

Create a Block and Enter the Block Name 
Create a block by invoking the Add Block option from the Edit menu or the toolbar. This 
brings up the New block name dialog box.   

 

Ensure that the block name entered exactly matches the block name specified in the 
WBlock command used in Planner. On clicking OK, the Block Details dialog box appears 
for editing. 

Enter Settings in the Block Details Dialog Box 
The Block Details dialog box allows custom properties to be assigned to the title block. 
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Full details of how to use this dialog box can be found in the Fixture Studio help file. The 
principal settings pertinent to title blocks are: 

Category Tab 
1. Set the Retail Type to Title Block. 

2. Set the Directory to match that specified in the WBlock command when the block 
was saved in Planner. 

3. Set the Units as appropriate. 

4. Set the Icon to Title Block.  

Insertion Tab 
1. Set the Layer to Other > TITLEBLOCK. 

2. Level can be left as Undefined. 

Size Tab 
1. The Sizes should be set as appropriate. 

2. Height can be left as 0.00001. This nominal value is to avoid divide by zero errors in 
the code. 

Adding Title Block Information in the Admin Module 
Adding title block information in the Admin Module is in two stages: 

 

Specifying Title Block Details 
Title Blocks are added, edited, or deleted using the Title Blocks option from the Planning 
menu. This brings up the Title Blocks dialog box.   
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Name is the nominal name of the title block.  
Block name is the name of the block for the title. It can be selected from a drop-down list. 
This list contains the name of all blocks of type Title Block is Fixture Studio. 

Width is the nominal width of the paper the title block is designed for. It is for display 
purposes only. 

Height is the nominal height of the paper the title block is designed for. It is for display 
purposes only. 
Width Offset is the offset of the insertion point of the title block in the X plane relative to 
the lower left corner of the printable area on the paper the title block is designed for. 

Height Offset is the offset of the insertion point of the title block in the Y plane relative to 
the lower left corner of the printable area on the paper the title block is designed for. 

Default Scale is the default scale that will be applied to the view ports when they are first 
defined in the Title Block dialog box. 
Canonical Media is selected from a drop-down list. It should be set to the size of paper 
the title block is designed for. 

Title Blocks can be added or deleted using the appropriate options on the Edit menu or 
the toolbar. Selecting the edit option on the Edit menu or the toolbar will bring up the 
Title Block dialog box. 

Specifying Viewport Details 
The Title Block dialog box is used to specify the details of the view ports in the title block. 
It is invoked by the edit option in the Title Blocks dialog box.  

 

 



About Fixture Studio Basics 

94 Oracle Retail Macro Space Management Fixture Studio User Guide 

The information to the left of the dialog box mirrors that of the Title Blocks dialog box. 
The information on the right of the dialog box is used to set up view ports. Title blocks 
may have multiple view ports. 

Width is the dimension of the view port in the X plane. 
Height is the dimension of the view port in the Y plane. 

Width Offset is the offset of the view port in the X plane relative to the insertion point of 
the title block. 

Height Offset is the offset of the view port in the Y plane relative to the insertion point of 
the title block. 

Scale is the scaling factor applied to the view port. 
View is the direction the drawing will be presented in the view port. Options include 
Plan and a number of isometric projection directions. 
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4  
Block Details Dialog Box 

Category Tab 
The Category tab is used to set general parameters for the block being defined.  

 

The Equipment Type Frame 
The Equipment Type frame can be used to specify basic parameters for the object. 

 

Retail Type  
Retail Type determines how the block behaves in the floor plan. For example, only blocks 
of type Fixture (Planner and Merchandiser) or Shelf (Merchandiser only) accept 
merchandise. This can be set using either the drop-down list or the wizard. 

Can Populate with Display Style 
The Can Populate with Display Style is only available if the Retail Type has been set to 
fixture or shelf. It determines whether the item of equipment can accept products at 
Display Style level in the Merchandiser module. 
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Can Populate with Placeholder  
The Can Populate with Product Placeholder is only available if the Retail Type has been 
set to fixture or shelf. It determines whether the item of equipment can accept product 
placeholders in the Merchandiser module. 

Attaches to Primary Equipment  
This determines if the object can attach to primary equipment (fixtures) in the 
Merchandiser module. It will be grayed out for certain Retail Types. 

Attaches to Secondary Equipment  
This determines if the object can attach to secondary equipment (typically shelves) in the 
Merchandiser module. It will be grayed out for certain Retail Types. 

Accepts Secondary Equipment  
This allows the object to accept secondary equipment (for example shelves and rods) in 
the Merchandiser module. It will be grayed out for certain Retail Types. 

Corner Block 
This is a flag to show that the particular item of equipment is designed to go into a 
corner, for example, to allow a run of fixtures to continue when it changes direction as a 
wall goes through a right angle. It also restricts options for populating and carrying out 
area calculations.    

The Equipment Wizard 
The Equipment Wizard allows the user to define the Retail Type by means of the two 
drop-down lists in the Equipment Type frame. It also allows the dimensions (Equipment 
Size frame) and the Connection Points (Spacing Frame) to be set.  
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Equipment Type Frame 
The Type and Description lists in the Equipment Type frame can be set to appropriate 
values for that block. When the OK button is clicked, the Retail Type and Icon are 
automatically set in the Categories tab of the Block Details dialog box. 

Equipment Size Frame 
The Equipment Size frame enables the dimensions to be entered. On clicking the OK 
button, these are automatically set in the Sizes tab of the Block Details dialog box.  

For the Calculate and Pick buttons to be active, the Connect to AutoCAD option must 
have been selected on the File menu. 
There are three ways of inputting dimensions: 

• Manually: numbers can be typed into the appropriate text boxes. 

• Calculate: if connected to an AutoCAD with an instance of the block in the drawing, 
clicking the Calculate button automatically populates the length, depth, and height. 

• Pick: if connected to an AutoCAD with an instance of the block in the drawing, 
clicking the Pick button takes the user to the drawing where the user can click two 
points (for example by using OSnap) to define that dimension. 

Spacing Frame 
The Spacing frame is used to set the dimensions for a vertical array of connection points. 
This can either be set manually or by means of the Pick buttons. The option is grayed out 
if the Retail Type (Equipment Type frame) is not appropriate.    

The General Frame 
The General frame enables the user to set a series of options concerning the general 
properties of the block.  

 

Directory 
The Directory block can be selected from a drop-down list. The list of available 
directories is specified in the directories tab of the Configuration module (accessed from 
the File menu).  
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Manufacturer 
The Manufacturer for the block can be selected from a drop-down list. This list is 
configured in the Administration Module (General Menu). 

Units 
Units specify the unit of measurement for the block. This should be set to the appropriate 
metric or imperial units. 

Material 
The Material can be selected from a drop-down list. It determines the color of the 3DS file 
used to represent the item of equipment in the Merchandiser module. The list of material 
is configured in the Product Studio module (View menu). 

Print Material 
The Print Material can be selected from a drop-down list. It determines the color of the 
item of equipment prints if a snapshot is taken of the view in the Merchandiser module. 
The list of material is configured in the Product Studio module (View menu). 

Status 
The Status can be selected from a drop-down list. It serves as an indication of where the 
block is in its business life cycle (for example, in service, or superseded from service). 
This status can be used for a number of purposes. These include: 

 Use as a filter for populating fixtures into the object grid. (This requires changes to 
the Custom SQL). 

 Use as a filter for Reporting Purposes. 

The list of Statuses is configured in the Administration module. 

Effective Date 
The Effective Date can be selected from the drop-down list. It is the date at which the 
item of equipment is set to come into service. Items of equipment before their Effective 
Date (or with their Effective Date before the Active Date of the Floor Plan) are grayed out 
and unavailable in the Object Browser in the Planner and Merchandiser modules. The 
Effective Date can also be used as a filter for reporting purposes.  

Expiry Date 
The Expiry Date can be selected from the drop-down list. It is the date at which the item 
of equipment is set to come into service. Items of equipment after their Expiry Date (or 
with their Expiry Date after the Active Date of the Floor Plan) are grayed out and 
unavailable in the Object Browser in the Planner and Merchandiser modules. The Expiry 
Date can also be used as a filter for reporting purposes.  

Product Code 
The Product Code is entered by the user. An example would be a manufacturer’s product 
code. It is used for reporting purposes. 

Icon 
The Icon for the block can be selected from the drop-down list. This list can only be 
customized by Oracle.  
The selected Icon then appears against the Block Definition in the various hierarchical 
trees. 
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   The Type Frame 

The Type frame specifies how the block is to be drawn in the AutoCAD drawing or 
Virtual Reality environment. 

 

Fixed Size blocks are always drawn at a constant scale. This is how most blocks are 
designated as it means they change in scale as the drawing scale is changed.  

The Graphics Frame 
The Graphics frame specifies what types of graphics are drawn in the AutoCAD 
environment. 

 

No Graphics is an option that can be used for blocks that are not visually displayed, such 
as parts.  

An example would be an associated block (such as a bolt or castor) that does not need to 
have graphics, but can still be included in reports. 

The drop-down list is used to specify the shape of the merchandisable area for fixture 
type blocks. 

 Rectangular is the default setting and should be used for all blocks of basically 
rectangular shape. 

 Circular can be used for all blocks with a circular profile. 
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 Semi-circular can be used for all blocks with a semi-circular profile. 

 Triangular caters for all blocks with an irregular profile. The functionality allows the 
user to draw an outline representing the merchandisable surface for the block.     

The Working/Stacking Axes Frame 
The Working and Stacking Axes frame determine how products align and stack on 
shelves in the Virtual Reality environment.  
They do not affect product placement in the Planner environment as products are 
represented by placeholders. 

 

Working Axis 
The Working Axis defines the directions products can be aligned on.  

 

 If the X axis is checked, products may be aligned along the length of the block. 

 If the Y axis is checked, products may be aligned over the depth of the block. 

 If the Z axis is checked, products may be aligned relative to the height above the 
block. 

The working axes selected have to be appropriate to the equipment.  
 For pegs, the Y working axis has to be enabled, as product has to be aligned 

along the length of the peg.  

 For peg boards, the X and Z working axes have to be enabled as products have to 
be aligned in a vertical place.  

 For chest freezers, the X and Y working axes have to be enabled as product has to 
be aligned over the bed of the unit. 

If only some of the working axes are checked, then not all the alignment commands will 
be enabled in Merchandiser.  

In the example shelf below, only the X Working Axis has been enabled. The product can 
therefore be aligned along the length of the shelf, but not relative to its depth and height. 
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Stacking Axis 
The Stacking Axis determines the directions products can be stacked in.  

If only some of the Working Axes have been checked, the Stacking Axes can be used to 
allow product to be stacked in more directions than they can be aligned.  

 
 

 If the X axis is checked, products may be stacked along the length of the block. 

 If the Y axis is checked, products may be stacked down the depth of the block. 

 If the Z axis is checked, products may be stacked vertically. 

In the example shelf below, stacking has been enabled in the X, Y and Z planes, allowing 
product to be stacked in both horizontal and the vertical directions. 

 

 

The Area Calculation Directions Frame 
The Area Calculations Direction frame is used to set the directions that the area 
calculation function uses when establishing the area apportioned to the fixture. (Fixtures 
and shelves are not used in the area calculations.) 

Area calculations are initiated from the Calculations menu in the Planner and 
Merchandiser menus. They allow users to take into account the amount of aisle 
apportioned to the fixture. For example, a fixture 4 feet long by 2 feet deep would have a 
footprint of 8 square feet. Area Calculations might assign a total area of 30 square feet to 
the fixture. Using this area for reporting purposes is more representative than the 
footprint. For example, reporting on sales per square foot would take into account the 
size of the aisle in front of the fixture. 
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Area calculation works by "feeling" out from the object in the specified directions. The 
starting point is the Front direction of the fixture. This is specified in the Insertion tab. 
The check boxes that are then selected should be appropriate to the function of the object. 
A wall-mounted fixture might have West, South and East selected. Feel out in front and 
to the sides. A freestanding display podium might have all directions checked because 
customers could approach from all points of the compass. 

  Reporting Options Frame 
The Reporting Options frame allows the user to specify whether the block definition 
should be excluded from reports or the central database. 

 

Not all blocks need be included in a report, for example, title blocks and some symbols 
such as directional arrows. It may not be necessary to store instances of a certain type of 
block in a database (for example, reference blocks) so there will not a record in the 
Fixtures table to represent the block. 

Exclude from Reports is a check box that can be used as a flag. This flag can then be used 
as a filter to exclude items in a report. 

Exclude Instances in DB is a check box allowing the user to exclude information from the 
drawing being stored in the database during a save. 

If you exclude instances of a block from the database, then it is also ignored when 
rebuilding the drawing from the database. 

Exclude Attributes would allow certain attributes of the block definition to be excluded 
from being stored in the central database.  

This option is not enabled in this implementation of Macro Space Management. 

Include in Fixture Annotation turns on annotation in the Planner module. If this option is 
checked, the block is annotated according to options set in the Text styles option 
(Planning menu) in the Administration module. 
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Non-Rectangular Merchandisable Areas 
Most fixtures or shelves are rectangular or semi-circular in section. Occasionally 
however, fixtures or shelves are less regular in shape. Fixture Studio provides a way of 
delineating the boundary of an irregularly shaped merchandisable area. 

 

 

This is achieved by using functionality accessed on the category tab of the Block Details 
dialog box in Fixture Studio. The steps are as follows: 

1. Open Fixture Studio and Planner. 

2. Select the Connect to AutoCAD option on the File menu. 
3. Open the required object for editing in Fixture Studio (Block Details dialog box). 

4. Set the shape to Triangular on the Category tab and click the Pick button. This opens 
a raw AutoCAD drawing, with the extent of the object outlined in yellow. 

5. Use the Load Blocks into the Drawing command on the File Menu to load an instance 
of the block into the drawing. 

6. Draw the shape of the object in the drawing. 
7. Delete the instance of the block in the drawing. 

8. Close the temporary drawing without saving it. 

9. If necessary, reset the dimensions of the fixture using the Calculate button. 

10. Save the Block in Fixture Studio. 

The results have associated a boundary with the block that defines the horizontal 
contours of the merchandisable area. The block then only accepts merchandise within 
that defined area.  
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Creating a Non-Rectangular Area 
In order to create a non-rectangular area, select the Connect To AutoCAD option on the 
File menu. This connects Fixture Studio to the Planner module. Next, open the block for 
editing (Block Details dialog box). 

Switching to AutoCAD 
In the Category Tab of the Block Details dialog box, select Triangular from the drop-
down list. The pick button next to it becomes active. Click the pick button in order to go 
to the Planner module where a raw AutoCAD drawing opens. 

 

The raw AutoCAD drawing displays a yellow rectangle. This represents the edges of the 
block. It has an origin at 0,0 in the drawing. 
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Loading the Block into the Raw AutoCAD Drawing 
In Fixture Studio, highlight the block in the Fixture hierarchy and select the Load Blocks 
into the Drawing option from the File menu. The block is drawn with its insertion point 
at 0,0, overlaying the yellow rectangle representing the edges. 

 

Drawing the Shape of the Irregular Area 
Using the fixtures as a guide, draw in a boundary representing the area that can be used 
for merchandising purposes.  

 

The boundary should be drawn with a polyline and the Close command should be used 
to ensure that the boundary is a single continuous line. 

Next, delete the instance of the block from the drawing, leaving behind the outline of the 
irregular area. 

 

Close the AutoCAD Drawing Without Saving 
The next action is to close the AutoCAD drawing without saving it. This may sound 
counter-intuitive, but Fixture Studio has stored the co-ordinates for the outline in 
memory. To close the drawing, click the small 'x' at the top right corner and then state 
you do not wish to save the drawing when a confirmatory dialog box appears. 

After the confirmatory dialog box has gone, the AutoCAD drawing may not immediately 
close. This is because if the boundary of the non-rectangular area has been drawn inside 
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the edges of the block (for example for a fixture), Fixture Studio will change the edges of 
the block. This will be confirmed by a dialog box. 

  

Click the OK button and the AutoCAD drawing closes. To reset the extents of the block 
back to the original value, click the Calculate button in the Actual Size frame of the Size 
tab. 

 

Save the Block in Fixture Studio 
The final stage is to save the block in Fixture Studio. This is done by highlighting the 
block in the Fixture hierarchy and selecting the Save option from the File menu. 

Insertion Tab 
 
The Insertion tab is used to specify a number of details affecting how the block is inserted 
into the drawing.  
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The Layers Frame 
The Layers frame specifies the Layer on which the Block is inserted when placed in a 
floor plan in the Planner or Merchandiser modules or in In-Store Space Collaboration. 
Each block must be assigned to a specific layer. 

Note: Layers are configured in the Layers and Aliases dialog 
box in the Planner module. See the Store Planning User 
guide for more information.  

 

 

For example, Macro Space Planning might be configured to have Zone, Fixture, Fitting, 
Shelf, Product, and Annotation layers. Fixtures, fittings, and shelves would then be 
configured to be inserted on the appropriate layers. Within the Planner or Merchandiser 
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modules or in In-Store Space Collaboration, these layers can then be turned on, turned 
off, locked, or unlocked, enabling users to control the use and visibility of those objects. 

The Levels Frame 
The Levels frame determines what elevation the Block is inserted in the drawing. 

 

These levels are configured directly in the AVTTB_LEVELTYPE table. This can only be 
done by Administrators with access to the database. An example of configured levels is 
given below. 

 

 

Each level represents a physical height at which equipment can be inserted in the 
drawing. These levels are relative to the floor level or to some other level. For example, 
the Ceiling Datum is set to be 240 inches (20 feet) above floor level, while the Banner 
Level is 120 inches (10 feet) below ceiling level. 
Items of equipment can then be assigned appropriate levels. For example:  

 Fixtures and major fittings are typically inserted at floor level. 

 Posters are inserted at Post Level, which has been defined as 42" (3.5 feet above floor 
level). 
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 Shelves are inserted at the Undefined Level, as their elevation can vary. 

The Front Direction Frame 
The Front Direction frame represents the side of the fixture that has been designated as 
the front of the fixture. This can be visualized as the direction the customer approach the 
fixture from. It also determines the default orientation of any shelves and merchandise 
that might be placed on the fixture.  

 

 

 

Note: When assigning block details, it is recommended that 
all blocks be initially defined with the same front direction. 
If front directions vary from block to block, this can lead to 
confusion when blocks are inserted in the drawing or 
formed into gondolas.  

 The Placement Frame 
The Placement Frame enables two forms of mounting options to be specified. 
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Space Mounted means this block can be inserted into any floor space. 
Wall Mounted means this block can be attached to a wall on insertion. 

The Insertion Position Frame 
The Insertion Position frame is a position specified within Macro Space Management that 
matches the insertion position created when the associated graphic for the block was 
drawn in AutoCAD. 

 

The insertion position specified within Macro Space Management is passive.  Changing 
the insertion position does not change the position of the graphical insertion position 
created when the graphic was drawn.  

It is important that the Fixture Studio insertion point matches the insertion point already 
defined in the graphic. If they do not match, then the graphic will be inserted into the 
AutoCAD and Merchandiser environments at a position that differs from the correct one. 
This in turn will result in problems with adjacency calculations and the placing of 
associated equipment and products. 
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In this example, there are 27 possible insertion positions, aligned in three layers: top, 
(green circles), middle (blue circles) and bottom (yellow circles). The layer can be selected 
by clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. The insertion position (blue square) is bottom-
back-left, with the radio button in the Insertion Position frame set accordingly...   

 

In the above example, the insertion position (blue square) is top-front-right, with the 
radio button in the Insertion Position frame set accordingly. 

The Child Insertion Position Frame 
The Child Insertion Position frame enables the child insertion position to be specified. 
The child insertion position is the data point at which an item of merchandise at the 
Display Style level is inserted onto a fixture or shelf object in the Merchandiser module. 
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In this example, there are 27 possible insertion positions, aligned in three layers: top, 
(green circles), middle (blue circles) and bottom (yellow circles). The layer can be selected 
by clicking on the appropriate radio button. Each layer contains nine possible insertion 
points ranging from left rear to front right. The required option can be selected by 
clicking on the appropriate radio button. 

 

An item of packaging going onto a shelf would generally have its child insertion position 
set to bottom-back-left.  

 

Each layer contains nine possible insertion points ranging from left rear to front right. 
The required option can be selected by clicking on the appropriate radio button. 

The position the first product will be inserted can be seen in the Preview Tab if the First 
Product Option is checked. 

The Insertion Options Frame 
The Insertion Options frame specifies how the block behaves on being inserted into the 
AutoCAD environment. 
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Rotate Attribute, when enabled, ensures any non-constant attributes on the block are 
rotated so they are upright and readable.  

For example, consider a text tag associated with a block. If the block is inserted in an 
orientation where the text would otherwise not be readable, the text will be rotated so it 
becomes visible. 

The Explode Block on Insert option, when enabled, results in the block exploding into its 
constituent parts on insertion, so they can be manipulated separately. 

Size Tab 
The Size tab is used to specify the maximum length, width, and height of a fixture. 
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It contains three frames. 

 The Actual Size frame contains the maximum dimensions of the block. 

 The Size details frame contains information on the ranges of permissible sizes. 

 The Nominal Dimensions frame displays the volume the fixture occupies after all 
equipment has been added to it. 

Overview of Block Sizes 
Blocks fall into two main types when sizes are concerned.  

 

Fixed Size 
These are specified in the Actual Size frame. They have a single, fixed sized that cannot 
be changed by store planners. 

Stretchable Blocks 
These are specified in the Size details frame. Here, a size rule can be associated with the 
block, allowing the block to take up a range of sizes in a floor plan. Such blocks are called 
stretchable blocks. Stretchable blocks can be used: 

 To represent a fixture that exists in a range of sizes. In this instance, one block could 
be used to represent a dozen fixtures. 

 To represent obstructions like columns in a floor plan. In this instance, one block 
could be used to represent a column of any size.  

Implementation and Reporting 
Representing fixtures using stretchable blocks has advantages and disadvantages. It 
makes it easier to create and maintain the fixture and gondola libraries because fewer 
blocks are required. In addition, it may be possible for store planners to place a fixture in 
a combination of sizes that does not exist in practice. This can lead to problems when 
equipment is ordered in order to put a floor plan into service. 

In addition, reporting bills of materials becomes more complex if stretchable fixtures are 
used. This is because the report must now identify the fixture sizes and use a look up list 
to relate that to a part number. 

The Actual Size Frame 
The Actual Size frame specifies the default size for the block. If no details are entered in 
the associated Size Details frame, the Actual Size frame specifies the only permissible set 
of dimensions that can be used. 
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Details may be entered in three ways: 

Direct Entry 
If the actual dimensions are known, they can be manually entered into the pertinent text 
boxes. 

1. Calculate 

For this option to work, Planner must be open, the Connect to AutoCAD option must be 
selected on the File menu, and the floor plan in Planner that Fixture Studio is connected 
to must contain an instance of the block for which the sizes are to be calculated. Clicking 
the Calculate button then returns the maximum length, depth, and height of the block. 

2. Pick 

For this option to work, Planner must be open, the Connect to AutoCAD option must be 
selected on the File menu, and the floor plan in Planner that Fixture Studio is connected 
to must contain an instance of the block for which the sizes are to be calculated. Clicking 
the Pick button for a specific dimension will take the user to the Planner drawing. Then, 
pick two points, for example, by using AutoCAD's OSnap option. On clicking the second 
point, the user returns to Fixture Studio and the dimension is automatically entered in 
the text box.  

3. Gondolas 

The actual sizes are used when placing instances of gondolas. It is important that these 
sizes are accurate or the gondola may have parts that overlap or have gaps between 
them. For example, if a fixture has an actual length of 35 inches and a nominal length of 
36 inches, it is important to use the actual length. 

In-Store Space Collaboration  
Macro Space Management may have a sister application installed: In-Store Space 
Collaboration. In-Store Space Collaboration uses the X, Y, and Z dimensions in the actual 
size frame. It is important these sizes are accurate or fixtures and fittings drawn in ISSC 
can overlap or have gaps between them. For example, if a fixture has an actual length of 
35 inches and a nominal length of 36 inches, it is important to use the actual length. 

The Nominal Dimensions Frame 
The Nominal Dimensions frame is used to associate a set of nominal dimensions to a 
fixture. 
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Nominal dimensions are primarily used for primary fixtures, where attached secondary 
equipment substantially increases the volume.  

For example, consider a back panel 600 mm long, 1900 mm high, and 5 mm deep. If this 
back panel has shelves attached, it will eventually occupy a significantly larger space.  
It could therefore be assigned nominal dimensions of 600 mm long, 1900 mm wide, and 
300 mm deep to allow for the eventual shelves.  

Tip: Any product or placeholders put onto a fixture with 
nominal dimensions will occupy a volume that corresponds 
to the larger of the actual and nominal sizes. 

Overview of Size Groups and Size Rules 

Size Group 
A size group allows sizes to be collected into similar groups within a hierarchical tree of 
sizes. 

Size 
A size contains definitions of all permissible dimensions that can be assigned to a block. 

Size Rules 
Size rules are the settings or combinations of settings that determine the definitions of 
dimensions permitted when assigned to a block. 

Overview 
Blocks that are assigned multiple possible dimensions conform to size rules.  
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A size is a set of definitions (size rules) indicating which sets of dimensions are allowed 
for a block that has been assigned to that size group. 

When any block is assigned to a size, it inherits the set of size rules associated with that 
size group. 
When the block is inserted into the drawing, a dialog appears showing the dimensions 
permitted by the size rules.  

A specific set of dimensions can be selected from those available, and the block is 
inserted into the drawing (or virtual reality environment) with those dimensions. 

Size Operations 

 

 

Sizes can be created. This means that a set of size rules is defined and stored within a 
named size group. 

Sizes can be edited. The existing set of size rules is changed to a newly defined set. In the 
process, any blocks that reference the size group being edited will have their size rules 
changed to the edited version.  

Sizes can be deleted. When a size is deleted, all blocks that reference that size will have 
their associated size rules removed and will need to be assigned to an alternative size 
group so that their size rules can be redefined.  

Block Operations 

 

Various operations can be carried out to assign blocks to sizes. 
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Create Size results in a block being associated with a size. The block may either be 
associated with an existing size group, or a new size group can be defined. 

Edit Size results in the size associated with that block being edited.  

Note: It is the size that is being edited, and not the Block 
Definition. Changes made to the Size will affect ALL blocks 
that reference that size, and not just the block that is having 
its definitions set. 

Delete Size removes what block definition currently references.   

It does not delete the size itself, but just removes the link between the size and block 
definition. 

The Size Associations Frame 
The Size Associations frame is used to allocate blocks to specific size groups.  

 

A size group contains details of the size rules that govern the dimensions for a block 
definition.  
Size groups can be configured in a number of ways. 

Size Details Frame 
When a block can be assigned multiple dimensions, it needs to be associated with a size 
group. The block then adopts the size rules associated with that size group and then has 
a range of permissible dimensions assigned to it. 
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The process is started by clicking on the Create Option. This brings up the Sizes dialog 
box.  

 

This gives two options, Create new size or Select from existing. These are selected by 
using the appropriate radio button.  

Size groups have varying purposes: Stretchable size groups can describe the size rules for 
fixtures that are to be made stretchable and square or circular size groups can describe 
fixtures that must preserve that class of dimensions.  

Similarly, Lozier or Hussmann can describe sets of dimensions specific to those 
manufacturers. 

Create New Size 
Selecting this option brings up the Sizes dialog box. 
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This can be configured to set the size rules. 

Select from Existing 
Select from Existing associates the block being defined with an existing set of size rules. 

 

Selected Sizes 
When the required size group has either been created or selected and the OK button 
clicked, the associated size rules is assigned to the block definition and appears in the 
Size Associations frame. 

 

Editing Size Group 
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Clicking on the Edit button enables the user to edit the size group details. 

 
This brings up the Size dialog box so that the size rules can be changed. 

 

This operation edits the size rules, not the dimensions for the block being defined.  

Editing the size rules affects all blocks currently associated with that set of size rules. 

Removing Size Group Association 
Removing a size group association can be achieved by clicking on the Remove button. 

 

This removes the link to the size group (and its associated size rules) but it does not 
delete the size group itself. 

The Size details frame then shows that no size group has been associated with this 
particular block. 

 

Connections Tab 
The Connections tab lets the user specify the connection options for Macro Space 
Management blocks. These are used within the Planner and Merchandiser modules.  
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The Planner Module displays basic left/right/rear connection points allowing fixtures 
and fittings to be accurately aligned relative to each other. The Merchandiser model 
allows more complex use of connections, including additions of small items of 
equipment such as grilles to shelf objects. There connection settings also act as the 
defaults in the Add Shelf dialog box in the Merchandiser module. 

Note: Gondolas provide a more efficient way of placing 
large numbers of items of equipment in a fixed alignment. 

 

A small Toolbar at the top lets users add, copy, and delete connections. The wizard on 
the toolbar allows the user to add three basic connections. The Connections List below 
lists all current connections for the Macro Space Management Block. Highlighting an 
individual connection enables the lower part of the tab, which allows the details of the 
connection to be configured.  

The Connections Tab and the Configuration Module 
Settings in the Configuration Module (File menu > Configure) can affect how connection 
points appear in the Preview tab the Block Details dialog box of Fixture Studio. They also 
affect how connection points appear and behave in the Merchandiser module.  
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Gender Filter, Size Filter, and Shape Filter determine whether the genders, sizes, and 
shapes of two connection points have to be compatible before they can snap together.  

Pointer Size and Line Size affect the appearance of the connection points as displayed.  

Colors for neutral, male, and female connection points can also be set. 

These settings have local effect. Changing one user's settings do not affect other users. 

The Connections Toolbar 
The Connections toolbar is found to the upper left of the Connections tab. 

It allows users to add, copy, and delete connections. It also allows the user to invoke the 
Connections Wizard. 

 

Icon Description 

 
Add a Connection 

 
Copy a Connection 



Block Details Dialog Box 

124 Oracle Retail Macro Space Management Fixture Studio User Guide 

Icon Description 

 
Delete a Connection 

 
Connection Point 
Wizard 

Add a Connection 
Clicking on the Add a Connection icon causes a line to be added to the connections list 
ready for further details of the connection to be added. 

 

See the information on connection lists for how to configure the connection.  

Copy a Connection 
Clicking on the Copy a Connection icon causes an existing connection to be copied to the 
connections list. This enables users to copy an existing connection configuration and then 
save it with small changes. 

 
Before clicking the Copy icon, highlight the connection to be copied. Clicking on the icon 
brings up the connection naming dialog box. 

 

Edit the name to one suitable for the new connection. 

On clicking OK, a duplicate connection is added, save for the changed name. 

 

Delete a Connection 
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To delete a connection, highlight the connection to be deleted and click on the Delete 
icon.  

The user is asked to confirm deletion. 

 

The Connections Wizard 
The Connections Wizard can be invoked from the Wizard icon in the toolbar in the 
Connections tab. It adds a set of basic connection points that allow fixtures to snap to 
each other in the Planner and Merchandiser modules. 

 

This brings up the Connections Wizard dialog box. 

 

 Checking the Add connection on Left check box adds a connection on the left. 

 Checking the Add connection on Right check box adds a connection on the right. 
 Checking the Add connection at Back check box adds a connection at the back. 

The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default. 

The back connection has no gender, so it can attach to any other connection.  

Checking the Clear Existing Blocks check box removes any existing connections. 
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On clicking OK on the Wizard, the selected default connections are added. 

 

The Type Frame 
The Type frame allows the user to specify whether the selected item is to be used as a 
physical connection point or as the anchor for instance specific text for the block. This 
option is set by the radio button. In addition, the selected connection can be designated 
as the default by selecting the check box. 

 

If the Text Reference Point option is chosen, a new version of the Connections tab 
appears. This can be used to attach text to a block in Planner. 
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Position Frame 
The Position frame is used to specify the position where the text appears. 

Text Justification Frame 
The Text Justification frame allows the user to pick a text style from the drop-down list. 
This list is configured using the Planning > Text Styles option in the Administration 
module. The radio buttons enable the user to specify the position of the text relative to 
the coordinates specified in the position frame.  

Horizontal Angle Frame 
This allows the user to specify the angle at which the text is drawn relative to the block. 

The Filters Frame 
The Filters frame enables the user to set parameters that can later be used as filters to 
decide whether two connection points are compatible or not.  

Which of these filtering options are active in a floor plan in Merchandiser is determined 
by a setting in the Fixturing tab of the Configuration module. 
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Gender 
The gender of a connection determines whether that connection is compatible with 
another. There are three genders: male, female, and neutral. They are selected from by 
means of the radio button. 

 Can connect with 

Male Female Neutral 

Female  Male Neutral 

Neutral Any other connection 

Shape 
The Shape of a point connection can be specified from the drop-down list. The shape is a 
theoretical concept and can be any convenient name: like connects with like. All shapes 
can connect with the None option.   
The list of shapes available can defined in the AVTTB_CONNECTION_SHAPE table in 
the database. This can only be done by Administrators. In the example below, the shapes 
have been changed to text entries for specific types of connections. 

 

Size 
A maximum and minimum size for the connection can be set using the spin controls.  A 
pair of connection points must have compatible sizes to connect together.  

If the Match check box is selected, then the connections must have identical maximum 
and minimum sizes. If they are not identical, the connections will not mate. 
If the Match check box is not selected, then the connections must have overlapping size 
ranges. If they are not overlapping, the connections will not mate. 

 Connection 1 Connection 2  

Size Range 0 - 50 25 - 75 Compatible 
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 Connection 1 Connection 2  

Size Range 0- 25 50 - 75 Incompatible 

The Position Frame 
The Position frame is used to set the origin of the connection point.  

 

The position frame is used to specify the position where the text appears. 

The Array Frame 
The Array frame is used to produce a connection line, plane, or box.  

 

There are three options, which are shown in the following figure: 

 Setting up spacing in a single dimension results in a line of connection points.  

 Setting up spacing in two dimensions results in a two dimensional array of 
connection points. This is typically in the X-Z plane and results in an array of points 
parallel to the back of the fixture.  

 Setting up spacing in three dimensions results in a cuboid of connection points. 
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Spacing 
This specifies the distance between successive points. 

Tip: If set to 0 a connection line will be drawn. This allows 
attachment at any point along the line, rather than at specific 
connection points. 

Max Extents 
This specifies the dimension in that particular plane. It is drawn relative to the position 
point specified in the Position frame. 

The Horizontal and Vertical Angle Frames 
The Horizontal and Vertical Angles are used to control the direction of connection points, 
irrespective of whether they are assigned as a point, as a line, or as a plane.  

 

Changing the Horizontal Angle changes the direction the designated connection point 
faces over the floor. 
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Setting it to 0 degrees makes the connection point face to the east; setting to 180 degrees 
makes it face to the west. 

Setting the Vertical Angle affects whether the connection points are horizontal, face up, 
or down.  
Setting to 0 degrees result in the connections being horizontal, 90 degrees pointing 
vertically up and 270 degrees vertically down. 

Note: Setting to 180 degrees results in the connection point 
turning upside down and facing in the opposite direction. 
Use caution when using this option.   

Connections Examples 
This section provides three examples of connections. 

Connection Points for a Shelf 
Shelves can be attached to a back panel. The following example is for a back panel 36 x 1 
x 72 inches in size. 

Connection Line 
The first example is for a connection line. 

 

1. The type is set to connection. 

2. The gender is set to female. This means that the connection point on the 
corresponding shelf is set to male in order to make the connection compatible. 

3. The shape is set to slot/shelf. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database). 

4. The size has been set to 10 and the match option selected. 

All of the above options can be used as filters if required. 

The Position Frame is set up using a standard Cartesian coordinate system.  

1. The connection is on the left edge of the back panel, and the X coordinate is set to 0. 

2. The connection is in the front face of the back panel, and the Y coordinate is set to -1 
(bring it forward by one unit). 

3. The shelves start 6 inches up from floor level, and the Z coordinate is set to 6. 



Block Details Dialog Box 

132 Oracle Retail Macro Space Management Fixture Studio User Guide 

This connection line is being configured in the vertical (Z) plane, so only the Z data is 
pertinent.  

1. The spacing is set to 0, so this is a continuous line. 

2. The Max extent is set to 60. This is calculated as follows: 
3. The height of the fixture is 72 inches.  

4. The connection line starts 6 inches from the base. 

5. The connection line stops 6 inches from the top. 

6. 72 inches - (6 inches + 6 inches) = 60 inches. 

The horizontal and vertical angle frames are used to set the orientation of the connection 
points.  

 The horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points 
This example is similar to the first example except that the spacing has been set to 6 
inches for the Z axis in the Array frame. This results in a series of connection points 
rather than a connection line. 

 

Connection Lines for a Slatwall 
Refer to the above example for connection points for a shelf before attempting this 
example. 
Varying shelf objects such as rods and pegs can be attached to a slatwall. This example is 
for a slatwall 36 x 1 x 72 inches in size. 
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1. The type is set to connection. 
2. The gender is set to female. This means that the connection point on the 

corresponding rod is set to male in order to make the connection compatible. 

3. The shape is set to slot/shelf. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database). 

4. The size has been set to 20 and the match option selected. (This differs from the 
setting for shelves to enable filtering options to work.) 

All of the above options can be used as filters if required. 

The Position frame is set up using a standard Cartesian coordinate system.  

 The connection is 3 inches in the left edge of the back panel, so the X coordinate 
is set to 3. 

 The connection is in the front face of the back panel, so the Y coordinate is set to -
1 (bring it forward by one unit). 

 The shelves start 6 inches up from floor level, so the Z coordinate is set to 6. 

The Array Frame connection lines are being configured in the horizontal (X) and vertical 
(Z) planes.   

1. The Z spacing is set to 6 so the lines are 6 inches apart in the vertical plane. 

2. The X spacing is set to 0 so this is a continuous line. 

3. The Max X extent is set to 30. This is calculated as follows: 
 The width of the fixture is 36 inches.  

 The connection line starts 3 inches from the left hand edge. 

 The connection line stops 3 inches from the right hand edge. 

 36 inches - (3 inches + 3 inches) = 30 inches. 

4. The Max extent is set to 60. This is calculated as follows: 

 The height of the fixture is 72 inches.  
 The connection lines starts 6 inches from the base 

 The connection lines stops 6 inches from the top. 

 72 inches - (6 inches + 6 inches) = 60 inches. 

The horizontal and vertical angle frames are used to set the orientation of the connection 
points.  
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 The horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The vertical angle is set to 0 degrees so that the connection points are level. 

Connection Points for a Pegboard 
Refer to the above example for connection points for a shelf before attempting this 
example. 
Varying shelf objects such as pegs can be attached to a peg board. This example is for a 
peg board 36 x 1 x 72 inches in size. 

 
1. The type is set to connection. 
2. The gender is set to male. This means that the connection point on the corresponding 

rod is set to female to make the connection compatible. 

3. The shape is set to peg/pegboard. (This option has been customized in the 
AVTTB_CONNECTION_SHAPE table in the database.) 

4. The size has been set to 5 and the match option selected. (This differs from the setting 
for Shelves to enable filtering options to work.) 

All of the above options can be used as filters if required. 

The Position frame is set up using a standard Cartesian coordinate system.  

 The connection is 3 inches in the left edge of the back panel, and the X coordinate 
is set to 3. 

 The connection is in the front face of the back panel, and the Y coordinate is set to 
-1 (bring it forward by one unit). 

 The shelves start 18 inches up from floor level, and the Z coordinate is set to 18. 

The Array Frame connection lines are being configured in the horizontal (X) and vertical 
(Z) planes.   

1. The X spacing is set to 6 so the lines are 6 inches apart in the horizontal plane. 

2. The Y spacing is set to 6 so the lines are 6 inches apart in the vertical plane. 

3. The Max X extent is set to 30. This is calculated as follows: 
4. The width of the fixture is 36 inches.  

5. The connection points start 3 inches from the left hand edge. 

6. The connection points stop 3 inches from the right hand edge. 

7. 36 inches - (3 inches + 3 inches) = 30 inches. 
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The Max extent is set to 48. This is calculated as follows: 

1. The height of the fixture is 72 inches.  

2. The connection lines starts 18 inches from the base 

3. The connection lines stop 6 inches from the top. 
4. 72 inches - (18 inches + 6 inches) = 48 inches. 

The horizontal and vertical angle frames are used to set the orientation of the connection 
points.  

 The horizontal angle is set to 270 degrees so the connection points protrude 
forward from the face of the back panel. 

 The vertical angle is set to 0 degrees so that the connection points are level. 

Parts Tab 
The Parts tab is used to improve the accuracy of reporting. A fixture can be represented 
by a single block in a floor plan. However, the actual fixture may be more complex and 
made up from a number of parts such as uprights, cross-bars, castors, and securing bolts. 
It is therefore possible to create a block and associate parts with it. When a report (such 
as a bill of materials) is run on a floor plan, that report can then be expanded from a list 
of parts to a list of required sub-components. 

 

 Part blocks do not need graphics files. They are not inserted into a floor plan. 

Available Parts 
The Available Parts frame contains a list of all blocks held in the database. This includes 
(for example) fixtures and fittings as well as blocks of type part.  

Associated Parts 
The Associated Parts frame contains a list of all parts and part quantities associated with 
that particular block.     
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Creating Part Blocks 
Part blocks are a specialized type of block that have no graphics and exist only within the 
Macro Space Management database. Their only use is for reporting purposes. 

 It is recommended that part blocks are kept in specific and separate groups within the 
Fixture Studio hierarchy. 
Only a few basic parameters need to be defined. More can be set if needed for detailed 
reporting purposes. 

Category Tab 

 

After inputting an appropriate block name and description, for the Category tab, set the 
following: 

 Set equipment type to part. 

 Ensure that the effective and expiry dates are set appropriately. 

 Select the part icon. 
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Insertion Tab 

 

For the Insertion tab, select a nominal layer. 

Note: A layer is not necessary for a block that is to be used 
purely for reporting purposes, but Macro Space 
Management will not allow the block to be saved until one 
has been set. 
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Size Tab 

 

Unless it is necessary to have accurate dimensions, set nominal values in the actual size 
frame. 

The block can then be saved to the database. 

Building Up a Parts List 
The Parts list can be added to and edited using the arrows in the center of the Parts tab. 
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Available Parts 
The Available Parts frame contains a list of all available parts. Block names and 
description can be sorted in ascending or descending order by clicking on the column 
header. 

Associated Parts 
The Associated Parts frame contains a list of all parts associated with that particular 
block. In the above example, the podium is made up of a top and frame.  

Quantities, block names, and description can be sorted in ascending or descending order 
by clicking on the column header. 

Building and Editing a Parts List 
To add a part to the Associated Parts list, highlight the part in the Available Parts frame 
and use the add arrow. 

Alternatively highlight and double click on the part in the Available Parts frame. 

To remove a part from the Associated Parts list, highlight the part in the Associated Parts 
frame and use the add arrow. 

Alternatively highlight and double click on the part in the Associated Parts frame. 

Changing the Number of a Specific Part 
To change the number of a specific part in the associated parts list, highlight the required 
part then left click on the number itself in the Qty column.  

 

The number can then be edited. Press Return to store the number. 

Fixture Tab 
 

The Fixture tab is used to specify the behavior of shelving and the product block for a 
fixture. 
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The Fixture Frame 
The Fixture frame allows some details of how the fixture is to be merchandised to be 
specified. 

 

Vertical Category allows the aliased layer to be occupied by the fixture to be further sub-
divided. The default is 0, but fixtures can be assigned to further vertical categories within 
the aliased layer. For example, TVs can be assigned to Vertical Category 1, CD Players to 
Vertical Category 2, and so forth. 
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Setting the Vertical Category affects Adjacency calculations. Fixtures in different Vertical 
Categories are not shown as adjacent.  

Setting the Vertical Category also affects annotation. If Vertical Categories are set, each 
category receives its own separate annotation. 
Finally, setting Vertical Categories affects the reporting options. Material in different 
categories can be reported separately.  

Tierage is used when the fixture has distinct merchandisable levels rather than shelves.  

 

Examples of fixtures that have tiers include those used to display magazines or perfumes. 

If the fixture has shelves, the tierage value should be left set to 0.  

If the fixture has tiers rather than shelves, then the number of tiers should be specified.  
There are two ways of assigning a product base to a tiered fixture. 

The product base can be designed such that a single product base fits the tier structure. In 
this case, the entire fixture can be merchandised, but only with a placeholder indicating a 
class of product, for example, cards or lipsticks. 

Alternatively, each tier can be defined as a merchandisable area in the Merchandisable 
Areas tab. Each tier can then have a product base assigned to it. This allows more specific 
placeholders to be used. For example CDs with artists’ names beginning with A or B can 
be placed on the upper tier.  

The Product Block Frame 
The Product Block frame allows the details of the product block to be assigned to the 
fixture.  
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Is not specified for a fixture or shelf, it is not possible to merchandise that item of 
equipment with a placeholder. 

Product blocks assigned in this frame are used to act as indications of the dimensions 
that can be merchandised when placeholders for a general class of product (for example 
shoes or canned goods) are assigned to the fixture.  

The default product block is PBASE__, which is a simple rectangular block, but other 
product blocks can assigned. For example, a round product block can be assigned to a 
table top, and a stepped product base can be assigned to a display cabinet with tiers. 

The Shelving Frame 
The Shelving frame is used to set parameters affecting the behavior of shelves on a 
fixture. 

 

Slot Spacing gives the distance between successive shelves. 
First Slot Number gives the height of the initial shelves. 

   

About Merchandisable Areas, Product Blocks, and Display Styles 

Merchandisable Areas 
A merchandisable area is an irregular cube-shaped space associated with a specific 
fixture or shelf object. It delineates the volume relative to the dimensions of that object 
that can be filled with product.  

Merchandisable areas are defined within the Merchandisable Areas tab in the Block 
Definitions dialog box. 

The merchandisable area is defined by specifying the two points that represent opposing 
corners of the cuboid. Accordingly, the geometry is simple and inflexible. 

Placeholders and Display Styles 
In the AutoCAD environment, all merchandise is displayed using placeholders.  
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In the virtual reality environment, there are two forms in which merchandise can be 
displayed. 

At article (SKU) level and above, merchandise is displayed as a placeholder. This 
indicates that a particular form of merchandise has been used to populate that section of 
the store.  

Placeholders are simple geometrical shapes (such as cubes and cylinders) and have no 
surface detail. 

At the Display level, a product block containing a more detailed physical representation 
of the product is placed, the amount of detail depending on local settings.  

 

In the above example, the lower shelf is populated with a placeholder. The upper shelf 
has products displayed using three types of display style product blocks.  
The plates are shown as graphical style product blocks, the boxes on the left as simple 
boxes, and the boxes on the right as textured boxes. 

Product Blocks for Fixtures and Shelf Objects 
Because the merchandisable area is of simple geometry, fixtures and shelf objects need to 
have default product blocks associated with them in their block definitions.  

These default product blocks can be of more complex shapes, for example, cylinders, 
hemispheres, or hexagons. Only a single design of each class of product block is required, 
as their dimensions are scalable.  
When placed on a fixture or shelf, object product blocks expand to the maximum 
dimensions permitted by the merchandisable area. In this way, a single cylindrical 
product block can be used for wide range of fixtures and shelf objects.  

The product block can then be used to define the volume occupied by a placeholder. 

For example, a circular table must still have a cubic merchandisable area defined, as all 
merchandisable areas have to be simple cuboids.  
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In the above diagram, the merchandisable area is represented by the cuboid with the 
heavy black outline.  

However, if this cuboid is merchandised directly with a placeholder, the product will be 
shown beyond the actual surface of the fixture. To address this, a cylindrical product 
block is associated with the fixture. This expands to the limits set by the merchandisable 
area and represents the limits that can be shown as occupied by a placeholder. 

Merchandising with Product Blocks and Placeholders/Display Styles 

Placeholders 
If a fixture or shelf object is merchandised with a placeholder, it can occupy the extents 
defined by the Merchandisable Area in block definitions.  

In the example below, the fixture on the left has a default product block assigned (green 
cylinder). It is not required unless the fixture is merchandised by a placeholder. 
Because the default product block is scalable, it takes up the size determined by the 
merchandisable area of the fixture. When the placeholder is then shown (yellow 
cylinder), it takes up the volume defined by the product block, which has itself expanded 
to the extents determined by the merchandisable area.  

If the specified product block were hexagonal, then the placeholder would be shown as a 
hexagonal shape, scaled to the extents of the merchandisable area.  
A similar logic applies to other shapes of product block. They allow placeholders to be 
displayed in a number of geometries. 

 

Display Style Product Blocks 
If the same fixture is merchandised with a Display Style product block (the blue box in 
the right hand diagram) the display style product block is placed within the limits set by 
the merchandisable area (the cuboid outlined in black).  
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The display style product block then must be moved within the limits of the actual 
merchandisable surface of the fixture using the alignment options available within 
Merchandiser. 

The display style product block represents the actual dimensions of an instance of the 
merchandise being placed on a fixture. This means multiple instances of display style 
product blocks can be placed until the available volume defined by the merchandisable 
area is filled.  

If a placeholder is used to represent merchandise, only a single instance is required, as 
this represents the volume occupied by a class of product, not individual items.  

User Defined Attributes Tab 
The User Defined Attributes tab is used to specify customized information for a block. 
This information can then be used for filtering or reporting purposes. 

 

There are two forms of attribute: 

Fixed Attributes 
Fixed attributes are definition data assigned to a specific block definition in Fixture 
Studio. They are configured in the Administration module (General menu). Options can 
then be set on a block-by-block basis in the Fixed Attributes frame in Fixture Studio.  

Variable Attributes 
Variable attributes are instance data that can be individually set for each instance of a 
block within a floor plan. This enables data to be assigned to a specific fixture within a 
specific store. This information can then be used for reporting or compliance purposes. 
Variable attributes are configured using the Edit Attribute Definitions option from the 
Edit menu in Fixture Studio. A list of possible options is assigned in the UDA tab of the 
Block Details dialog box. After an instance of the block has been placed in a floor plan, 
users can set individual values for each of the variable attributes by selecting the 
fixture/block and using the Show Attribute on the Fixturing Toolbar of the Object 
Browser. 
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Note: Variable attributes can also be set for individual 
fixtures in In-Store Space Collaboration.  

Configuring Fixed UDAs 
Setting up Fixed User Defined Attributes takes place in two stages. 

1. The User Defined Attributes are configured in the Administration Module. 

2. The values for the User Defined Attribute are assigned on a case-by-case business to 
each block definition in Fixture Studio.  

Configuring UDAs in the Admin Module 
UDAs are configured in the Admin Module via the User Defined Attribute option from 
the General Module. 

 

Setting Values for Individual Block Definitions 
Once the User Defined Attributes have been configured in the Administration module, 
values can be set for individual block definitions.  

 

The list of User Defined Attributes appears on the left. The value can then be set on the 
right. It can be a text, date, or Boolean value. Depending on settings in the Admin 
module, a default could already be assigned or the numeric or text value confined to 
those specified in a drop-down list.  

Once assigned, the UDA can be used for filtering purposes, for example, in refining a list 
of available fixtures in the Object Browser in the Planner or Merchandiser module. The 
UDA can also be used for filtering purposes in a report, for example, in restricting data to 
a list of fixtures with a common characteristic.  
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Configuring Variable Attributes 
Setting up Variable Attributes takes place in two stages. 

 The Variable Attributes are configured using the Edit Attribute Definitions 
option on the Edit menu. 

 The variable attributes that can be set are then assigned to individual blocks. 
When an instance of that block is placed in a floor plan then the values of the variable 
attributes that have been assigned to that block can be set in the Planner and 
Merchandiser modules. These values can also be set in In-Store Space Collaboration - this 
enables tasks such as store survey or compliance to be carried out. 

Configuring Variable Attributes 
Variable Attributes are configured using the Edit Attribute Definitions option on the Edit 
menu. This will bring up the Attribute Definitions dialog box. Variable Attribute 
definitions can then be added, edited, or deleted by means of the options on the toolbar.  

 

Data set in this dialog box appears in the UDA tab of the Block Details dialog box and in 
the Attributes dialog box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration. 

 ID - this cannot be edited and is automatically assigned by the software. 
 Name - this is the name given to the Variable Attribute.  

 Data Type - this is set from a drop-down list and is determined by the type of 
information to be stored. The options are as follows: 

Data Type  Description 

String Used for text values. 

Integer Used for whole numbers: 1, 2, 3, and so forth. 

Long Used for fractional numbers1123.456, and so forth. 

Single Can be used as a substitute for Long. 

Double Can be used as a substitute for Long. 

Boolean Used for Yes/No options (with check boxes).  

Currency Used for financial values. 
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Data Type  Description 

Image Not in use. 

 Control type - this specifies the type of control to be used in the Attributes dialog 
box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration. 

Control 
Type  

Description 

Text Box A box for text, numbers or monetary values to be entered.  

Drop-
down List 

Drop-down list of preset values, normally used in conjunction with options 
in the Lookup field. Text can also be typed in. 

Check Box A check box for Yes/No options, normally used with the Boolean option. 

 Mandatory - if checked, this forces the user to assign a value in the Attributes 
dialog box in the Planner and Merchandiser modules and in In-Store Space 
Collaboration before that dialog box can be closed.  

 Sequence - this determines the order in which the options are displayed in the 
Attributes dialog box in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. 

 Tab - this option is not currently in use. 

 Lookups - this enables the user to populate a predefined list of options for drop-
down lists. Each options is separated from the next by a pipe (for example Value 
1|Value 2|Value 3).  

Once all values have been assigned, they can be saved back to the database by using the 
Exit option.  

Assigning Variable Attributes to Individual Blocks 
After configuration in the Attribute Definitions dialog box, the list of variable attributes 
appears in the left hand side of the Variable Attributes frame of the UDA tab on the block 
details dialog box.  

 

 The > button can be used to add variable attributes to the list on the right hand 
side. This list is displayed when the Attributes dialog box is invoked in the 
Planner and Merchandiser modules and in In-Store Space Collaboration. 

 The < button can be used to remove variable attributes from the list on the right 
hand side. 
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Using Variable UDAs 
Within the Planner and Merchandiser modules (and in In-Store Space Collaboration), 
variable attributes can be set for individual fixtures by selecting a fixture, then clicking 
the Show Attribute option on the toolbar. 

 

This brings up the Attributes dialog box. 

 

This contains a list of attributes specific to that block in that floor plan that were assigned 
in the UDA tab of the Block Details dialog box in Fixture Studio. The values for that 
instance of the block can then be set accordingly. In the above example, the variable 
attributes allow an In-Store Space Collaboration user to set values based on a store 
survey or compliance check. 

Once set, the values can then be read in Macro Space Management if the floor plan is 
opened in the Planner or Merchandiser modules and the attributes displayed for the 
appropriate fixtures. Alternatively, the assigned attributes can be used for reporting 
purposes.  
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Styles/Ranges Tab 

The Styles/Ranges Tab 
The Styles/Ranges Tab has two purposes: to set the styles for items of equipment, and to 
specify any ranges for physical parameters limiting the products than can be placed on 
that equipment. They are assigned to both fixtures and shelves. 

Fixtures 
Fixtures only require a fixture style. This determines what items of equipment and 
merchandiser can be placed on it. 
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Shelves 
Shelves require both a fixture and a shelf style. The fixture style must be compatible with 
the fixture style of the item of equipment that is being placed on it. The shelf style 
determines what products can be accepted. 

 

Both Styles and ranges are configured in the Administration module - as are the 
relationships between different types of styles. The styles are then assigned to blocks in 
Fixture Studio. Once assigned to blocks, they are used to control actions in the 
Merchandiser module. 

Note: Styles and ranges are also used as filters for 
planogram placement in In-Store Space Collaboration. 

The Available Styles Tab 
The Available Styles Tab contains a list of styles that have been defined in the 
Administration Module. If a fixture, the list will only contain Fixture styles. If a shelf, the 
list will contain both fixture and shelf styles. 
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Building a Styles List 
To add a style to the Selected Styles list, highlight the part in the Available Styles frame 
and use the Add arrow. 

 
Alternatively highlight and double click on the style in the Available Styles frame. 

Selected Styles 
The Selected Styles Tab contains a list of styles that have been chosen from the Available 
Styles frame. 
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Depending on the block, the styles will define the type of equipment it can connect with, 
and (if a shelf or fixture) the type of merchandise it can accept. 

Removing from the Selected Styles List 
To remove a part from the Selected Styles list, highlight the part in the Selected Styles 
frame and use the Remove arrow. 

 
Alternatively highlight and double click on the part in the Selected Styles frame. 

Configuration Module 
Whether Styles are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only affect the user making them. 

 

Planner Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 

Merchandiser Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 
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It will also trigger a warning if the styles on equipment and merchandise do not match 
when placing products at display style level. 

 

In-Store Space Collaboration 
Styles can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 

 

Range Options 
The Range Options frame allows the user to set a permissible temperature range for the 
fixture/shelf. This is compared with the temperature range for any display style level 
merchandise placed in Merchandiser. The merchandise can be placed if the temperature 
ranges match, but will be rejected if they do not. 

Note: Temperature Ranges can also be used as a filter when 
placing planograms in In-Store Space Collaboration. 
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Temperature ranges are configured in the Administration module (Merchandising Menu 
> Ranges). They are then assigned to Fixtures and Shelf Objects in Fixture Studio. 
Temperature ranges can also be assigned to Products in Product Studio and to 
Planograms in Merchandiser (or can be imported with product or planogram 
information). 

Configuration Module 
Whether Ranges are used for filtering purposes in Macro Space Planning depends on 
settings the Check Rules frame of the Merchandising Tab in the Configuration Module - 
these are local settings that only affect the user making them. 

 

Planner Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 

 

Merchandiser Module 
If the range option has been turned on for an individual user in the Configuration 
Module, it will trigger a warning if the ranges on equipment and merchandise do not 
match when placing planograms. 
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It will also trigger a warning if the ranges on equipment and merchandise do not match 
when placing products at display style level. 

 

In-Store Space Collaboration 
Range can be used as a filter when placing planograms in In-Store Space Collaboration. 
This option is set in the Planogram Filter dialog box. 

 

About Styles 

Overview of Styles 
Styles are used in the Merchandiser Module as filters, primarily to ensure that products 
are placed on the correct fixture or shelf. There are a variety of styles and style 
relationships. 
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Fixtures and Shelf Objects 
Fixtures have to be assigned a Fixture style in Fixture Studio. Similarly Shelf Objects 
(shelves, pegs, etc) have to be assigned both a Fixture and a Shelf style in Fixture Studio. 
When shelving is placed in a fixture in Merchandiser, the Fixture Style assigned to the 
Fixture must match the Fixture Style assigned to the shelf to allow the shelf to be placed. 

Shelf Objects and Products 
Shelves have to be assigned a Shelf style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Shelf and Product Style has been defined in the Administration Module, the Product can 
be placed on the shelf. If a relationship has not been defined, the product cannot be 
placed in the Merchandiser Module. (Display styles cannot be placed in the Planner 
Module). 

Fixtures and Products 
Fixtures have to be assigned a Fixture style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Fixture and Product Style has been defined in the Administration Module, the Product 
can be placed directly onto the fixture. If a relationship has not been defined, the product 
cannot be placed in the Merchandiser Module. (Display styles cannot be placed in the 
Planner Module). 

Joints 
Some products cannot be placed directly onto fixtures, but must be placed into shelf 
objects such as pegs. There are two ways of achieving this: 

1. Place the shelf object (i.e. peg) first, then place the product 
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2. Place the product and shelf object simultaneously - joints 

Planograms 
Fixtures have to be assigned a Fixture style in Fixture Studio. Planograms are assigned a 
Fixture Style in the Planogram Design dialog box in the Merchandiser Module. If the 
Fixture Style of the Planogram being placed does not match the Fixture Style of the first 
of the selected fixtures, a warning will be given. The user can then accept the warning, or 
override it and place the planogram. 

Other Modules 
Styles and style relationships can also be configured in the Fixture Studio and Product 
Studio Modules. 

Where Styles are Assigned 
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms. 

Fixtures 
Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block 
Details dialog box. 

 

A Fixture is required to have a Fixture style assigned. Only Fixture Styles will be 
available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a fixture is set in 
the Categories tab. 
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Shelf Objects 
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab 
of the Block Details dialog box. 

 

A Shelf Object is required to have both Fixture and Shelf styles assigned. Both Fixture 
and Shelf Styles will be available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a Shelf Object is set 
in the Categories tab. 

Products 
Only Products at Display Style Level can be assigned Styles. This is done in the Styles 
Tab of the Display Style dialog box in Product Studio 
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Only Product Styles will be available for Selection. 

Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Only Fixture Styles will be displayed. 

Styles and Style Relationships 
Style Relationships are set up within the Styles option in the Administration module. 
They control: 
1. What products can be placed on what fixture 

2. What products can be placed on what shelf 

3. What products can be placed on what fixture using a specified shelf object (joints) 
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Style relationships must be set up before products are placed in Merchandiser. 

Preferred Styles 
Preferred Styles are used on Shelf Objects. They enable automatic switching of display 
styles for a SKU so that the preferred Display Style is placed on a shelf object. 
An example would be if electric kettles were available in two display styles: Boxed and 
Presentation. The Presentation Display Style would typically be for an electric kettle that 
has been taken out of its box and was being displayed on a shelf above the boxed electric 
kettles. The 'presentation' electric kettle would be used to show customers what the 
electric kettle looked like, the boxed' electric kettles would be purchased by customers 

An example of this would be a fixture with five shelves on it. The top shelf might contain 
examples of 'presentation' goods such as electric kettles, electric toasters, bread makers 
and toasters. The four shelves below would contain respectively boxed electric kettles, 
electric toasters, bread makers and toasters for purchase. 

By setting the preferred style of the top shelf to accept 'Presentation' Display Styles and 
the preferred styles of the shelves below to accept 'Boxed' Display Styles, the user can 
ensure that the correct form of the merchandise goes onto the shelves. If an attempt is 
made to put 'Presentation' Display Styles onto a shelf that prefers 'Boxed' Display Styles, 
then the Display Style will automatically be switched to the correct one. 

The full process for using preferred styles is 

1. Add Appropriate Styles in Admin 

2. Set up Style Relationships in Admin 

3. Assign Styles to Shelf Objects in Fixture Studio 
4. Assign Styles to Display Style level products in Product Studio 

5. Set up Preferences for Shelves 

6. Drag and drop Display Style products onto shelf - preferred style should be chosen if 
not correct 

Add Appropriate Styles in Admin 
The appropriate styles have to exist in the Style tab of the Styles dialog box in the 
Administration module 
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Set up Style Relationships in Admin 
The appropriate style relationships have to exist in the Style Relationship tab of the Styles 
dialog box in the Administration module 
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Assign Styles to Shelf Objects in Fixture Studio 
Shelf styles have to be assigned to the shelf object in Fixture Studio. A minimum of two 
shelf styles are required for Preferred Styles to work. 

 

Assign Styles to Display Style level products in Product Studio 
Product Styles are assigned in Styles Tab of the Product Display Style dialog box in 
Product Studio. 
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Set up Preferences for Shelves 
The preferences for shelves are set in the Merchandiser module. There are two ways of 
doing this: on adding the shelves to a fixture, or by editing a specific shelf. 

When adding shelves to a fixture, the preferred style can be set using the drop down list 
in the Add Shelves dialog box. 
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Once shelves have been added, the Preferred Style can be edited using the Preferred Style 
drop down list in the Edit Shelf dialog box. 

 

Drag and Drop Display Style products onto shelf - preferred style should be chosen if not correct 
Once preferred styles have been set for a shelf, they can be used to determine what 
display style for a specific SKU is placed. If there are several alternatives, dragging and 
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dropping any display style onto a shelf from that SKU will result in the type of display 
style being checked, and if necessary changed to the preferred style. 

About Joints 
Joints are a special type of Style Relationship. They allow a product to be placed directly 
onto a compatible fixture at the same time as the associated shelf object that the product 
will be placed on is added.   

 

In the example above products have been directly placed into a slatwall using pegs. 
Without a joint, the pegs would have to have been placed first, and then merchandised 
with product in a second operation. 

Prior to products being added via joints, the following must be true: 
1. The Fixture that will support the shelf objects the products are being added to must 

have a Fixture Style assigned in Fixture Studio 

2. The Shelf Object the product will be added to must have a Shelf Style assigned in 
Fixture Studio 

3. The Product must have a Product Style assigned in Product Studio 

4. The appropriate Joint (Style Relationship) must be set up in the Styles option within 
the Admin Module 

To add a product using joints requires the following steps: 

5. Drag the product from the Object Browser or Object Grid and drop onto the required 
Fixture. 
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6. The Add Shelves dialog box will appear allowing users to specify details of the shelf 
objects to be added. 

 

Note: this dialogue box will not appear if the Add Products 
Silently option is on in the Edit Menu in Merchandiser. 

7. After the Shelf Object details have been specified and the OK button clicked, the Add 
Products dialog box will appear. 
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8. After specifying the quantity, alignment, etc, and clicking the OK button, the 
products and shelf objects will simultaneously place on the selected fixture. 

About Styles and Ranges 
Styles and Ranges can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects. 

 

Styles 
If styles have been assigned to: 
1. Fixtures and Products 

2. Shelf Objects and Products 

and the requisite Style Relationships exist, and then styles can be used to determine 
whether a product can be placed on either a fixture or a shelf object. 

Ranges 
If Ranges have been assigned to: 

1. Fixtures and Products 

2. Shelf Objects and Products 

and the ranges are compatible, and then they can be used to determine whether a 
product can be placed on either a fixture or a shelf object. 

Example 
1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 

styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to determine 
whether products could or could not be placed. 

2. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles 
that could be assigned to all Fixtures, Shelf Objects and Products. The 
pertinent Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' 
temperature range. In this example, the Range would serve to determine whether 
products could or could not be placed. 

Merchandisable Areas Tab 
The Merchandisable Areas tab is used to indicate the extent of the space that 
merchandise can take up on the fixture or shelf object.  
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There are two types of merchandisable areas: the primary area and the further area. The 
two are mutually exclusive. You can have either a primary area or a further area, but not 
both. 

Primary Area 
This option is used when only one merchandisable area is required on a fixture or shelf 
object. In the example below, a single merchandisable area has been assigned to a chiller 
unit. Primary areas can be used with both fixed size and stretchable blocks. 

 

Further Area 
Further areas are used when multiple merchandisable areas are required. In the example 
below, the freezer has a permanent internal divider and thus has been assigned left and 
right merchandisable areas. Further areas are normally only used for fixed size blocks. 
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Note: If a Primary Area has been assigned and a user defines 
a Further Area, the Primary Area is disabled.  

The Primary Area Frame 
The Primary Area frame allows the user to specify the primary merchandisable area.  

Primary merchandisable areas can be used in conjunction with stretchable fixtures. 

 

They are defined as cuboids with reference to the extent of the fixture. Offset 1 defines 
the starting point of the primary area relative to the bottom back-left corner of the fixture. 
Offset 2 defines the diagonally opposite corner of the primary area. This is relative to the 
top front-right corner of the fixture. 

 

The offsets work relative to the extents of the block. A positive value brings the corner of 
the cuboids inside of the extents of the fixture, while a negative value moves it outside. 
This can be seen in the diagram below. 
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The position of the merchandisable area is also affected by the child insertion position set 
in the Insertion tab. 

 

 If the child insertion position is set to bottom, the bottom back-left corner of the 
merchandisable area is aligned relative to the AutoCAD insertion point of the 
fixture. 

 If the child insertion position is set to middle, the centre of the back left-side of 
the merchandisable area is aligned relative to the AutoCAD insertion point of the 
fixture. 

 If the child insertion position is set to top, the top back-left corner of the 
merchandisable area is aligned relative to the AutoCAD insertion point of the 
fixture. 

Normally, the child insertion point is set to bottom for fixtures that are to have 
merchandise stacked on them and to top for pegs or other shelf objects, where 
merchandise hangs.  
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In the above example, the fixture has the child insertion position set to bottom, and the 
rod has the child insertion position set to top. Setting up the merchandisable areas for the 
two types of object requires slightly different techniques. These are explained in the 
worked examples that follow:  
The size of the defined primary area is shown towards the right of the frame, while the 
unconstrained check boxes allow merchandise to extend for any distance in that 
direction. If unconstrained areas are specified, these are indicated by plus or minus 
symbols in the preview tab. 

 

The unconstrained check boxes are normally only used with pegs and rods. 

Additional Fixture Height 
The height of a primary merchandisable area can also be affected by the 
ADDITIONAL_FIXTURE_HEIGHT system variable.  This global setting can add a 
specified additional height to all Primary Areas. It is configured in the Administration 
module. 

 Configuring a Primary Merchandisable Area for a Fixture 
Primary merchandisable areas are configured in the Primary Areas frame. 

 

In the example fixture below, the fixture has a base and back. The merchandisable area 
has to take those into account. This example shows how to create that merchandisable 
area. 
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AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 

 

 

Position the fixture that is having its merchandisable areas configured with its insertion 
point at 0,0,0. When OSNAP is turned on, the ID command returns the coordinates of 
any selected point. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame is blank. 

 

Before Starting 
Ensure that the insertion point and child insertion point (Insertion Tab) are appropriately 
set. In this case both have been set to bottom back-left. 
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Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. Offset 1 defines the 
starting point of the primary area relative to the bottom back-left corner of the fixture. 
Offset 2 defines the diagonally opposite corner of the primary area. This is relative to the 
top front-right corner of the fixture. 

 

For the bottom back-left corner, it is necessary to allow for the thickness of the back and 
the base of the fixture. Positive coordinates move the positions of the merchandisable 
areas inside the fixture, so coordinates of 0,6,6 are required. This leaves the position of 
the corner relative to the X axis unchanged, but moves it up 6 units and forward 6 units. 
For the top front-right corner, there is no need to change the coordinates. Accordingly, 
the defaults of 0,0,0 can be left unchanged. 

The settings look as follows. The size of the merchandisable area is shown towards the 
right. 

 

And the end result looks as follows: 

 

If the fixture has been defined as stretchable, when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for Circular Fixtures 
Primary merchandisable areas for circular fixtures are configured in the Primary Areas 
frame. 
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There are two special cases provided for in the Category Tab. These are selected by 
setting the drop-down list in the Graphics frame to circular or semi-circular. 

 

 

This example shows how to create a primary merchandisable area for a circular fixture.  
A semi-circular fixture follows exactly the same principles. 

Note: The shape must previously have been set to Circular 
in the Category tab.  

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame is blank. 
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Before Starting 
Ensure that the insertion point and child insertion point (Insertion Tab) are appropriately 
set.  

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2 defines the 
diameter of the primary area relative to that of the block. Entering a pair of values for the 
X and Y values alters that diameter. 

The settings look as follows. The size of the merchandisable area is shown towards the 
right. 

 

Offset 1 is set to a value of 6 for the Z axis. Positive offsets move the starting point of the 
merchandisable area inside the fixture. In this case the value of the offset moves the start 
of the merchandisable area to the top face of the block. 

Offset 2 is set to a Z value of -36. Negative offsets move the starting point of the 
merchandisable area outside of the fixture, in this case 36 inches above the top face of the 
block. The X and Y offsets are set to 6. Positive offsets move the starting point of the 
merchandisable area inside the fixture, in this case making the merchandisable area 6 
inches less in diameter than the diameter of the block.  

The end result looks as follows: 

 

If the fixture has been defined as stretchable, when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

Configuring a Primary Merchandisable Area for a Peg or a Rod 
Primary merchandisable areas are configured in the Primary Areas frame. 
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In the example fixture below, a rod is represented by a simple cylinder. The 
merchandisable area has to take those into account. This example shows how to create 
that merchandisable area. 

 

Setting the Child Insertion Position 
The first stage is to set the child insertion position. 

 

This must be set to top for a peg or rod. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame is blank. 

 

Before Starting 
Ensure that the insertion point is appropriately set. For most pegs and rods, this is 
middle back-center. 

Offset 1 and Offset 2 
The positions of the two offset points have changed slightly. Offset 1 is now top back-left 
and Offset 2 is bottom front-right. 
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Negative values take the merchandisable area outside the extents of the rod. In this case 
the merchandisable area extends three units to the side. Offset 1 is thus set to -3,0,0. The 
merchandisable area extends three units to the other side and twelve units down. Offset 2 
is thus set to -3, 0,-12. 
The settings look as follows. The size of the merchandisable area is shown towards the 
right. 

 

And the end result looks as follows: 

 

The size is shown towards the right of the frame. Although the height of the 
merchandisable area has been set to 12 units, this has been overridden by the software 
and any height of package can be hung from the rod (subject to not sharing the same 
space with other merchandise).  

The maximum width of packaging that can be hung from the rod is six inches. This can 
be overridden by selecting the Y unconstrained check boxes. 

Configuring a Primary Merchandisable Area for a Non-Rectangular Area 
There is an option in the Category tab to set the shape of the block to triangular. This 
enables the user to configure the horizontal outline of a non-rectangular merchandisable 
area.  
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Once the horizontal outline has been configured, this can be used as the basis for a 
primary area. 

Starting Condition of the Primary Area Frame 
For a new block (fixture) the frame is blank. 

 

Before Starting 
Ensure that the insertion point and child insertion point (Insertion Tab) are appropriately 
set.  

Creating the Primary Area 
In order to create the primary area, two offsets have to be entered. The data in Offset 1is 
used to specify the height of the primary area relative to the AutoCAD insertion point of 
the block. This necessitates entering a value for the Z (vertical) axis. Offset 2is used to 
specify the height of the primary area relative to the top of the block. This necessitates 
entering a value for the Z (vertical) axis.  
The settings look as follows. The size of the merchandisable area is shown towards the 
right. 

 

Offset 1 is set to a value of 3 for the Z axis. Positive offsets move the starting point of the 
merchandisable area inside the fixture. In this case the value of the offset moves the start 
of the merchandisable area to the top face of the base of the block. 

Offset 2 has no settings. This is because the top of the merchandisable area is already 
correctly positioned at the top front-right corner of the block. 

There is no need to enter X or Y coordinates for the primary area. This is read from data 
stored when the triangular area was defined in the Category tab.  
The end result looks as follows: 
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If the fixture has been defined as stretchable; when the dimensions of the fixture are 
specified in the floor plan, the merchandisable area will move relative to those 
dimensions and extend for the specified portion of the fixture. 

The Further Areas Frame 
The Further Areas frame allows other merchandisable areas to be specified. Further areas 
are of fixed size and are not normally used with stretchable blocks. 

Note: If a primary area has been assigned and a user defines 
a further area, the primary area is disabled.  

 

Names 
Entering data into the text box and pressing Return enters the name of a further area into 
the grid below. Highlighting a further area and pressing delete removes it. Highlighting 
a further area in the list populates the right hand side with any data associated with that 
further area. 

Dimensions 
The pair of X, Y and Z coordinates is used to specify the bounds of the further 
merchandisable area. The left hand set of X, Y and Z coordinates is used to specify the 
bottom-back-left corner of a cuboid. The right hand set of X, Y and Z coordinates is used 
to specify the top front-right corner of a cuboid. The dimensions of this cuboid are 
relative to the first set of points. For example the two sets of points 6,6,6 and 12,18,24 
describe a cuboid with its origin at 6,6,6. It has a length of 12 units, a depth of 18, and a 
height of 24. 

The pick buttons can be used to toggle the user to the currently active drawing in 
Planner. If an instance of the block is present, the user can pick the required points rather 
than manually enter them. 
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The dimensions obey a standard Cartesian coordinate system drawn relative to the 
insertion point of the block as defined in AutoCAD (Planner). The directions of the axes 
in this coordinate system are shown below. The specified co-ordinates are drawn relative 
to the insertion point of the AutoCAD (Planner) block. 

 

Horizontal and Vertical Angles 
These options determine the orientation of the cuboid defined by the directions. This 
orientation can be changed by means of the horizontal angle and vertical angle controls. 
The effects of these controls are shown in the diagram below.  
 

 

The Horizontal Angle is often set to correspond with the front direction of the fixture 
(Insertion tab).  

Origin of Further Area 
The origin of the further area (the first set of X, Y, Z coordinates) is indicated by an X. 
This has been exaggerated in size in the diagram below for clarity; it is normally 
significantly smaller. 
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Configuring Further Merchandisable Areas 
Further merchandisable areas are configured in the Further Areas frame. 

 

 

In the example fixture below, the fixture has two merchandisable areas: left (green) and 
right (blue). This allows merchandise to be placed taking into account the thickness of the 
base, rear, and internal dividing wall. This example shows how to create 
those merchandisable areas 

 

AutoCAD ID Command 
When identifying the coordinates that identify the extents of each merchandisable area, 
the AutoCAD ID command can be useful. 
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Position the fixture that is having its merchandisable areas configured with its insertion 
point at 0,0,0. When OSNAP is turned on, the ID command returns the coordinates of 
any selected point. 

Starting Condition of the Further Areas Frame 
For a new block (fixture) the frame is blank with no further areas added. 

 

Before Starting 
Ensure that the insertion point and child insertion point (Insertion Tab) are appropriately 
set. In this case both have been set to bottom back-left. 

Creating the Left Hand Area 
The first stage is to enter the name of the further merchandisable area in the text box and 
press Return, in this case Left. The name appears in the list of available names. 
Highlighting it activates the rest of the frame, which until now will have been grayed 
out.  
The next stage is to set the dimensions for the bottom-back-left and top-front-right 
corners of a cuboid. The coordinates for the bottom back-left point are 0,-6, 6. These 
define the starting point of the cuboid. The next set of coordinates (12,18,24) define the 
volume of the cuboid, 12 units in positive X, 18 units in positive Y, 24 units in positive Z. 

 

The horizontal angle is set to 270 degrees. This matches the front direction of the fixture. 
The vertical angle is set to 0 degrees as the further area is parallel to the ground. 
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The settings look as follows: 

 

And the end result looks as follows: 

 

Creating the Right Hand Area 
The right hand is created in the same way as the left, except the first set of coordinates is 
set to 18, -6, 6 because this further area starts in a different place. The second set of 
coordinates is the same because the further area is the same physical size. The setting is 
as follows: 
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The result is as follows (with the left further area colored green, and the right further area 
colored blue). 

 

Constrained and Unconstrained Merchandisable Areas 
Primary merchandisable areas can either be constrained or unconstrained. Constrained 
areas are areas that stay within the specified co-ordinates. Unconstrained areas may take 
up any volume in the specified direction.  

These options are set by checking the check boxes in the primary areas frame. 

 

Unconstrained axes are shown visually in the Preview tab. 



Preview Tab 

Shelf Tab 187 

 

Any unconstrained axis has a plus or a minus sign by it. 

Shelf Tab 
The Shelf tab can be used to define the permissible angles for shelves to be set at when 
placed on a fixture. 

 

Currently defined angle categories can be seen from the drop-down list.  
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These angles can then be used as predefined values when assigning shelves in the 
Merchandiser module. 

  

Specifying Permissible Shelf Angles 
Angle categories can be created, edited, or deleted. 

Creating an Angle Category 
To create an angle category, click on the Create button in the Angle Category frame. 
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This brings up the Shelf Angles dialog box. 

 

Enter the required angle category name then left click in the Angles box. (Do not press 
Return at this stage or it will close the dialog box.) 

Enter the required angle and press Return. Continue to enter the required angles and 
pressing return until the desired list of angles has been created.  

 

When the required angles have been entered, click OK to save the information to the 
database and close the dialog box. 

Editing an Angle Category 
To edit an angle category, click the Edit button in the Angle Category frame. This brings 
up the Shelf Angles dialog box. 
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The shelf group name cannot be edited.  

The angles can be edited by typing in the required angle and pressing Return. 

When the required changes have been made, click OK to save the information to the 
database and close the dialog box. 

Deleting an Angle Category 
To delete an angle category, click the Delete button in the Angle Category frame. The 
selected category is deleted without further confirmation. 

Preview Tab 
The Preview tab allows users to visualize merchandisable areas, connection points, the 
origin (insertion point) and the position of the first product placed on a fixture. 

 

Note: In order to display an image in the preview frame, a 
3DS file of that block must be present in the directory 
specified in the Category tab. 
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In the above image, the shelf is enclosed by a red selection frame.  

 While the selection frame is present the fixture can be rotated by holding down 
the left mouse key and moving the mouse cursor around the fixture. 
Alternatively, different viewpoints can be adopted by clicking the icons in the 
Preview toolbar.  

 The selection frame can be removed by holding down the Control key and left 
clicking with the mouse on the fixture. (Alternatively use the <Escape Key>). 
While the selection frame is removed, the fixture can be moved on zoomed in 
and out on by holding down either the left or right mouse buttons and moving 
the mouse cursor around the fixture. Alternatively, different viewpoints can be 
adopted by clicking the icons in the Preview toolbar.  

 The selection frame can be restored by holding down the Control key and left 
clicking with the mouse on the fixture.  

The Preview Tab Toolbar allows users to select the point of view for the displayed 
preview. 

 

Click on the relevant icon to see the viewpoint. 

Icon Description 

 

 
Front view of 
selected object 

 

 
Back view of selected 
object 

 

 
Top view of selected 
object 

 

 
Bottom view of 
selected object 

 

 
Left view of selected 
object 

 

 
Right view of 
selected object 



Block Details Dialog Box 

192 Oracle Retail Macro Space Management Fixture Studio User Guide 

Icon Description 

 

 

NW isometric view 
of selected object 

 

 

NE isometric view of 
selected object 

 

 

SE isometric view of 
selected object 

 

 

SW isometric view of 
selected object 

Merchandisable Areas Option 
The Merchandisable Areas option allows users to see the assigned merchandisable areas 
for a fixture. Activate it by selecting the check box. 

 

Individual users can set their preferred color for the primary merchandisable area in the 
Fixturing tab of the Configuration Module. 
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If there is a single merchandisable area on the fixture, it is displayed as that single color. 
If there are multiple merchandisable areas on a fixture or shelf object, they are displayed 
as different colors. 

 

In the above example, the chiller unit on the left has a single merchandisable area; the 
freezer unit of the right has left and right merchandisable areas. 

Connection Points Option 
The Connection Points option allows users to see the assigned connection points for a 
fixture, fitting, or shelf object. Activate it by selecting the check box. 
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Individual users can set their preferred display size and colors for the connection points 
in the Fixturing tab of the Configuration Module. 

 

The connection points are displayed as small triangles of the specified size and color. 

 

Origin Option 
The Origin option allows users to see the assigned origin (set in the Insertion tab) for a 
fixture, fitting, or shelf object. Activate it by selecting the check box. 
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In the example below, the origin can be seen as a set of red, green, and blue lines set at 90 
degrees to each other.  

 

 

Blue Line Direction of X 
Axis 

Green 
Line 

Direction of Y 
Axis 

Red Line Direction of Z 
Axis 

 

Note: This origin point corresponds to that set in the 
Insertion tab. It does not correspond to the AutoCAD DWG 
file insertion point. 

First Product Option 
The Origin option allows users to see where the first product is placed on a fixture or 
shelf object. It is determined by the child insertion position in the Insertion tab. Activate 
it by selecting the check box. 

 

In the example below, the child insertion position has been set to bottom back-left and 
the first product is within the bounds of the merchandisable area.  
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Overview of Dragging Option 
The Dragging option allows users to manually change the positions of connection points 
or change the size and position of the merchandisable areas. The option is selected using 
the Enable Dragging check box. It is also necessary to check a second option for either 
merchandisable area. 

 

Before any dragging operations can be carried out, the fixture must first be removed from 
its selection box by left clicking on it. 

 

In the above example, the fixture on the left has a selection box and the one on the right 
has it removed.  

Once the selection box has been removed from the fixture, either merchandisable areas or 
connection points can be selected by left clicking on them.   

 

In the example above, the left hand connection point has been selected by left clicking on 
it and is now enclosed by a red selection box. 
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Dragging or Rotating Connection Points 

Dragging Connection Points 
To drag a connection point, select a fixture that has had connection points assigned. 
Check the Connection Points and Enable Dragging check boxes. 

 

 

Ensure the fixture selection box is de-selected by left clicking on it (as per the fixture on 
the right).  

 

 

Select a connection point by left clicking on it. It will be enclosed in a red selection box. 

 

 

Move the mouse pointer over the selected connection point and hold down the left 
mouse key. The connection point can now be dragged to its new position.  

 

Rotating a connection point 
Select a connection point by left clicking on it. It will be enclosed in a red selection box. 
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Move the mouse pointer over the selected connection point and hold down the right 
mouse key. The connection point can now be rotated to its new position.  

 

Connections Tab 
Changes made to connection points by dragging or rotating are reflected in the 
Connections tab. Similarly, small changes in position can be made by changing the co-
ordinates in the Connections tab, then confirming in the preview tab. 

Dragging Merchandisable Areas 
To drag a merchandisable area, select a fixture that has had one or more merchandisable 
areas assigned. Check the Merchandisable Areas and Enable Dragging check boxes. 

 

 

Next ensure that the fixture is de-selected and the merchandisable area selected. This can 
be done by holding down the Control key, then left clicking on the fixture to de-select it. 
The merchandisable area can then be selected by holding down the Control key, then left 
clicking on the merchandisable area to select it.  
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In the example above, the fixture is shown as selected on the left, while the 
merchandisable area is shown as selected on the right.  

The merchandisable area can then be dragged by the mouse. 

Move the mouse pointer over the merchandisable area and hold down the left mouse 
key. The merchandisable area can now be dragged to its new size. 

 

Merchandisable Areas Tab 
Changes made to merchandisable areas by dragging are reflected in the Merchandisable 
Areas tab. Similarly, small changes in position can be made by changing the co-ordinates 
in the Merchandisable Areas tab, then confirming in the preview tab. 
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5 
Fixture Hierarchies 

Fixtures are arranged into a Fixture hierarchy by means of fixture groups. Fixture groups 
are a way of arranging large numbers of fixtures into subsets sharing a common 
characteristic. For example, one group could hold all fittings and fixtures used for 
clothing, another for all those used for chilled or frozen foods. The example below shows 
the Fixture hierarchy in Fixture Studio. 

 

Fixture hierarchies have a number of uses within Macro Space Planning: 

 They make it easier to manually navigate to the required fixture in Fixture Studio. 

 The same hierarchy also appears in the Object Browser in the Planner and 
Merchandiser modules and in In-Store Space Collaboration. Again, a well designed 
hierarchy makes it easier to manually navigate to the required fixture. 

 Fixture groups can be used to pre-filter the data that shows in the Object Grid. For 
example, clicking on the appropriate Fixture group populates the Object Grid with 
all fittings and fixtures used for clothing. 

 Fixture groups can be used as filters for data in reports, for example from BI 
Publisher. 

Adding, Editing, and Deleting Fixture Groups 
Fixture groups are used to arrange fixture definitions into logical subsets. The resulting 
hierarchy is used in Fixture Studio for maintaining information on the equipment used in 
Macro Space Planning. The hierarchy also appears in the Object Browser in the Planner 
and Merchandiser modules and in In-Store Space Collaboration.  
Groups can be added, edited, and deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu.) 
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Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click the 
Add Group Icon. The Group dialog box appears. 

 

Enter a description and select an icon from the drop-down list. Click OK to confirm. 
The group to be added is a child of its selected parent group. 

Edit Group 
To edit a group, highlight the group which is to be edited. Click the Edit Group Icon. The 
Group dialog box appears. 

 

Edit the description if requited. It is also possible to select an alternative icon from the 
drop-down list. Click OK to confirm. 

The Group details are updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click the Delete Group Icon. 

If the group to be deleted has child groups or block definitions, a warning dialog 
appears. 

 

If there are no child objects, the group is deleted without any requirement for 
confirmation. 
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6 
Fixture Creation 

Overview of AutoCAD Blocks 
This section explains the basic concepts of an AutoCAD Block. 

The AutoCAD Drawing 

 

The AutoCAD drawing (floor plan) consists of two parts. 

Model space (or the drawing area), which is the part of the drawing that is visible to the 
user. It is where a fixture (or a store plan) is created.  

Database, which is the part of the drawing is not visible to the user. It contains details of 
all the information drawn in the visible part. 

Blocks and Their Purpose 
Blocks are a mini-drawing representing a single object that can be placed multiple times. 
Consider a checkout. Each store might contain ten checkouts. If there are 300 stores in the 
chain, the total is 3,000 checkouts. Drawing each checkout individually would be very 
labor intensive. Better to draw a single checkout and then store it in a form that can be 
repeatedly reinserted into other drawings. The form it is stored in is called a block. 

Blocks can exist in two forms, locally within the drawing and as an external DWG file. 
Once a block has been created within a drawing, it can be reused multiple times within 
that drawing. It cannot however be used outside of that drawing. It is also possible to 
write the block to an external Windows folder in the form of a DWG file. This form of 
block can be used multiple times in any number of drawings. 

The process can be represented diagrammatically as follows: 

 The fixture is drawn in AutoCAD. 

 The AutoCAD Block command is used to write the local block into the database part 
of the drawing. 

 The AutoCAD Write Block (WBlock) command is used to write a copy of the block to 
a Windows folder. 

 Once in the Windows folder, the AutoCAD Insert command can be used to insert 
multiple copies of the block into other drawings. 

Naming Conventions 
A naming convention is a planned and logical way of assigning block names.  

If blocks are given names like Widget-187567 and Gizmo-ADRTYN, it is not obvious 
what the blocks are for, or what their dimensions are.  

With a well thought-out naming convention, things are far simpler. 
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In the above example, there are three types of block; Back Panels, L-shaped uprights, and 
T-shaped uprights.  

It is apparent from the block names that the back panels have widths of 600 and 900 mm, 
and that they have heights of 1400, 1600, 2500, and 2900 mm.  
Similarly, it is obvious that both the L-shaped and T-shaped uprights come in four 
heights; 1400, 1600, 2500, and 2900 mm. 

Widget-187567 might well be a back panel of width 600 mm and height 2500 mm, but the 
lack of naming convention means this cannot be deduced from the block name. 

Drawing the Fixture 
The beginning point for creating a fixture is to create a representative drawing within the 
AutoCAD environment. This is normally created within a drawing used as a Fixture 
Library. 

 

The drawing should be dimensionally accurate and showing the level of detail required 
for display in the Macro Space Management Planner and Merchandiser environments. 
The following points should be noted. 

Do not use unnecessary detail. The drawing should be representative of the fixture, but 
drawing too great a level of detail is not recommended. This increases the size of the 
eventual DWG file (and 3DS file). Because a floor plan may contain some thousands of 
fixtures, an over elaborate fixture drawing (and resulting increased file size) can result in 
performance in the floor plan becoming slow. 
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Ensure the insertion point is appropriately positioned. It is useful to have a consistent 
position for the insertion points for the fixtures that are drawn. This makes it easier when 
configuring blocks in Fixture Studio. For example, all fixtures can be created with 
insertion points of bottom, back, and left. All pegs can be created with insertion points of 
middle, center, and back. 

Another point to consider when selecting insertion points is In-Store Space Collaboration. 
This application represents fixtures and fittings as rectangles based on the extents of the 
block. 

 

The checkout above (purple outline) is not rectangular in shape. The dotted outline 
indicates the rectangle that represents the checkout in In-Store Space Collaboration. The 
insertion point for the fixture should be placed where the blue square is and set to 
bottom back left. If the insertion point is placed where the red square is, the rectangle 
representing the checkout will not be drawn in the correct position in ISSC.  
Ensure that the front direction of the fixture is correct. Fixtures are assigned a front 
direction. This indicates the primary direction that a customer approaches to get 
merchandise.  

 

 

By convention, this is normally 270 degrees (the equivalent of south). The fixture should 
be drawn so that, when converted into a block, it is in this orientation. 
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Add in 2D/3D Functionality. If 2D/3D functionality is required, the varying parts of the 
block must be configured accordingly. (See the section on how to create 2D/3D 
functionality for more information). 

Ensure the Color and Line Weight is set By Block. The ability to change the color and line 
weights of individual blocks within a drawing (floor plan) is used by two specific items 
of Macro Space Management functionality. 

KPIs depend on the ability to change the color of individual blocks. It is possible to color-
code blocks in a Planner floor plan by specific performance criteria. In the example 
below, fixtures designated as promotional fixtures have had their outline changed to red, 
while standard fixtures have gray outlines.  

 
This functionality only works if the color properties for the block are set to By Block in 
the AutoCAD Properties dialog box when the block is being configured.  

 

The 'Thicken' form of Highlighting requires the line weight of the block to be changed. 
Highlighting options for blocks are set in the Fixturing tab of the Configuration module. 
One option is Thicken. If the Highlight in View option is selected on the Object Browser 
in Planner, fixtures selected in the Fixture hierarchy will have their outlines thickened. 
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This functionality only works if the line weight properties for the block are set to By 
Block in the AutoCAD Properties dialog box when the block is being configured.  

 

2D/3D Functionality 
2D/3D functionality allows users to toggle between an outline at floor level and a full 3D 
representation of a fixture in the Planner module. The function is accessed from the 
Planner module from either the Retail Layers toolbar or the View Menu. 
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This is useful when publishing a store plan as it can be output with the fixtures in a 
simplified form, with many of the construction lines omitted. The screen shot below 
shows the fixtures in both 3D (top) and 2D (bottom) form. 

 

This can be achieved as follows: 

Note: If an existing block from a client is being modified, this 
will have to be exploded first, and then re-blocked after the 
2D/3D modifications have been made. 

1. Create a drawing to be used as a Fixture Library. 
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2. In the drawing, create two layers called 2D and 3D. (These precise names must be 
used as the MSM functionality references them). 

3. While on Layer 0, draw an outline representing the outline of the block at floor level. 

Note: The outline is only required if the fixture or fitting 
places directly on the floor. If the object is (for example) a 
shelf, then it only requires a 3D component so that it 
vanished from view when a floor plan is toggled to 2D.  

4. Using the properties dialog box: 

a. Set the Layer to 2D. 

b. Set the Color to By Block. This ensures the block colors correctly for KPIs. 

c. Set the Line Weight to By Block. This ensures that the block thickens correctly if 
Thicken is a highlight option. 

5. While on Layer 0, draw a 3D representation of the block at floor level. 

6. Using the properties dialog box: 

a. Set the Layer to 3D. 

b. Set the Color to By Block. This ensures the block colors correctly for KPIs. 

c. Set the Line Weight to By Block. This ensures that the block thickens correctly if 
Thicken is a highlight option. 

7. Use the Block command to turn the 2D and 3D components into a block. 

8. Test that the block toggles between 2D and 3D mode by turning the 2D and 3D layers 
off and on as required. 

Note: Setting Color and Line Weight to By Block enables 
instances of that block placed in floor plans to have the color 
and line weight modified by the application. If the Color and 
Line Weight are set to By Layer, then instances of that block 
will adopt the defaults for that layer when placed and 
cannot be modified by the application.  

Information for AutoCAD Experts 
When converted onto a block later (on Layer 0), the block will contain internal layers 
called 2D and 3D. When the block is placed into floor plan in Macro Space Management, 
this will result in the creation of additional layers called 2D and 3D in that floor plan. 
When the 2D/3D functionality is used, the respective layers will be toggled on/off, 
leaving those parts of the block on either the 2D layer or 3D layer visible.   

Creating and Inserting AutoCAD Blocks 

Note: This section of help shows how to make, save, and 
insert blocks using purely AutoCAD tools. It is intended for 
users new to AutoCAD so they can see the basic process 
involved. The procedure for registering blocks in Fixture 
studio is more complex and is discussed further in a separate 
section. 

The stages for creating a block are as follows: 
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Draw Fixture 
The fixture is drawn using standard AutoCAD methods. It must be on Layer 0 of the 
drawing. 

 

Convert to a Block 
To convert to a block, type BLOCK into the command line and press Return. The Block 
Definition dialog box appears. 

 

1. Enter a unique name into the Name text box. 

2. Click the Select Object button and select the required fixture. 
3. If the bottom back-left corner of the fixture is at coordinates, 0,0,0 no further action is 

required. If the bottom back-left corner of the fixture is not at 0,0,0 then the Pick Point 
button in the Base Point frame should be used to specify the bottom back-left corner 
of the fixture. 

Note: the requirement to pick bottom back left is Macro 
Space Planning specific. It is not required in 'raw' AutoCAD. 

4. Set the correct units in the Settings Frame 
5. On clicking OK, the selected fixture is saved as a block. 
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The drawing of the fixture has now been converted into a block. This block may be 
inserted multiple times within the current drawing, but cannot yet be inserted in other 
drawings. 

Write to Windows Folder 
To take an existing block and write it to a Windows folder, Type WBLOCK (Write Block) 
into the command line and press Return. The Write Block dialog box appears. 

 

1. Click the Block Radio button. 
2. Select the name of the required block from the drop-down list. 

3. Select a destination to save the block. This can be done by clicking the button in the 
destination frame. 

4. Ensure the Insert Units are set correctly. 

5. On clicking OK, the block is saved as a DWG file to the external windows folder. 

Inserting a Block 
1. To take an existing block and reinsert it in a drawing, type INSERT into the 

command line and press Return. The Insert dialog box appears.  
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2. Select the Name of the block from the drop-down list. This will give a list of blocks 

currently inserted in the drawing. If the required block is not in the list, click the 
Browse button, navigate to the appropriate Windows folder and select the required 
DWG file. 

3. If the Specify On-Screen check box is selected, the block can be inserted at any point 
in the drawing. If it is un-selected, it will be inserted at the specified coordinates. 

4. On clicking OK, the block will be inserted into the drawing. 

AutoCAD Blocks and Macro Space Management 
In order to ensure optimum performance within Macro Space Planning, blocks must be 
created and defined in a very specific sequence. Failure to follow all steps in this process 
may result in problems when using functionality within Macro Space Planning.  

 

Create Block in the Planner Module 
The first stage of the process is to create an AutoCAD block in the Planner module. This 
block should be configured so it meets the requirements of Macro Space Planning. 

1. The insertion point should be bottom back left.  Any other insertion point (except in 
special cases) may cause problems. 

2. If 2D/3D functionality is required, the block should be drawn on 2D and 3D layers as 
required. 

3. Ensure the units are correct for the type of database the block will be used in: 
imperial or metric as required. 

4. Ensure the block is appropriately named, particularly if a naming convention is in 
use. 

5. If possible, ensure the block is stored in a Fixture Library.  

Import the Block into Fixture Studio 
Importing the block from a Fixture Library into Fixture Studio is good practice. This is 
done as follows: 

1. Ensure that both Planner and Fixture Studio are open. Also ensure the Fixture 
Library is the active drawing in Planner. 
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2. Select the Connect to AutoCAD option from the File menu. This links Fixture Studio 
to the currently Active Drawing in Planner. It also means Fixture Studio can access 
the AutoCAD functionality it requires to save the block. 

 

3. Select the Read Blocks option from the View menu. This brings up the Read Blocks 
dialog box. Select the Merge option. This compares the information in the database 
and the currently active Planner drawing. Any blocks that are in the drawing, but not 
the database, will be imported into Fixture Studio. 

 

4. The block(s) are visible in the Fixture hierarchy. They can be dragged and dropped to 
the appropriate fixture group in the hierarchy. 
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5. The required fixture is then highlighted and the Edit Block option selected. This 
brings up the Block Details dialog box. 

 

The required details are then configured in each tab. One item of data to set is the 
directory. This specifies the Windows folder where the copy of the DWG file inserted by 
MSM into the planner drawing will be stored. On clicking OK, the details for the block 
are stored locally in Fixture Studio, and not yet written back to the Macro Space Planning 
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database. This can be seen in the list of blocks, where the Red icon and -1 Block ID 
indicate that data is not yet saved back to the database. 

 

6. Save the block details back to the database. This is done by selecting the Save blocks 
option from the File menu. 

 

 Both the Database and Drawing options should be selected. The drawing option 
ensures that XData is written to the current copy of the block in the Fixture 
Library. 

 Add New Definitions should be selected to ensure the new block's details are 
written back to the database. 

 Only Save Selected blocks should be selected to avoid writing back details of all 
blocks (new or not) to the database. 

 Write Block Files ensures XData is written both to the block in the Fixture Library 
and to the copy of the DWG file stored in the Directory specified in the Block 
Details dialog box. 

On clicking OK in the Save Block Definitions dialog box, the following actions take place. 

 The information held in local memory is permanently written to the database. 
 XData (MSM specific data) is written to the instance of the block in the currently 

active drawing. (An instance of every block being saved must be in the currently 
active drawing). 

 A copy of the block in the currently active drawing is written to the directory 
specified in the Category tab of the block Details dialog box. 

Note: When first saving blocks, Fixture Studio sometimes 
saves the DWG file to the MSM directory rather than the 
directory specified in the block details dialog box. This 
problem can be solved by cutting and pasting the DWG Files 
to the correct directory. 
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7. Create a 3DS File. Highlight the required block(s) in the Fixture Hierarchy and then 
select the Create 3DS file(s) option from the File menu. (You must be connected to 
AutoCAD [Planner] to access this option). 

 

On clicking the option, the 3DS files are created and a confirmatory message appears. 

 

 

Tips and Tricks 

Fixture Library 
It is recommended all blocks be manipulated in fixture libraries. These are drawings that 
hold master copies of specific types of blocks. Blocks are often organized using a grid, 
which enables them to be stored in a manner that facilitates locating any block that is to 
be modified.  
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There are often multiple fixture libraries. Each contains a specific class of block, for 
example racking or freezer/chiller units. 

Having all blocks of a certain type grouped together in a drawing makes editing of the 
blocks easier, should it be required in the future. 

XData 
Some data is stored in a specialized attribute called BSLINK-ATT. This attribute is 
produced when the Write Block command is used when saving blocks in Fixture Studio. 
It is located at the insertion point of the block, is of very small size and only becomes 
visible after the block is exploded in an AutoCAD floor plan.  

 

This data is used for a number of actions including: 

 Connection Points  

 Fixture Manipulation  

If the XData is absent, this affects the operation of this functionality in Planner. 

Viewing the XData 
Occasionally it is useful to view the XData (for example when liaising with Oracle 
Support). This can be done as follows in AutoCAD: 
1. Enter SEQ into the AutoCAD command line. 

 

The Command Line instructs the user to select a block. 
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On clicking a block, the command line dialog box appears with the XData visible. 

 

Pressing Return returns the user to the AutoCAD floor plan. 

Using Composites to Rename Blocks 
It is possible to create a composite block that results in a renamed block being inserted 
into an existing drawing (floor plan). This is done as follows within AutoCAD: 

1. Within a fixture library take a specific block from the client and explode it. 

2. Select the exploded sub-entities and remake the (child) block with the required 
modified name. 

3. Select the recently created block and remake it as another block with the original 
block name. This is the composite (parent) block. The inner (child) block has the 
modified name. The outer (parent) composite block has the original name. 

This should have resulted in a composite with the following properties that can be seen 
in the schematic diagram below: 

 

The block with the red outline is the inner (child) block with the new name. The block 
with the blue outline is the (parent) composite block with the original name. 

As will be described in a later chapter, the child block and parent composite block can 
then both be registered in Fixture Studio. An existing floor plan can then be opened 
(using Store Planner) in the Planner module. The Restructure Drawing facility can then 
be used to: 

 Redefine Blocks from Disc. This action results in the recently created composite 
(parent) block replacing the older client designed block of the same name in the 
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drawing. As the composite block has exactly the same insertion point as the older 
block it is replacing, it occupies exactly the same position in the drawing. 

 Explode Composites. This action results in the composite (parent) block 
exploding and disappearing. It leaves behind (in exactly the same position) the 
inner (child) block. This block has the modified name.  

Note: For the Explode Composite option to work in 
Restructure Drawing, the block must be set to type 
’Composite’ in the Retail Type drop-down list in the 
Category Tab of the Block Details dialog box in Fixture 
Studio. 

After the composite has been exploded, the Synchronization option can be used to write 
the changes back to the database. 

Restructure Drawing and Synchronization are covered in more detail in the chapter on 
converting the client’s existing drawings for use in Macro Space Management. 

Correcting Insertion Points using Composites 
All DWG files have an insertion point. This serves as a data for when blocks are inserted 
and manipulated within a floor plan. In the example below, the insertion point can be 
seen at bottom, back, left for the fixture block. This is the default position assumed by 
much of the functionality in Macro Space Management and In-Store Space Collaboration. 

 

If the insertion point is in another position (for example bottom, front, left) then there 
may be problems with functionality within Macro Space Management and In-Store Space 
Collaboration. For example: 

 Area Calculations may not give the correct results. 

 Product blocks may not place correctly in the Planner module. 

 Shelves may not place correctly in the Merchandiser module without the aid of 
connection points. 

This problem can be corrected as follows: 

1. Within a fixture library take a specific block from the client and explode it. 

2. Select the exploded sub-entities and remake the (child) block with the insertion point 
in the bottom, back, left position using an appropriate block name. 

3.  See the section on renaming blocks using composites. This task can be carried out at 
the same time as insertion points are repositioned. 

4. Select the recently created block and remake it as another block with the original 
insertion point and original block name. This is the composite (parent) block. 

This should result in a composite with the following properties: 
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 The inner (child) block has an appropriate bottom, back, left insertion point and a 
suitable name. 

 The outer (parent) composite block has the original name and insertion point. 

This can be seen in the schematic diagram below: 

 

The block with the red dotted outline is the inner (child) block with the bottom, back, left 
insertion point. The block with the blue dotted outline is the (parent) composite block 
with a bottom, back, right insertion point. 

The child block and parent composite block can then both be registered in Fixture Studio. 
An existing floor plan can then be opened (using Store Planner) in the Planner module. 
The Restructure Drawing facility can then be used to: 

 Redefine Blocks from Disc. This action results in the recently created composite 
(parent) block replacing the older client designed block of the same name in the 
drawing. As the composite block has exactly the same insertion point as the older 
block it is replacing, it occupies exactly the same position in the drawing. 

 Explode Composites. This action results in the composite (parent) block 
exploding and disappearing. It leaves behind (in exactly the same position) the 
inner (child) block. This block has a bottom, back, left insertion position and 
possibly a different name (perhaps one obeying a naming convention). 

For the Explode Composite option to work in Restructure Drawing, the block must be set 
to type ’Composite’ in the Retail Type drop-down list in the Category Tab of the Block 
Details dialog box in Fixture Studio. 

After the composite has been exploded, the Synchronization option can be used to write 
the changes back to the database. 

 



 

221 

7 
Gondola Hierarchies 

Gondolas are arranged into a Gondola hierarchy by means of gondola groups. Gondola 
groups are a way of arranging individual gondolas into subsets sharing a common 
characteristic. For example, one group could hold all the gondolas used for chilled food, 
another all the gondolas used for fruit and vegetables. The example below shows the 
Gondola hierarchy in Fixture Studio. 

 

Gondola Hierarchies have a number of uses within Macro Space Planning: 

 They make it easier to manually navigate to the required gondola in Fixture 
Studio. 

 The same hierarchy also appears in the Object Browser in the Planner and 
Merchandiser modules and in In-Store Space Collaboration. Again, a well 
designed hierarchy makes it easier to manually navigate to the required gondola. 

 Gondola groups can be used as filters for data in reports (for example from BI 
Publisher). 

Adding, Editing, and Deleting Gondola Groups 
Gondolas groups are used to arrange gondola definitions into logical subsets. The 
resulting hierarchy is used in Fixture Studio for maintaining information on the 
equipment used in Macro Space Planning. The hierarchy also appears in the Object 
Browser in the Planner and Merchandiser modules and in In-Store Space Collaboration.  

Groups can be added, edited, and deleted using the options on the toolbar. (They may 
also be added using the options on the right click menu). 
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Adding a Group 
To add a group, highlight the parent group to which it is going to be added. Click on the 
Add Group Icon. The Group dialog box appears. 

 

Enter a description and select an icon from the drop-down list. Click on OK to confirm. 

The group to be added is a child of its selected parent group. 

Edit Group 
To edit a group, highlight the group which is to be edited. Click the Edit Group Icon. The 
Group dialog box appears. 

 

Edit the description if required. It is also possible to select an alternative icon from the 
drop-down list. Click OK to confirm. 

The Group details are updated. 

Delete Group 
To delete a group, highlight the group to be deleted. Click the Delete Group Icon. 

If the Group to be deleted has child groups or block definitions, a warning dialog 
appears. 

 

If there are no child objects, the group is deleted without any requirement for 
confirmation. 
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8 
Gondolas 

Gondolas are predefined arrangements of fixtures and fittings that are aligned to each 
other in a precise spatial relationship. This enables long runs of equipment to be placed 
using just a few commands, saving considerable time when creating store plans. In the 
example below, the run of storage racking is configured as a gondola and can be placed 
in four separate sizes in either two or three tiers. 

 

Gondolas are made up of repeating units called bays. A gondola consists of one or more 
bays. Each bay contains a specific arrangement of fixtures and fittings. A bay could be as 
simple as a simple fixture, for example a Chiller unit.  

 

Equally, a bay could be made up multiple components. In the example below, the 
slatwall gondola consists of a number of bays. The first bay has been exploded to show it 
is made up of three components: a leg, slatwall, and base. 
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Gondolas are defined in Fixture Studio using the Gondola definition dialog box. 

 

They can then be placed in the Planner and Merchandiser module (and in In-Store Space 
Collaboration) using the Gondola Run dialog box. 
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This dialog box allows this specific gondola to be: 

 Placed in any combination of six lengths and heights. 

 Have optional start and end caps. 

 Have a specific number of bays. 
 Be placed at a specific angle from a specific starting point. 

This makes laying out equipment in a store plan fast and easy. 

Basic Steps in Gondola Creation 
There are a number of basic steps to gondola creation.  

Some of these steps must be taken at the time the database is first created (for example 
deciding on a naming convention).  

The steps are: 

 Decide on and implement a naming convention 

  Import the blocks into Fixture studio (not covered in this section) 

–  Ensure Insertion points are consistently located 
 Assign Gondola Part Types 

 Assign Gondola Sizes 

 Define Gondola 

– Define name, main length and maximum bays 

– Select and assign dimensions 

– Specify the list of parts 

– Define the part details 

– Define the part size position and rotation 

Naming Conventions 
Naming conventions are vital to the efficient operation of Macro Space Management. 
They must be decided upon before any blocks are imported into Fixture Studio.  
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A naming convention is a planned and logical way of assigning block names.  

Names like Widget-187567 and Gizmo-ADRTYN do not make it clear what the blocks are 
for or what their dimensions are.  

Here is an example of an organized naming convention: 

 

In the above example, there are three types of block: Back Panels, L-shaped uprights, and 
T- shaped uprights.  

The back panels have widths of 600 and 900 mm and heights of 1400, 1600, 2500, and 
2900 mm.  

Both the L-shaped and T-shaped uprights come in four heights; 1400, 1600, 2500, and 
2900 mm. 
Widget-187567 might well be a back panel of width 600 mm and height 2500 mm, but 
that is not clear from the block name. 

Naming Conventions 
Naming conventions are of the general form: 

Prefix-parameter-parameter-parameter-suffix 

These can be any combination of numbers and letters, together with several separating 
characters. 

The separating characters can be: 

 A minus sign (-) 
 An underscore ( _ ) 

 An x  

Each of the following naming conventions is equally valid: 

 Prefix-Parameter-Parameter-Parameter-Suffix 

 Prefix-ParameterxParameterxParameter-Suffix 

 Prefix_ParameterxParameterxParameterxSuffix 
Note that the use of naming conventions must be consistent. Naming blocks with a 
mixture of ‘–’, ‘_’ or ‘x’ will lead to errors.  

The following example shows incorrectly named back panels. Macro Space Management 
expects to find the same separating character for blocks within a naming convention.  
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 Backpanel-600-1400 

 Backpanel-600x1600 

When the program draws a gondola, if it expects to see: 

Prefix-Width-Height 
And some of the blocks are named: 

Prefix-WidthxHeight 

It will find blocks with name like Backpanel-600-1400 because these are in the expected 
form. It will fail to find blocks with names like Prefix-widthxheight because there is an ‘x’ 
present where Macro Space Management expected to find a ‘–’. 

Examples of Naming Conventions 
The examples below are all valid examples of naming conventions: 

Prefix-Size 
 Leg-1500 

 Leg-2000 

 Leg-2500 

Prefix-WidthxHeight 
 Backpanel-600x1500 
 Backpanel-900x1500 

 Backpanel-1200x1500 

Prefix-Width-Depth-Height  
 FreezerUnit-600-800-300 

 FreezerUnit-600-800-400 

 FreezerUnit-600-1000-500 

Prefix-Width-Depth-Height-Suffix 
 FreezerUnit-600-800-300-Lozier 

 FreezerUnit-600-800-400-Lozier 

 FreezerUnit-600-1000-500-Lozier 
 FreezerUnit-600-800-300-Hoffmann 

 FreezerUnit-600-800-500-Hoffmann 

 FreezerUnit-600-1000-500-Hoffman 

Prefix-Size 
 Podium-Small 

 Podium-Medium 

 Podium-Large 

In general naming conventions should be specified such that the block name provides all 
the information required. If we take the example of a naming convention of the form: 

Prefix-Width-Depth-Height-Suffix 

Block names of the form allow us to define gondolas so that at the time of addition into 
the Planner or Merchandiser environments we can choose the: 

 Specific type – for example Freezer Units 
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 Specific width – for example 600, 800 and 1000 mm 

 Specific depth – for example 800, 1000 and 1200 mm 

 Specific height – for example 400, 500 and 600 mm 

 Manufacturer – for example Lozier 

Gondola Parts 
Gondolas are made up from a number of components. In the example below, the gondola 
is made up of Freezers of type Structure and Condiment Cabinets of type Bench 
Mounted. This information can be used for reporting purposes.  

 

These reporting types can be defined in the Gondola Parts dialog box. This is accessed 
from the Gondola Parts icon on the toolbar. 

 

This brings up the Gondola Parts dialog box. 

 

Gondola parts can be added by typing entries into the top row and pressing Return.  

Gondola parts can be deleted by highlight the pertinent entry and pressing Delete. 
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These part types are then available in the Type drop-down list of the Details sub-tab of 
the Parts tab of the Gondola Definition dialog box. 

 

Mapping Gondola Parts 
Sometimes a client has an existing fixture library where the block names do not conform 
to a naming convention. Gondolas require blocks with naming conventions. Mapping 
Gondola Parts is initiated from the toolbar.  

 

Alternatively, it can be initiated from the Mapping button of the Details sub-tab of the 
Parts tab of the Gondola Definition dialog box. 

 

This brings up the Gondola Block Mapping dialog box. 
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If initiated from the toolbar, the naming convention must be typed in. If initiated from 
the Gondola definitions dialog box, the possible naming conventions will already be 
populated. The block name can then be typed in. In addition, if the block needs to be 
given a rotation during insertion of the gondola, this angle can be specified. Press Return 
after each line to ensure the information is written back to the database. 

Assigning Gondola Sizes 
 
The parts that make up a gondola run come in specific sizes. The possible sizes for 
specific gondola dimensions are entered in the Gondola Sizes dialog box. This is accessed 
by clicking on the Gondola Sizes icon on the toolbar. 

 

 

This brings up the Gondola Sizes dialog box. 

 

Dimensions can be added on the left hand size by clicking the Add Size icon. Data can 
then be entered on the right. 



Specifying Part Size, Position and Rotation 

Gondola Definitions Dimensions Tab 231 

 Size is the physical size that is used for calculation purposes by Macro Space 
Management when drawing the bay. In the above example, the bays are 6 inches 
longer than the size of the main part for the bay. 

 Description is the text that appears in the Add Gondola dialog box in the Planner 
and Merchandiser module (and in In-Store Space Collaboration). In the above 
example the description is in feet, which is easier for users to select than if the 
dimension were in inches. 

 Name is the text that is matched to the block name. In the above example, the 72 
name is eventually matched up to the pertinent part of the I_HDR_Beam_72x1-
5x4 block name that is used to draw the gondola.  

Once assigned to a gondola definition, Gondola sizes become available for selection in 
the Add Gondola dialog box in the Planner and Merchandiser module (and in In-Store 
Space Collaboration). 

 

Gondola Definitions Dimensions Tab 
The Dimensions tab is primarily used to specify the name and the dimensions used in the 
gondola. 
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Name and Description 
The Name must be unique within the Macro Space Planning database.  

The Description can be used to give more information as to the gondola definition if 
required.  

Main Length 
If set to 0, the main length is set automatically, based on the dimension selected when the 
gondola is placed in a floor plan.  

If the main length is set to any positive value, then each bay in the gondola will be that 
single, fixed length. 

Max Bays 
If set to 0, then the number of bays that can be placed in a floor plan is unlimited. 

If set to a positive number, this will limit the number of bays that can be placed when the 
gondola is added to a floor plan. 

Dimensions 
The list of available dimensions is available in the left hand pane. These are configured in 
the Gondola sizes dialog box that can be accessed from the toolbar. They can be selected 
for use by double clicking in the left hand pane. They then appear in the right hand pane. 

 Size Range is the name of the size range. It cannot be edited. 
 Label is the title given to the dimension in the Add Gondola dialog box that is 

used to place gondolas in the Planner and Merchandiser modules and in In-Store 
Space Collaboration. This enables the dimension name to be modified to make it 
easy for store planners. 
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 Suffix is used in building up the block name when the gondola is placed in a store 
plan. This is discussed in more detail in the section on the Parts tab. 

 Name Order is used in building up the block name when the gondola is placed in a 
store plan. This is discussed in more detail in the section on the Parts tab. 

 Main is the dimension used to specify the length of the bay when the gondola is 
placed in a store plan. Only one dimension can be designated as main. 

 
There should always be a Main dimension specified unless the Main Length text box 
has a value specified. 

Gondola Definition Parts Tab Details 
The Details sub-tab of the Parts tab enables users to set up a list of gondola parts, define 
some rules as to how the blocks used to draw the gondola in a floor plan are identified, 
and specify the gondola bays that part is used in. 
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Parts 
Names for specific parts within a gondola are entered by typing a name in the text box at 
the top off the Parts frame and pressing Return.  

 

Parts can be deleted by highlighting them in the list then pressing Delete. Highlighting a 
gondola part also makes it available for editing. 

Block Names 
Two part of the Parts Tab/Details sub-tab are used to create a series of rules used to 
determine the name of the block used to create that part of the gondola. 
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 Type - this is selected from a drop-down list and is used for reporting purposes. 
The drop-down list is configured using the Gondola Parts option on the toolbar. 

 Description - this is the part name. It is echoed across from the left hand pane 
holding the list of part names. 

 Prefix - this becomes the first part of the block name used to draw the gondola 
when it is placed in a floor plan. All blocks used to draw this gondola part start 
I_BR__Slatwall_ 

 Suffix - this is the concluding part of the block name. Suffixes like _Wood or 
_Red could be used to specify particular types of blocks. 

 Optional - this option allows users to specify whether a part is optional or not. It 
is activated by typing the name of the optional part in to replace the <no> option. 

 

The part can then be selected or de-selected by means of the check boxes in the Add 
Gondola dialog box when the gondola is added in the Planner and Merchandiser 
modules or in In-Store Space Collaboration. 

 
 Name Dependency - this is used to specify the Dimensions to use when 

determining the block name.  
 Mapping Button - this serves two purposes: 
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– It can be used to bring up a list of all possible combinations of block names 
defined for the part. This is useful in seeing if the details have been 
configured properly. 

– It can be used to map names from a naming convention (such as 
I_Backpanel_36x1x72) to non-systematic block names such as ABC123. 

Include If 
Include if specified which bays the part will be associated with. 

 

 

 First Bay - if checked, the parts will be drawn in the first bay. 

 Middle Bay - if checked, the part will be placed in all bays except the First and Last 
bays 

 Last Bay - if checked, the parts are drawn in the last bay. 

 Odd Bay - if checked, there parts are placed in all odd-numbered bays. 

 Even Bay - if checked, there parts are placed in all even-numbered bays. 

These can be used in combination. In the example below, the gondola has been 
configured to place a chiller unit in the odd numbered bays and a freezer unit and 
condiment cabinet in the even-numbered bays. 

 

Building up Block Names 
When a gondola is placed in the Planner or Merchandiser modules, it relies on using a 
DWG or 3DS file to represent the gondola. In order to find the required file, Macro Space 
Planning reconstructs the block name from selections made in the Add Gondola dialog 
box and information in the Gondola definitions dialog box. This process is followed for 
every part in the gondola. 
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Add Gondola Dialog Box 
The starting point for placing a gondola is the Add Gondola dialog box. Here the user 
selects the required dimensions. In this example, there are three: Racking Length, 
Racking Depth, and Racking Height. Values of 48 inches, 24 inches, and 96 inches have 
been selected. On clicking the OK button, the application starts to reference information 
in the Gondola Definitions dialog box. 

 

 

Gondola Definitions Dialog Box Prefix 
The next stage is derived from the Parts sub-tab of the Details tab of the Gondola 
Definitions dialog box. The Prefix (if any) is selected and becomes the first part of the 
block name. In this case it is I_BR_Fixture_. 

 

Gondola Definitions Dialog Box Name Dependencies 
The next stage in building up the block names depends on the selected Name 
Dependencies. 
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These Name Dependencies are then used in Name Order sequence. 

 

 The starting point for the block name is the suffix: I_BR_Fixture_. 

 The first name dependency is Racking Length. This is 48 inches, so a value of 48 
is added to the suffix, together with the Suffix for Racking Length. This modifies 
the block name to I_BR_Fixture_48x. 

 The next name dependency is Racking Depth. This is 25 inches, so a value of 24 is 
added to the block name, together with the Suffix for Racking Depth. This 
modifies the block name to I_BR_Fixture_48x24x. 

 The final name dependency is Racking Depth. This is 25 inches, so a value of 96 
is added to the block name. There is no Suffix for Racking Depth. This modifies 
the block name to I_BR_Fixture_48x24x96. 

See the section on Assigning Gondola Sizes for more information on how Name 
dependencies/Dimensions are configured. 

Gondola Definitions Dialog Box Suffix 
The final part of the block name is derived from the Parts sub-tab of the Details tab of 
the Gondola Definitions dialog box. The Suffix (if any) is selected and becomes the last 
part of the block name. 

 

 

In this example, there is no suffix and so there is nothing to be added to the block name. 
(If the suffix had been _Steel, the result would have been I_BR_Fixture_48x24x96_Steel).  

Selecting the Block 
The final block name is I_BR_Fixture_48x24x96. The functionality identifies that block 
name in the fixture hierarchy and places it. 
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If the result of the above calculations is a block name that does not exist, an error occurs 
when an attempt is made to place gondola in the Planner or Merchandiser modules.  

Specifying Part Size, Position, and Rotation 
A gondola can contain a wide variety of parts. These have to be orientated relative to the 
base point of the bay and rotated relative to the initial insertion position of the block. This 
information is entered in the Size, Position, and Rotation Tab. 

 

Stretchable Blocks 
The top section of the sub-tab specifies the dimensional offsets for stretchable block. 
Blocks are made stretchable by assigning a size to them in the Sizes tab of the Block 
Definition dialog box. 
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Fixed-Size Blocks 
The top section of the sub-tab specifies the dimensional offsets for blocks of fixed size. 
These are blocks that have a single fixed size assigned to them in the Sizes tab of the 
Block Definition dialog box. 

 

Block Rotations 
The bottom section of the sub-tab gives the rotation required to orientate each part within 
the gondola. Sections of the gondola such as the back and the start and end caps 
generally require a rotation. 
Rotations are normally in the Z (Vertical) plane. It is unusual to rotate on the X or Y 
planes. 

Baselines and Base Points 
When configuring a gondola, it can be considered as having fixtures placed along an 
imaginary baseline. Each point along the baseline is the origin for a specific bay. 

 

If there are multiple parts within a bay, all are associated with that base point. 
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In the above plan view, the two L legs and fixture making up the start cap of a gondola, 
together with the T leg and two fixtures are all associated with the first base point. Many 
of the parts have been given differing offsets and rotations so they draw in the correct 
position when the gondola is placed. The start cap and first few bays of the gondola are 
seen below. 

 

All parts are rotated and offset relative to their insertion point. In the example below, the 
insertion point (represented by a red circle) is situated at bottom back-left of the fixture. 
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Sizes of Gondola Parts 
The distance between base points is determined by the main dimension of the gondola.  

 

If a part to be used in the gondola is a fraction of the distance between base points, this 
can be specified in the Gondola Definition dialog box. 
For example, to place a shelf half the length of the bay, match the main dimension and 
use a size of half of it. 
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Rotations of Gondola Parts 
All fixtures and fittings have a designated front direction. This is normally set to point 
down the drawing when they are inserted. 

 

When a gondola is created, some of the parts (Start Cap, Back, and End Cap) need to 
have their components rotated so that the front of those parts is facing in the right 
direction when the gondola is drawn. 

  

To add a part to the End Cap, specify a 90 degree rotation in the Gondola Definition 
dialog box. 
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Rotation and Offsetting of Gondola Parts 
When a gondola component is rotated to get it into the correct orientation, it is rotated 
around its insertion point.  

 

In the case of a component to be used for the back of the gondola, it is rotated through 
180 degrees.  

Because it rotates around the insertion point its position changes. In the above example, 
we can see that the component to be used for the back of the gondola has been displaced 
to the left during the rotation.  

Apply an offset to get it back into its intended position. 

These offsets will vary depending on which part of the gondola is being defined. 

Note that all offsets are relative to the un-rotated orientation of the block.  

 Offsets in the X axis are relative to length 

 Offsets in the Y axis are relative to depth 
 Offsets in the Z axis are relative to height 

Side 
The sides of a gondola do not require any rotations or systematic offsets. 
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Back 
The back of the gondola is rotated through 180 degrees to get the front facing in the 
correct direction.  

 

It then needs a positive offset equal to the width of the block. 

 

Start Cap 
The start cap is rotated through 270 degrees to get the front facing in the correct 
direction.  

 

It then needs a positive offset equal to half of the width of the block. 

 

End Cap 
The end cap is rotated through 90 degrees to get the front facing in the correct direction.  
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It then requires two offsets to get it into the correct final position. 

 

Firstly, it requires a positive offset equal to the width of the side component of the 
gondola to move it to the right.  

Then it requires a negative offset of half its width to move it the correct distance down. 
(The negative offset is to move the block down, as opposed to up). 
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Fixed-Size Gondola Creation Example 
This example shows how to create a simple gondola. 

 

It is made up of four parts: front, back, start cap (optional), and end cap (optional). These 
are defined in the Gondola Definition dialog box in Fixture Studio. 
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After definition in the Fixture Studio module, it can be placed using any combination of 
two lengths, two depths, or three heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration.  

 

Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part after it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a temporary floor plan open in the Planner module. The required sequence of 
actions is: 

1. Click the OK button on the Gondola Definition dialog box. This saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu. This saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser. 
This reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Creating the Gondola Sizes 
In order to create the Gondola Sizes, first analyze the dimensions of the fixtures and 
fixtures and fittings that will be used to make up the gondola. In this example, the 
gondola is formed from metal uprights. These follow a naming convention of Block 
Name_LengthxDepthxHeight, enabling the sizes to be easily determined.  
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Looking at the list, it is possible to identify the dimensions required. 

Dimension Values 

Length 36 and 48 inches 

Depth 24 and 30 inches 

Height 72, 84 and 96 inches. 

The Size option can then be selected from the toolbar. 

 

The values can then be entered into the Gondola Sizes dialog box. 

 

The sizes are then available for selection in the Add Gondola dialog box when a gondola 
is placed in Planner, Merchandiser, or in In-Store Space Collaboration. 
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Creating the Basic Information 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 

 

This brings up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 
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Name and Description 
The name and description are entered as Basic Double Sided Metal upright. This is the 
title that the user sees in the Planner and Merchandiser modules and in In-Store Space 
collaboration. 

Main Length and Max Bays 
These are left at the default of 0. Main length would have been set to a positive value if 
there was only one option for the length of the gondola bay. May Bays would have been 
set to a limiting value if it was desired to set a maximum number for the bays to be 
placed. 

Dimensions 
Dimensions are selected from the list in the left hand pane by double clicking them. They 
are selected in the sequence they will be used in building up the block names when the 
gondola is drawn. The Metal Upright Length has been selected as the main dimensions. 
The value selected when adding a gondola into a floor plan defines the length of the bay 
drawn. 
As the blocks use a naming convention of Block Name_LengthxDepthxHeight suffixes of 
'x' have been added for the Length and depth to ensure the block name is calculated 
correctly. 

Creating the Front 
The first part of the gondola to be created is the front. This is shown in blue in plan and 
perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab becomes active. 

Type 
Structure has been selected from the predefined drop-down list. 
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Description 
This is identical to the text typed into the Parts text box. 

Prefix 
This is the first part of the bock name that is used to draw this specific part of the 
gondola. The naming convention for the block name is of the form Block 
Name_LengthxDepthxHeight. I_Metal_Upright_ is therefore entered into the Prefix field. 

Include If: 
This option determines which bays the part is drawn in. It is drawn in all bays, so all 
options are checked. 

Name Dependency 
This determines what dimensions are going to be used in building up the block name. As 
the block name includes Length, Depth, and Height, all three dependencies are checked. 

Mapping Option 
It is good practice to confirm the block names required to draw the gondola are recreated 
correctly. This can be done by clicking the Mapping button.   

 

This confirms that the block names generated by the gondola functionality conform to 
those which are present in the database. 

Creating the Back 
The next part of the gondola to be created is the back. This is shown in blue in plan and 
perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Part Name 
This is generated by typing Back into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab becomes active. 

Other Settings 
All other settings in this sub-tab are the same as for the Front settings. 
Other settings are required in the Size, Position & Rotation sub-tab. 
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When the parts for the back are placed, they are initially placed in the default position 
(green fixture). They then require a combination of an 180o rotation (blue fixture) and an 
offset to move it into position (red fixture) behind the equivalent front fixture.  

 

Rotation 
The rotation is 180o around the Z (vertical) axis.  

Offset 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Length (X Axis) offset is set to Offset by Metal Upright Length 
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from the drop-down list. If the user selects 3 ft long fixtures, the offset will be three feet, if 
the user selects 4 ft long fixtures, the offset will be four feet.  

Creating the Start Cap 
The next part of the gondola to be created is the start cap. This is shown in blue in plan 
and perspective in the diagram below. 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 
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Part Name 
This is generated by typing Start Cap into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab will become active. 

Include If 
The start cap is only present in the first bay. Accordingly only the First Bay option is 
checked. 

Optional 
Because the start cap does not have to be present, it can be made option by typing Start 
Cap in place of the default <no> in the Optional text box. 

Other Settings 
All other settings in this sub-tab are the same as for the Front settings. 

Other settings are required in the Size, Position & Rotation sub-tab. 

 

 When the parts for the start cap are placed, they are initially placed in the default 
position (green fixture). They then require a combination of a 270o rotation (blue fixture) 
and an offset to move it into position (red fixture) relative to the front fixture in the first 
bay.  
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Rotation 
The rotation is 270o around the Z (vertical) axis.  

Offset 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Depth offset (Y Axis) is set to Offset by Metal Upright Length from 
the drop-down list. The Scale Factor is set to 0.5. This means the fixture will be moved 
along by a distance equivalent to half its length. 

If the user selects 3 ft long fixtures, the offset will be 18 inches; if the user selects 4 ft long 
fixtures, the offset will be two feet.  

Creating the End Cap 
The final part of the gondola to be created is the end cap. This is shown in blue in plan 
and perspective in the diagram below. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Part Name 
This is generated by typing End Cap into the Parts text box and pressing Return. On 
highlighting Back in the list of parts, the Details sub-tab becomes active. 

Include If 
The End Cap is only present in the last bay. Accordingly the Last Bay option is checked. 
Because the gondola can contain any number of bays, both the Odd Bay and Even Bay 
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check boxes are selected to ensure the End Bay is present for gondolas with both an odd 
and an even number of bays. 

Optional 
Because the End Cap does not have to be present, it can be made option by typing End 
Cap in place of the default <no> in the Optional text box. 

Other Settings 
All other settings in this sub-tab are the same as for the Front settings. 

Other settings are required in the Size, Position & Rotation sub-tab. 

 

 

 When the parts for the end are placed, they are initially placed in the default position 
(green fixture). They then require a combination of a 90o rotation (blue fixture) and two 
offsets to move it into position (red fixture) relative to the front fixture in the last bay.  
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Rotation 
The rotation is 90o around the Z (vertical) axis.  

Offset 
Two offsets are required; one to move the fixture from the beginning of the last bay to the 
other side and one to adjust its position so that it is centered between the front and back 
(not shown) fixtures. 

Offset for Length 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Length (X Axis) offset is set to Offset by Metal Upright Length 
from the drop-down list. If the user selects 3 ft long fixtures, the offset will be three feet, if 
the user selects 4 ft long fixtures, the offset will be four feet.  

Offset for Depth 
Because the bays can be different lengths depending on selections made when the 
gondola is placed, the Depth offset (Y Axis) is set to Offset by Metal Upright Length from 
the drop-down list. The Scale Factor is set to -0.5. This means the fixture will be moved 
along by a distance equivalent to half its length. Because the offset is negative, the fixture 
will be moved along the -Y axis. If the user selects 3 ft long fixtures, the offset will be 18 
inches; if the user selects 4 ft long fixtures, the offset will be two feet.  
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Saving the Gondola 

Saving the Gondola in Fixture Studio 
The gondola can be saved in Fixture Studio as follows: 

1. Click the OK button on the Gondola Definition dialog box. This saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu. This saves the information to the 
Macro Space Planning database. 

Updating Gondola Definitions in Planner and Merchandiser 
If either the Planner or Merchandiser modules are open when a Gondola is being defined 
or updated in Fixture Studio, the definition must be updated in the Planner or 
Merchandiser modules before it can be used. The steps are as follows: 

1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 
Gondolas option on the File menu. 

2. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser. 
This reads the latest gondola definition information from the database into the 
Planner module. 

Updating Gondola Definitions in In-Store Space Collaboration 
If In-Store Space collaboration is open when a Gondola is being defined or updated in 
Fixture Studio, the definition must be updated in ISSC before it can be used. The steps 
are as follows: 
1. Ensure the Gondola Definition has been Saved in Fixture Studio with the Save 

Gondolas option on the File menu. 

2. Use the Refresh option in the In-Store Space Collaboration toolbar to load the latest 
changes. 
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Stretchable Gondola Creation Example 

Refer to the example on how to create a fixed size gondola. It provides information that is 
necessary to understanding this example. 

This example shows how to create a stretchable gondola. It uses two parts: a stretchable 
leg and a stretchable fixture. Each bay consists of a leg and a fixture, except the end bay, 
which has an additional leg. 

 

These are defined in the Gondola Definition dialog box in Fixture Studio. 
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After definition in the Fixture Studio module, it can be placed using any combination of 
eleven lengths, five depths, or nine heights in the Planner or Merchandiser modules or in 
In-Store Space Collaboration. This allows a gondola to be place using any one of 495 
combinations of length, depth, and height using only two basic fixtures. This makes this 
method economical in terms of creating fixtures, but requires care when reporting bills of 
materials for a floor plan.  

 

Testing the Gondola during Definition 
When defining gondolas, it is a good idea to test each part after it has been defined. This 
enables the user to correct any errors before moving onto the next part. Test can be done 
by having a temporary floor plan open in the Planner module. The required sequence of 
actions is: 

1. Click the OK button on the Gondola Definition dialog box. This saves the 
information locally in Fixture Studio. 

2. Select the Save Gondolas option on the File menu. This saves the information to the 
Macro Space Planning database. 

3. Click the Refresh option on the Toolbar of the Fixturing tab of the Object Browser. 
This reads the latest gondola definition information from the database into the 
Planner module. 

4. Place the gondola and verify the parts are in the expected position. 

Assigning Sizes to the Stretchable Blocks 
Stretchable gondolas use blocks that can have their sizes determined upon insertion into 
a floor plan. Sizes are assigned to blocks by selecting the Edit Sizes option from the Edit 
menu. 
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This in turn brings up the Sizes dialog box. 

 

Specific sizes can then be defined in the Size dialog box. 

 

These Sizes can then be assigned to specific blocks in the Sizes tab of the block Details 
dialog box. 
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Creating the Stretchable Gondola Sizes 
In order to create the Gondola Sizes, analyze the dimensions of the fixtures and fixtures 
and fittings that will be used to make up the gondola. In this example, the gondola is 
formed from stretchable blocks. Because the blocks are stretchable, for this gondola, only 
two blocks are needed.  

 

The dimensions required for the Gondola sizes are those defined in the Sizes dialog box 
accessed from the Edit menu. 

 

Once the sizes are known, the Size option can then be selected from the toolbar. 

 

The values can then be entered into the Gondola Sizes dialog box. The options should 
match those in the Size dialog box. 
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This is the same process as for creating sizes for gondolas used for blocks of fixed 
dimensions. The differences arise when the sizes are used in the Gondola Definition 
dialog box. 

Creating the Basic Information for the Stretchable Gondola 
The first stage of creating the gondola is to highlight a Gondola group and then select 
Add Gondola in the right click menu. 

 

This brings up the Gondola Definition dialog box. The first stage is to add name 
information and select the required dimensions. 
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Name and Description 
The name and description are entered as Stretchable Gondola. This is the title that the 
user sees in the Planner and Merchandiser modules and in In-Store Space Collaboration. 

Main Length and Max Bays 
These are left at the default of 0. Main length must be set to 0 for stretchable gondolas. 
Max Bays would have been set to a limiting value if it was desired to set a maximum 
number for the bays to be placed. 

Dimensions 
Dimensions are selected from the list in the left hand pane by double clicking them. They 
are selected in the sequence they are used in building up the block names when the 
gondola is drawn. The Stretch Racking Length has been selected as the main dimension. 
The value selected when adding a gondola into a floor plan defines the length of the bay 
drawn. 
No suffixes are required for stretchable blocks. 

Creating the Stretchable Gondola Leg 
The first part of the gondola to be created is the leg. This appears at the beginning of each 
bay. 
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In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Part Name 
This is generated by typing Leg into the Parts text box and pressing Return. On 
highlighting Leg in the list of parts, the Details sub-tab becomes active. 

Type 
Leg has been selected from the predefined drop-down list. 

Description 
This is identical to the text typed into the Parts text box. 
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Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box. 

Include If: 
This option determines which bays the part are drawn in. It is drawn in all bays, so all 
options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies, so none of the options should be 
checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. 

Other settings are required in the Size, Position & Rotation sub-tab. 

 

These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 
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 The length (width) of the leg has been specified as one inch. 
 The depth has been specified in increments of 6 inches as variable between 24 

and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

 The dimensions the leg may take up are set in to part of the Size, Position & 
Rotation sub-tab. 

 The length has been fixed at 1 inch, so is not specified. 

 The depth is set to Match Stretchable Racking Depth. The leg is able to take up 
the dimensions specified for the Stretchable Racking Depth dimension. 

 The height is set to Match Stretchable Racking height. The leg is able to take up 
the dimensions specified for the Stretchable Racking Height dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the leg 
into the correct position. The leg is 1 inch in length (width) and the insertion point is set 
to bottom back middle. 

 

So that the bottom-back-left corner of the leg to be the start position of the bay, the leg is 
given a positive offset of 0.5 inches in the X axis. 
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Creating the Stretchable Gondola Front 
The first part of the gondola to be created is the front. This appears in each bay. 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 

 

Part Name 
This is generated by typing Front into the Parts text box and pressing Return. On 
highlighting Front in the list of parts, the Details sub-tab becomes active. 
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Type 
Leg has been selected from the predefined drop-down list. 

Description 
This is identical to the text typed into the Parts text box. 

Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box 

Include If: 
This option determines which bays the part will be drawn in. It is drawn in all bays, so all 
options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies, so none of the options should be 
checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. 

Other settings are required in the Size, Position & Rotation sub-tab. 

 
These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 
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 The length has been specified in increments of 6 inches as variable between 24 
and 84 inches. 

 The depth has been specified in increments of 6 inches as variable between 24 
and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

The dimensions the leg may take up are set to part of the Size, Position & Rotation sub-
tab. 

 The length is set to Match Stretchable Racking Length. The front is able to take 
up the dimensions specified for the Stretchable Racking Length dimension. 
Because the length of the front needs to be 1 inch less than the length of the bay 
(to allow for the leg), a delta value of -1 has been entered.  

 The depth is set to Match Stretchable Racking Depth. The front is able to take up 
the dimensions specified for the Stretchable Racking Depth dimension. 

 The height is set to Match Stretchable Racking height. The front is able to take up 
the dimensions specified for the Stretchable Racking Height dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the 
front into the correct position. The leg is 1 inch in length (width). 
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The insertion point of the fixture is set to bottom-back-left. So that the bottom-back-left 
corner of the fixture to be alongside the bottom-back-right corner of the left that starts the 
bay, the front is given a positive offset of 1.0 inches in the X axis. 

Creating the Stretchable Gondola End Leg 
The last part of the gondola to be created is the end leg. This only appears on the end of 
the last bay. 

 

In order to do this, the following actions are required in the Parts tab of the Gondola 
Definition dialog box: 
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Part Name 
This is generated by typing End Leg into the Parts text box and pressing Return. On 
highlighting End Leg in the list of parts, the Details sub-tab becomes active. 

Type 
Leg has been selected from the predefined drop-down list. 

Description 
This is identical to the text typed into the Parts text box. 

Prefix 
For stretchable gondolas enter the entire block name into the Prefix text box 

Include If: 
This option determines which bays the part will be drawn in. It is drawn in all bays, so 
the last bay and odd and even bay options are checked. 

Name Dependency 
Stretchable gondolas do not use name dependencies, so none of the options should be 
checked. 

Mapping Option 
The mapping option does not work for stretchable gondolas. 

Other settings are required in the Size, Position & Rotation sub-tab. 

 

These are determined by settings in the Sizes specified for the stretchable block (Edit 
menu). 
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 The length (width) of the leg has been specified as one inch. 
 The depth has been specified in increments of 6 inches as variable between 24 

and 48 inches. 

 The height has been specified in increments of 6 inches as variable between 60 
and 108 inches. 

The dimensions the leg may take up are set to part of the Size, Position & Rotation sub-
tab. 

 The length has been fixed at 1 inch, so is not specified. 

 The depth is set to Match Stretchable Racking Depth. The leg is able to take up 
the dimensions specified for the Stretchable Racking Depth dimension. 

 The height is set to Match Stretchable Racking height. The leg is able to take up 
the dimensions specified for the Stretchable Racking Height dimension. 

A further setting is required in the lower part of the tab. This is for an offset to get the 
front into the correct position. The leg is 1 inch in length (width). 

 

The end leg has to be moved to the right hand side of the 'front' part of the bay. To do 
this, it is given an offset of 'Offset by Stretch Racking Length'. The insertion point of the 
fixture is set to bottom-back-middle. As we want the bottom-back-left corner of the leg to 
be alongside the bottom-back-right corner of the left that starts the bay, the front is also 
given a positive offset of 0.5 inches in the X axis. 

 





 

1 

11 
Points to Watch 

Points to watch give solutions to commonly experienced problems. 

Problems with Naming Conventions 
The Gondola Definitions dialog box is used to specify the components of a gondola.  

 

If there are errors in specifying the components, then Space Management will not be able 
to find the blocks to draw the gondola in the Cad or Virtual Reality environments.  

In the above example, the Prefix has been wrongly typed in as Back rather than 
Backpanel-. 
The gondola can be saved without problems, but when an attempt is made to place it in a 
drawing an error message will result. 

 

All Prefixes and Suffixes must be correctly defined for Macro Space Management to 
reference the correct block. 



  

2 Oracle Retail Macro Space Management Fixture Studio User Guide 

Combinations using Naming Conventions 
Naming conventions rely on a consistent approach being applied to block names.  

 

In the above example, podiums have been named using a consistent convention.  
There are available in widths of 1025 and 1200 mm, depths of 800, 1025, 1200, 1500 and 
1750 mm and heights of 200, 480 and 680 mm.  

This gives a theoretical number of 2 x 5 x 3 = 30 combinations, yet there are only 13 actual 
blocks.  

When specifying gondolas, care must be taken that the dimensions chosen minimize the 
number of potential combinations, or else more combinations will be generated than 
there are blocks to match them.  

If a block name is generated while drawing a gondola that does not match the list of 
available ones, an error will result. 

 

Graphics Not Found Message in the Block Details Dialog Box 
When blocks are configured, users will sometimes see the message, Graphics Not Found, 
in the Preview tab. 

 



  

Graphics Not Found Message in the Block Details Dialog Box 3 

This tab displays images using a 3DS file. If the file has not been created, or if it is in a 
different directory to that expected, this error message will result.  
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